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Notices

© 2020 copy rights

You may, at your own risk, assemble a MyDocs collection solely for your own internal business purposes, which
constitutes a modification to the original published version of the publications. Avaya shall not be responsible for any
modifications, additions, or deletions to the original published version of publications. You agree to defend,
indemnify and hold harmless Avaya, Avaya's agents, servants and employees against all claims, lawsuits, demands
and judgments arising out of, or in connection with, your modifications, additions or deletions to the publications.

Assingle topic or a collection of topics may come from multiple Avaya publications. All of the content in your collection
is subject to the legal notices and disclaimers in the publications from which you assembled the collection. For
information on licenses and license types, trademarks, and regulatory statements, see the original publications from
which you copied the topics in your collection.

Except where expressly stated by Avaya otherwise, no use should be made of materials provided by Avaya on this site.
All content on this site and the publications provided by Avaya including the selection, arrangement and design of the
content is owned by Avaya and/or its licensors and is protected by copyright and other intellectual property laws
including the sui generis rights relating to the protection of databases. Avaya owns all right, title and interest to any
modifications, additions or deletions to the content in the Avaya publications.
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Legal

©2017-2020, Avaya Inc.
All Rights Reserved.

Notice

While reasonable efforts have been made to ensure that the information in this document is complete and
accurate at the time of printing, Avaya assumes no liability for any errors. Avaya reserves the right to make
changes and corrections to the information in this document without the obligation to notify any person or
organization of such changes.

Documentation disclaimer

“Documentation” means information published in varying mediums which may include product information,
operating instructions and performance specifications that are generally made available to users of products.
Documentation does not include marketing materials. Avaya shall not be responsible for any modifications,
additions, or deletions to the original published version of Documentation unless such modifications, additions,
or deletions were performed by or on the express behalf of Avaya. End User agrees to indemnify and hold
harmless Avaya, Avaya's agents, servants and employees against all claims, lawsuits, demands and judgments
arising out of, or in connection with, subsequent modifications, additions or deletions to this documentation, to
the extent made by End User.

Link disclaimer

Avaya is not responsible for the contents or reliability of any linked websites referenced within this site or
Documentation provided by Avaya. Avaya is not responsible for the accuracy of any information, statement or
content provided on these sites and does not necessarily endorse the products, services, or information
described or offered within them. Avaya does not guarantee that these links will work all the time and has no
control over the availability of the linked pages.

Warranty

Avaya provides a limited warranty on Avaya hardware and software. Refer to your sales agreement to establish
the terms of the limited warranty. In addition, Avaya’s standard warranty language, as well as information
regarding support for this product while under warranty is available to Avaya customers and other parties
through the Avaya Support website: https://support.avaya.com/helpcenter/getGenericDetails?
detailld=C20091120112456651010 under the link “Warranty & Product Lifecycle” or such successor site as
designated by Avaya. Please note that if You acquired the product(s) from an authorized Avaya Channel Partner
outside of the United States and Canada, the warranty is provided to You by said Avaya Channel Partner and not
by Avaya.

“Hosted Service” means an Avaya hosted service subscription that You acquire from either Avaya or an
authorized Avaya Channel Partner (as applicable) and which is described further in Hosted SAS or other service
description documentation regarding the applicable hosted service. If You purchase a Hosted Service
subscription, the foregoing limited warranty may not apply but You may be entitled to support services in
connection with the Hosted Service as described further in your service description documents for the
applicable Hosted Service. Contact Avaya or Avaya Channel Partner (as applicable) for more information.
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Hosted Service

THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN AVAYA HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR
AN AVAYA CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE FOR HOSTED SERVICES ARE AVAILABLE ON
THE AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/LICENSEINFO UNDER THE LINK “Avaya Terms of Use for
Hosted Services” OR SUCH SUCCESSOR SITE AS DESIGNATED BY AVAYA, AND ARE APPLICABLE TO ANYONE WHO
ACCESSES OR USES THE HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED SERVICE, OR AUTHORIZING
OTHERS TO DO SO, YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE DOING SO
(HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO THE TERMS OF USE. IF
YOU ARE ACCEPTING THE TERMS OF USE ON BEHALF A COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT
THAT YOU HAVE THE AUTHORITY TO BIND SUCH ENTITY TO THESE TERMS OF USE. IF YOU DO NOT HAVE SUCH
AUTHORITY, OR IF YOU DO NOT WISH TO ACCEPT THESE TERMS OF USE, YOU MUST NOT ACCESS OR USE THE
HOSTED SERVICE OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED SERVICE.

Licenses

THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA WEBSITE, HTTPS://SUPPORT.AVAYA.COM/
LICENSEINFO, UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya Products)” OR SUCH SUCCESSOR
SITE AS DESIGNATED BY AVAYA, ARE APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR INSTALLS AVAYA
SOFTWARE, PURCHASED FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN AVAYA CHANNEL PARTNER (AS
APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH AVAYA OR AN AVAYA CHANNEL PARTNER. UNLESS
OTHERWISE AGREED TO BY AVAYA IN WRITING, AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE WAS
OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA
RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU AND ANYONE ELSE USING OR SELLING THE
SOFTWARE WITHOUT A LICENSE. BY INSTALLING, DOWNLOADING OR USING THE SOFTWARE, OR AUTHORIZING
OTHERS TO DO SO, YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR WHOM YOU ARE INSTALLING,
DOWNLOADING OR USING THE SOFTWARE (HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU” AND “END
USER”), AGREE TO THESE TERMS AND CONDITIONS AND CREATE A BINDING CONTRACT BETWEEN YOU AND
AVAYA INC. OR THE APPLICABLE AVAYA AFFILIATE (“AVAYA”).

Avaya grants You a license within the scope of the license types described below, with the exception of Heritage
Nortel Software, for which the scope of the license is detailed below. Where the order documentation does not
expressly identify a license type, the applicable license will be a Designated System License as set forth below in
the Designated System(s) License (DS) section as applicable. The applicable number of licenses and units of
capacity for which the license is granted will be one (1), unless a different number of licenses or units of capacity
is specified in the documentation or other materials available to You. “Software” means computer programs in
object code, provided by Avaya or an Avaya Channel Partner, whether as stand-alone products, pre-installed on
hardware products, and any upgrades, updates, patches, bug fixes, or modified versions thereto. “Designated
Processor” means a single stand-alone computing device. “Server” means a set of Designated Processors that
hosts (physically or virtually) a software application to be accessed by multiple users. “Instance” means a single
copy of the Software executing at a particular time: (i) on one physical machine; or (ii) on one deployed software
virtual machine (“VM”) or similar deployment.

License types

Designated System(s) License (DS). End User may install and use each copy or an Instance of the Software only: 1)
on a number of Designated Processors up to the number indicated in the order; or 2) up to the number of
Instances of the Software as indicated in the order, Documentation, or as authorized by Avaya in writing. Avaya
may require the Designated Processor(s) to be identified in the order by type, serial number, feature key,
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Instance, location or other specific designation, or to be provided by End User to Avaya through electronic means
established by Avaya specifically for this purpose.

Concurrent User License (CU). End User may install and use the Software on multiple Designated Processors or
one or more Servers, so long as only the licensed number of Units are accessing and using the Software at any
given time. A “Unit” means the unit on which Avaya, at its sole discretion, bases the pricing of its licenses and can
be, without limitation, an agent, port or user, an e-mail or voice mail account in the name of a person or
corporate function (e.g., webmaster or helpdesk), or a directory entry in the administrative database utilized by
the Software that permits one user to interface with the Software. Units may be linked to a specific, identified
Server or an Instance of the Software.

Named User License (NU). You may: (i) install and use each copy or Instance of the Software on a single
Designated Processor or Server per authorized Named User (defined below); or (ii) install and use each copy or
Instance of the Software on a Server so long as only authorized Named Users access and use the Software.
“Named User”, means a user or device that has been expressly authorized by Avaya to access and use the
Software. At Avaya’s sole discretion, a “Named User” may be, without limitation, designated by name, corporate
function (e.g., webmaster or helpdesk), an e-mail or voice mail account in the name of a person or corporate
function, or a directory entry in the administrative database utilized by the Software that permits one user to
interface with the Software.

Shrinkwrap License (SR). You may install and use the Software in accordance with the terms and conditions of
the applicable license agreements, such as “shrinkwrap” or “clickthrough” license accompanying or applicable
to the Software (“Shrinkwrap License”).

Heritage Nortel Software

“Heritage Nortel Software” means the software that was acquired by Avaya as part of its purchase of the Nortel
Enterprise Solutions Business in December 2009. The Heritage Nortel Software is the software contained within
the list of Heritage Nortel Products located at https://support.avaya.com/Licenselnfo under the link “Heritage
Nortel Products” or such successor site as designated by Avaya. For Heritage Nortel Software, Avaya grants
Customer a license to use Heritage Nortel Software provided hereunder solely to the extent of the authorized
activation or authorized usage level, solely for the purpose specified in the Documentation, and solely as
embedded in, for execution on, or for communication with Avaya equipment. Charges for Heritage Nortel
Software may be based on extent of activation or use authorized as specified in an order or invoice.

Copyright

Except where expressly stated otherwise, no use should be made of materials on this site, the Documentation,
Software, Hosted Service, or hardware provided by Avaya. All content on this site, the documentation, Hosted
Service, and the product provided by Avaya including the selection, arrangement and design of the content is
owned either by Avaya or its licensors and is protected by copyright and other intellectual property laws
including the sui generis rights relating to the protection of databases. You may not modify, copy, reproduce,
republish, upload, post, transmit or distribute in any way any content, in whole or in part, including any code and
software unless expressly authorized by Avaya. Unauthorized reproduction, transmission, dissemination,
storage, and or use without the express written consent of Avaya can be a criminal, as well as a civil offense
under the applicable law.

Virtualization

The following applies if the product is deployed on a virtual machine. Each product has its own ordering code
and license types. Unless otherwise stated, each Instance of a product must be separately licensed and ordered.
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For example, if the end user customer or Avaya Channel Partner would like to install two Instances of the same
type of products, then two products of that type must be ordered.

Third Party Components

“Third Party Components” mean certain software programs or portions thereof included in the Software or
Hosted Service may contain software (including open source software) distributed under third party agreements
(“Third Party Components”), which contain terms regarding the rights to use certain portions of the Software
(“Third Party Terms”). As required, information regarding distributed Linux OS source code (for those products
that have distributed Linux OS source code) and identifying the copyright holders of the Third Party Components
and the Third Party Terms that apply is available in the products, Documentation or on Avaya’s website at:
https://support.avaya.com/Copyright or such successor site as designated by Avaya. The open source software
license terms provided as Third Party Terms are consistent with the license rights granted in these Software
License Terms, and may contain additional rights benefiting You, such as modification and distribution of the
open source software. The Third Party Terms shall take precedence over these Software License Terms, solely
with respect to the applicable Third Party Components to the extent that these Software License Terms impose
greater restrictions on You than the applicable Third Party Terms.

The following applies only if the H.264 (AVC) codec is distributed with the product. THIS PRODUCT IS LICENSED
UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES IN
WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD
(“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL
ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM
MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.

Service Provider

THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S HOSTING OF AVAYA PRODUCTS OR SERVICES. THE
PRODUCT OR HOSTED SERVICE MAY USE THIRD PARTY COMPONENTS SUBJECT TO THIRD PARTY TERMS AND
REQUIRE A SERVICE PROVIDER TO BE INDEPENDENTLY LICENSED DIRECTLY FROM THE THIRD PARTY SUPPLIER.
AN AVAYA CHANNEL PARTNER’S HOSTING OF AVAYA PRODUCTS MUST BE AUTHORIZED IN WRITING BY AVAYA AND
IF THOSE HOSTED PRODUCTS USE OR EMBED CERTAIN THIRD PARTY SOFTWARE, INCLUDING BUT NOT LIMITED
TO MICROSOFT SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS REQUIRED TO INDEPENDENTLY
OBTAIN ANY APPLICABLE LICENSE AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE, DIRECTLY FROM
THE APPLICABLE THIRD PARTY SUPPLIER.

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL PARTNER IS HOSTING ANY PRODUCTS THAT USE OR EMBED
THE H.264 CODEC OR H.265 CODEC, THE AVAYA CHANNEL PARTNER ACKNOWLEDGES AND AGREES THE AVAYA
CHANNEL PARTNER IS RESPONSIBLE FOR ANY AND ALL RELATED FEES AND/OR ROYALTIES. THE H.264 (AVC)
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER OR
OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE VIDEO IN COMPLIANCE WITH THE
AVC STANDARD (“AVC VIDEO”) AND/OR (I1) DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN
A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO
LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION FOR H.264 (AVC)
AND H.265 (HEVC) CODECS MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.
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Compliance with Laws

You acknowledge and agree that it is Your responsibility for complying with any applicable laws and regulations,
including, but not limited to laws and regulations related to call recording, data privacy, intellectual property,
trade secret, fraud, and music performance rights, in the country or territory where the Avaya product is used.

Preventing Toll Fraud

“Toll Fraud” is the unauthorized use of your telecommunications system by an unauthorized party (for example,
a person who is not a corporate employee, agent, subcontractor, or is not working on your company's behalf). Be
aware that there can be a risk of Toll Fraud associated with your system and that, if Toll Fraud occurs, it can result
in substantial additional charges for your telecommunications services.

Avaya Toll Fraud intervention

If You suspect that You are being victimized by Toll Fraud and You need technical assistance or support, call
Technical Service Center Toll Fraud Intervention Hotline at +1-800-643-2353 for the United States and Canada.
For additional support telephone numbers, see the Avaya Support website: https://support.avaya.com or such
successor site as designated by Avaya.

Security Vulnerabilities

Information about Avaya’s security support policies can be found in the Security Policies and Support section of
https://support.avaya.com/security.

Suspected Avaya product security vulnerabilities are handled per the Avaya Product Security Support Flow
(https://support.avaya.com/css/P8/documents/100161515).

Downloading Documentation

For the most current versions of Documentation, see the Avaya Support website: https://support.avaya.com, or
such successor site as designated by Avaya.

Contact Avaya Support

See the Avaya Support website: https://support.avaya.com for product or Hosted Service notices and articles, or
to report a problem with your Avaya product or Hosted Service. For a list of support telephone numbers and
contact addresses, go to the Avaya Support website: https://support.avaya.com (or such successor site as
designated by Avaya), scroll to the bottom of the page, and select Contact Avaya Support.

Trademarks

The trademarks, logos and service marks (“Marks”) displayed in this site, the Documentation, Hosted Service(s),
and product(s) provided by Avaya are the registered or unregistered Marks of Avaya, its affiliates, its licensors, its
suppliers, or other third parties. Users are not permitted to use such Marks without prior written consent from
Avaya or such third party which may own the Mark. Nothing contained in this site, the Documentation, Hosted
Service(s) and product(s) should be construed as granting, by implication, estoppel, or otherwise, any license or
right in and to the Marks without the express written permission of Avaya or the applicable third party.

Avaya is a registered trademark of Avaya Inc.
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All non-Avaya trademarks are the property of their respective owners. Linux® is the registered trademark of Linus
Torvalds in the U.S. and other countries.
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Introduction

Purpose

This document describes how to set up and use Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows.
End users can do all the tasks without assistance.

This document includes Avaya Aura® content for Avaya IX™ Workplace Client. IP Office content for Avaya IX™
Workplace Client is covered in the IP Office document for Avaya IX™.

Change history

The following table describes the major changes made in this document for each release:
Issue Date Summary of changes

Added information on support for:

Using Rich Text Format in instant messages on Avaya IX™ Workplace Client for Windows.

Removing participants from a conversation with Avaya Multimedia Messaging service on Avaya

Aura® Presence Services Release 8.1.2 and later.
1,Release  June

3.9 2020

Displaying the Avaya Spaces conversation in Rich Text Format.

» Removing an instant message in an Avaya Spaces conversation if the other participant deletes the
sent message.

Restricting the download of attachments with specific file extensions in an instant message on Avaya
IX™ Workplace Client for iOS and Mac.
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Avaya IX Workplace Client overview

Avaya IX™ Workplace Client is a soft phone application that provides access to Unified Communications (UC) and
Over the Top (OTT) services. You can access Avaya IX™ Workplace Client on the following platforms:

Mobile:

+ Android: From a mobile phone, tablet, or an Avaya Vantage™ device
« i0S: From an iPad, iPhone, or iPod Touch

Desktop:

« Mac
» Windows
Based on your feature requirement, you can deploy Avaya IX™ Workplace Client in several ways. In the basic

deployment type, you can have only voice calling. You can then include additional features such as directory
search, contact management, presence, instant messaging, and conferencing.

With Avaya IX™ Workplace Client, you can use the following functionalities:

Make point-to-point audio and video calls.

Answer calls, send all calls to voice mail, and forward calls

Extend calls to your mobile phone if EC500 is configured

Log in to your extension and join calls with multiple devices if Multiple Device Access (MDA) is configured.
Listen to your voice mail messages.

View your call history.

Access your Avaya Aura® and local contacts.

Perform an enterprise-wide search using Avaya Aura® Device Services, Client Enablement Services, Avaya Cloud
Services, ActiveSync on mobile platforms and Avaya Aura® Device Services, LDAP, or Avaya Cloud Services on
desktop platforms.

Manage your presence status and presence status message.

Send instant messages.

Capture photo, audio, and video files, and send generic file attachments in an IM conversation.

Join and host conference calls with moderator controls.

Use point-to-point and conference call control functionality. You can also add participants to a conference.

Share a screen portion, the entire display screen, an application, or a whiteboard while on a conference call on
desktop platforms.

View a portion of the screen, the entire display screen, an application, or a whiteboard shared by another
conference participant on mobile and desktop platforms.
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© Note:

Some Avaya IX™ Workplace Client features must be configured for your enterprise before you can use them.

Multiple Device Access overview

Avaya IX™ Workplace Client supports Multiple Device Access (MDA), which you can use to:

+ Logon to the same extension from multiple devices, including mobile EC500 devices.
« Answer a call from multiple devices.
+ Join an existing call from other logged in devices.

+ Hear simultaneous ringing on all logged in devices when a call is made to your extension.
The Avaya Aura® network configuration, which your administrator configures, determines:

+ The number of devices that you can log in to at the same time.
+ Whether the first or last logged in device is denied login access when you reach the maximum simultaneous
device limit.

For more information, see Planning for and Administering Avaya IX™ Workplace Client for Android, iOS, Mac, and
Windows.

MDA limitations

Support on other devices

+ Some devices do not support MDA. You might be able to log in to these devices using the same extension that
you used to log in to Avaya IX™ Workplace Client. However, other MDA functionality, such as the ability to answer
a new call or join an existing call, might not work properly.

Video escalation

« When more than one device is on a call, you cannot escalate the call to video. If additional devices drop from the
call and only one device remains on the call, you can escalate that call to a video call.

+ When a second device joins a video call, the video screen becomes blank.
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« An EC500 device cannot escalate to a video call at any time even if the EC500 device is the only device on the call.

Bridged Line Appearance overview

Use the Bridged Line Appearance (BLA) feature to give single-line and multi-appearance telephones an
appearance of another telephone number. With BLA, the user can make, answer, and bridge onto calls to or from
the telephone number of another user. For the BLA feature to be available, your administrator must provision the
BLA feature for your extension.

The terms primary number, primary telephone, and primary station all mean the same thing.

The primary number is the extension that you want other extensions to bridge onto. For example, you want
extension A as the primary number to also have call appearances on extensions B, C, and D. In this case, your
administrator must access extensions B, C, and D to configure Bridge Appearance of extension A onto these
extensions.

A typical use case for the BLA feature is a boss and secretary scenario. In this scenario, the primary number is of
the boss and call appearances of the primary number are configured on the extension of the secretary. When
someone calls the boss, either the boss or secretary can answer the call. If the call is answered first by the
secretary, the boss can bridge onto the call.

If a call is made to the extension of the secretary, the boss cannot see this call or bridge onto it.

To make a call using the BLA extension, you must first select the primary extension appearance and then dial on
behalf of the primary extension.

When you receive a call on the primary extension, the call rings on the primary extension and the secondary
extension. In this case, the secondary extension displays that the call is for the primary extension. The user of the
secondary extension can select and answer this call. After the call is answered, the secondary extension displays
that the active answered call is for the primary extension. On the primary extension, Avaya IX™ Workplace Client
displays a bridge appearance to bridge onto the call answered on the secondary extension.

Interactions for Bridged Line Appearance

This section provides information about how the Bridged Line Appearance (BLA) feature interacts with other
features on the system. Use this information to ensure that you receive the maximum benefits of BLA in any
feature configuration. For more information, see Avaya Aura® Communication Manager Feature Description and
Implementation.

© Note:
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Enhanced conferencing using Avaya Equinox® Conferencing is not supported with BLA. If a BLA watcher wants to
be a participant in an enhanced conference, the BLA watcher must join the enhanced conference directly.

Automatic Callback

Automatic Callback calls cannot originate from a BLA. However, when Automatic Callback is activated from the
primary telephone, the callback call rings on all bridged appearances of the extension and the primary
telephone.

Call Forwarding All Calls, Call Forward Busy, and No Answer

Call Forwarding can be activated or canceled for the primary extension from any BLA of that extension using a
feature access code. When activated, calls to the primary extension do not terminate at the BLAs, but go to the
designated forwarding destination.

Call Park

When a call is parked from a BLA, it is parked on the primary extension associated with the BLA.

Call Pickup

Calls that are made to a primary telephone can only be answered by pickup group members of the primary
number. This refers to calls with alerting at bridged appearances of the primary telephone.

+ The Temporary Bridged Appearance on Call Pickup? field on the Feature-Related System Parameters screen is set
to n: In this case, the primary appearance and all bridged appearances of the call are dropped after Call Pickup is
used to answer the call.

+ The Temporary Bridged Appearance on Call Pickup? field on the Feature-Related System Parameters screen is set
to y: In this case, the primary and bridged call appearance lamps stay lit after Call Pickup is used to answer the
call.

+ The primary telephone and the BLA are not in the same pickup group: In this case, members in the same pickup
group as the BLA telephone cannot answer a call that is made to the primary telephone.

'9 Note:

The primary telephone and the BLA cannot be in the same pickup group. This is not a supported configuration.

When a user dials the Call Pickup FAC on a BLA, the system interprets the action as an attempt to answer a call
from the call pickup group of the primary telephone. When operating this way, the covering user can act as the
primary user and provide the same call pickup coverage if required. Covering user is the user associated with the
extension number that is configured to have call appearances of the primary number.

Send All Calls

Single-line device: When a single-line device is administered as a BLA, the user cannot start Send All Calls for the
extension of the device. The user does not have a Send All Calls button, and the call appearance is associated
with another extension, that is, the primary extension. When the user dials an FAC, Send All Calls is activated for
the extension associated with the call appearance.
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Multi-appearance telephones: A user with BLAs can activate or deactivate Send All Calls for a primary telephone
from the bridged appearance.

Bridge Line Appearance scenarios

The following Bridge Line Appearance (BLA) scenarios display the device user interface of the boss and secretary
who are using Avaya IX™ Workplace Client:

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 14



se Scenario

Make a
call to the
extension
number
of the
boss.

Secretary
answers
the call.

Bridge

Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

User interface

Device of boss

8 EXT 50100
=]

Device of secretary

8 EXT 50100
1 -~

Device of boss

Incoming Call

Call for 59496

EXT 50100

Device of secretary

Device of boss

bid, i0S, Mac, and Windows

CONFERENCE 2

15



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

se Scenario User interface

Device of boss

Enter a number to start a call Hide:

Boss off- ' Device of secretary
hooks the

phone. o)

Call as...

52505 (Me)

L0496

59496

Device of secretary

Boss Call as...

drops the
Ca“.

Mo Current Calls
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se Scenario User interface

Device of secretary

Cancel Call as... Dot
Secretary
selects 52595 (M E)
the BLA
of the
boss.

59496

Reset to "Me" after one call

SIP deskphones and accessibility

To enable the blind and visually impaired to use Avaya SIP phones, such as the J100 series, Avaya IX™ Workplace
Client for Windows supports the following:

+ Hidden mode. While using your deskphone for calls, Avaya IX™ Workplace Client for Windows is not visible on
your computer, which prevents unwanted interactions with screen readers.

+ Desk Phone mode. You can use this mode to control the deskphone using your keyboard. You can use
customizable keyboard shortcuts to perform deskphone operations. Global shortcut keys enable keyboard
control to work regardless of which application is in focus.

+ Microsoft narrator. Avaya IX™ Workplace Client for Windows voices key information to you using the Microsoft
narrator. You can select the preferred voice from the available narrator voices and adjust the text-to-speech
speed and volume.
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These accessibility enhancements are also available for softphone use cases where the Avaya IX™ Workplace
Client user interface is visible on your computer.

Checklist to set up Avaya IX Workplace Client for
Windows for use with deskphones

Use the following checklist to set up Avaya IX™ Workplace Client for Windows for use with deskphones for blind
and visually impaired users:

Task Reference v

Install and configure the application. If « Installing Avaya IX Workplace Client on desktops

possible, use automatic configuration.

Configuring Avaya IX Workplace Client settings
automatically

Enable the Desk Phone mode to use the
deskphone for calls.

OR Enabling the Desk Phone mode

To force the application to use the Desk Phone
mode, use the VDIENV=1 installation parameter.

Enable the narrator and configure the narration = Configuring the narrator on Avaya IX Workplace
preferences. Client for Windows

) . . Configuring keyboard shortcuts on Avaya IX
Configure hotkeys, including global hotkeys. Workplace Client for Windows

Log in to the deskphone. Refer to the appropriate deskphone documentation.

Log in to the application. Logglng in and out of the Avaya IX Workplace Client
services
Modifying audio and video settings on desktop

Adjust the ringer volume if required. clients
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Task Reference v

Configuring the hidden mode on Avaya IX Workplace

Enable hidden mode. Client for Windows

New in this release

Use Contact Center agent capabilities with Avaya IX™ Workplace Client for iOS.

Accessibility improvements including color contrast and keyboard navigation with Avaya IX™ Workplace Client
for Windows.

Use Rich Text Format in instant messages on Avaya IX™ Workplace Client for Windows with:

+ Avaya Multimedia Messaging Release 3.5 and later
» Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1.2 and later

Remove participants from a conversation with Avaya Multimedia Messaging service on Avaya Aura® Presence
Services Release 8.1.2 and later.

Display the Avaya Spaces conversation in Rich Text Format. You can view the messages as formatted by the other
participant in the conversation.

Restrict the download of attachments with specific file extensions in an instant message on Avaya IX™ Workplace
Client for iOS and Mac.Avaya IX™ Workplace Client does not download common malware, which is found on
these file extensions.

Configure the maximum video resolution that Avaya IX™ Workplace Client for Android and iOS can receive and
send over the network.

USB call control support for Avaya B109 with Avaya IX™ Workplace Client for Mac and Windows.
Arabic language support with Avaya IX™ Workplace Client for Windows.
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Avaya IX Workplace Client navigation

The following images display the Top of Mind screen of Avaya IX™ Workplace Client on mobile and desktop
devices. You can access the settings of Avaya IX™ Workplace Client through the Top of Mind screen. The settings
are described in the table following the images.

Mobile client
2 3 4
‘_ ‘ . ODL »
= Top of Mind v ada
» D
— §§§ Q_ Find someone 5
Next Meetings >

No more meetings today!
Now you can get some work done :)

Sign in to view conversations 6

Your recent calls will appear here

&8 Workplace Meetings

&% Workplace Meetings >
A\?L Spaces Sign in / Sign up >
[ Go to My Meeting Portal P
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Desktop client

4 3 2

Avaya |IX Workplace @- —

Top of Mind

— I % _1. name or number
/ -
[i#] Next Meetings »

No more meetings today!
Now you can get some work done :)

{1Messages >

Your recent messages will appear here

Your recent calls will appear here

4°% Workplace Meetings

.&-EE. Workplace Meetings

ﬁ Spaces Sign in / Sign up 3 7
|__’|’?' Go to My Meeting Portal 3
New Conversation + g:: e 8
No. Name Description
1 Dialpad Access the dialpad to make an audio or video call.
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No. Name

2 Menu

3 Top of Mind

Presence status
indicator

5 Search

Next Meetings,
Messages,

6 History, and
Workplace
Meetings

Manage audio
7 and video
devices
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Description

Access the following screens from the Avaya IX™ Workplace Client menu:

Top of Mind

Favorites

Contacts

History

Messages

Meetings

Features: Only on mobile clients

You can also manually configure the settings, access your voice mail messages, and exit from the
Avaya IX™ Workplace Client application.

Access the settings for configuring the layout of the Top of Mind screen.

Access the incoming and outgoing calls settings. You can also configure your presence status and
message, and sign out from the Avaya IX™ Workplace Client application.

Search for a contact.

You can start an instant messaging conversation by typing the messaging address.

Join Avaya IX™ Workplace Client and Spaces meetings with one touch and view your meeting
calendar.

© note:

You cannot click to join an Avaya IX™ Workplace Client meeting from your calendar. However, if
you are using the Avaya IX™ Workplace Client add-in for Microsoft Outlook, you can click to join
from the meeting invitation.

Respond to the latest messages and view your active conversations.
Return important missed calls and view your call activity.

Start a meeting, join an Avaya IX™ Workplace Client meeting, log in to Spaces or open the Spaces
dashboard, and go to your meeting portal.

Modify the audio and video settings on desktop clients.

On mobile clients, you can modify the audio and video settings from the user preferences settings.
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No. Name Description

Open the Feature Manager on desktop clients. Your administrator must configure the call features
for your extension. Features might include Automatic Callback, Call Pickup, Call Pickup Directed,
8  Feature Manager Call Pickup Extended, and Call Unpark.

On mobile clients, you can view the configured features by going to the Avaya IX™ Workplace
Client menu.

Viewing the Avaya IX Workplace Client tutorial

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Support.
2. Do one of the following:

+ On mobile clients: Select Tutorial.
« On Avaya IX™ Workplace Client for Windows: Select Open Tutorial.
« On Avaya IX™ Workplace Client for Mac: Select Show Tutorial.

3. Select one of the following:

« Skip or Skip Tutorial: To exit the tutorial.
« Next: To view the next screen.
« Back or Previous: To view the previous screen.

+ Done: To finish viewing and exit the tutorial.

Icons

Presence status

Avaya IX™ Workplace Client displays the following icons on the various screens:

Button Name Notes

Available —
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Button Name Notes

Away —

Busy —

° Do not disturb —

Offline —
Out of office —
i “ Automatic Presence status is updated automatically.
History screen
Button Name Notes
@ All History View your complete call history.
\J/ Incoming Calls —
W Missed Calls —
15 Outgoing Calls —
ao Voicemail View your voice mail messages.

Incoming Calls screen

Button Name Notes

Forward Calls

% or Forward calls to another telephone number of your choice.
Y Eorward Calls Busy/No Forward calls when you are busy or do not answer.
Answer
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Button Name

*._.7] | SendAll Calls

|

EI EC500

Outgoing Calls screen

Button Name

)

VolP Call

-'i‘"\
a

E'Ej’j EC500 Call

£l Call Using Mobile

=
“ Call Using Work phone
f@‘ Call Using My Phone

Dialpad icons

Button

[alale

0000
Qo0

Notes

Send all calls to voice mail.

Activate simultaneous ringing on your deskphone and device for a call that
arrives on your deskphone.

Notes

Calls are made using Wi-Fi or your cellular data.

Calls are made using your cellular minutes.

Mobile number is called back when you make a call.

Work number is called back when you make a call.

Configured number is called back when you make a call.

Name Notes

Dialpad Opens the Dialpad.

Redial —

Audio Call —

Video Call —

Clear —
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Conference screen

Button

)

e

T LL

<—
——

August 4, 2020

Name

Recording

Lecture Mode

Entry Tones

Continuation

Presentation Mode
or

Start Sharing

Lock Meeting

Mute Everyone

Unmute Everyone

End Meeting

Add participant

Conference Participants

Transfer Call

Controls

Notes

The audio and video of all participants in the conference is on mute.

When a participant joins or leaves the conference, Avaya IX™ Workplace Client
generates a tone.

When the Conference Continuation feature is enabled, the conference remains active
after the moderator drops out unless the moderator chooses to end the conference for
everyone.

When the Conference Continuation feature is disabled, the conference ends
automatically two minutes after the moderator drops out.

The moderator can lock the conference to prevent new participants from joining the
call. However, the moderator can continue to add participants to the conference.
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Generalicons

Button

%;'rff'

August 4, 2020

Name

Settings

Menu
Features Manager

Manage audio and video
devices

More

Audio Call

Mute Audio Call

Speaker

Video Call

Block camera

Resume Call

Notes

On desktop clients.

Audio is muted during the call.

Use this button to enable or disable video on a call. If you enable video, this
button turns blue to indicate the active state.

'o Note:

If you enable video calling in Avaya IX™ Workplace Client settings, the Avaya

IX™ Workplace Client status bar displays the icon. However,

L
the Conference screen displays the - icon.

When this button is active, Avaya IX™ Workplace Client blocks your camera
and does not send your video into the conference. This button is only usable
when video is active on the call.
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Button

&

August 4, 2020

"

Name

Hold Call

Instant Messaging

Email

Add

End Call

Merge Call

Handoff to Cellular

Search

Alert

Information

Name

Notes

Callis placed on hold.

Email is sent to a contact using the native email application.

Active call is merged with the call that is on hold.

Callis extended to your EC500 device.

Notes

Start My Meeting —

Workplace Meetings —

Join Spaces Meeting —
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Button

Name

Go to My Meeting Portal

Notes

Shortcut keys for Avaya IX Workplace Client for Mac and

Windows

You can use the default shortcut keys to access the following functionality on desktop clients. However, you can update the
keyboard shortcuts only on Avaya IX™ Workplace Client for Windows.

August 4, 2020

Function

Apply bold format in chat
Apply italic formatin chat

Apply underline format in
chat

Call Actions

Answer Incoming Call
Ignore Incoming Call
Mute / Unmute

End Current Call

Hold / Unhold Current Call
Transfer Current Call

Transfer Current Call to
Last Held Call

Merge Current Call with
Last Held Call

Avaya IX™ Workplace
Client for Mac

command +B

command + I

command+U

option+command+A

control+M
option+command+E
shift+control+H

option+command+T

Avaya IX™ Workplace Client for

Windows

Ctrl+B

Ctrl+I

Ctrl+U

Ctrl+Alt+A

Ctrl+Alt+I

Ctrl+M

Ctrl+Alt+E

Ctrl+H

Ctrl+T

Ctrl+Alt+T

Ctrl+Alt+M

Notes

Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows
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. Avaya IX™ Workplace Avaya IX™ Workplace Client for
Function a - Notes
Client for Mac Windows

Redial _ ctrl+R Redials the last outgoing
number.

Dial from clipboard option+W Alt+W —

App & Call Status
Invokes narration on sign
in status, Desk Phone

Check App Status — Ctrl+Alt+1 mode on or off, and
phone service impacting
errors.

Check Voicemail Status — Ctrl+Alt+2 —

Check Incoming Call
— Ctrl+Alt+3 —
Feature Status .
Invokes narration on the
Read Current Call _ Ctrl+Alt+9 active call information
Appearance such as user name or
number and call timer.

Narrator

Narrator On / Off — Win+Ctrl+N —
Stop Reading — Ctrl+ Spacebar —
Repeat Last Phrase - Ctrl+Shift+X —

App Window & Navigation

Hidden Mode On / Off — Ctrl+Alt+H —

When the application isin
focus, minimizes the
application.

Show / Hide Dashboard - Ctrl+Alt+U When the application is
minimized or not in focus,
opens the application
and puts the application
in focus.

Open Dialpad command + D Ctrl+D —

Select Top of Mind shift +command+T Alt+T —
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Function

Select Favorites
Select Contacts
Select History

Select Messages
Select Meetings

Search

August 4, 2020

Avaya IX™ Workplace
Client for Mac

shift+command+F
shift +command+C
shift +command+H
shift +command+ I
shift +command+M

F3

Avaya IX™ Workplace Client for
Windows

Alt+F
Alt+C
Alt+H
Alt+1I
Alt+M

F3

Notes

Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows
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Setting up Avaya IX™ Workplace Client

System requirements and interoperability

For the latest and most accurate compatibility information for Avaya IX™ Workplace Client, use the Compatibility
Matrix tool on the Avaya Support website at https://support.avaya.com/CompatibilityMatrix/Index.aspx.

Ensure that your mobile device or desktop system includes the latest OS updates. Your system must have the
latest vendor supplied drivers, specifically for:

+ Headsets

« Cameras

+ Display adapters

Mobile clients

Security certificates on mobile devices

Avaya IX™ Workplace Client requires security certificates to establish connections with various servers.

If you need to install additional certificates, follow the instructions provided by your administrator.

Installing Avaya IX Workplace Client on mobile devices
About this task

Use this procedure to install Avaya IX™ Workplace Client on your mobile device.

9 Note:
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If you do not want to receive notifications from Avaya IX™ Workplace Client, you can disable the notifications on
your mobile device. The notifications are controlled by the operating system on your mobile device rather than
any application. The exact method of disabling notifications varies on each mobile device.

Procedure

1. Onthe mobile device for:

« Android: Open the Play Store application.
+ i0S: Open the App Store application.
2. Onthe mobile device for:

+ Android: Search for Avaya IX Workplace.
« i0S: Search for IX Workplace.
. Select the entry for Avaya IX™ Workplace Client.

3

4. Install Avaya IX™ Workplace Client.

5. After the installation process is complete, select Open.
6

. Accept the terms of the license agreement and the message to not use Avaya IX™ Workplace Client to make
emergency calls.

Android permissions

After you install and open Avaya IX™ Workplace Client for Android, you must configure a few permissions for
Avaya IX™ Workplace Client to work properly. Permissions are categorized into required and optional.

To use Avaya IX™ Workplace Client, you must provide the required permissions at a minimum. To get the best
user experience, you must provide all permissions. For example, permission to record audio and to make and
manage phone calls is mandatory for Avaya IX™ Workplace Client to function properly. Permission to provide
access to your contacts, calendar, and camera is optional.

Desktop clients

Security certificates on desktops
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Avaya IX™ Workplace Client requires security certificates to establish connections with various servers.

If you need to install additional certificates, follow the instructions provided by your administrator.

Installing Avaya IX Workplace Client on desktops
About this task

Use this procedure to install Avaya IX™ Workplace Client on desktop platforms.

Your administrator can also install Avaya IX™ Workplace Client on desktop platforms using a command line
option. The administrator can deploy Avaya IX™ Workplace Client for Windows to work in a Citrix, XenApp, or
VMWare environment. For more information, see Planning for and Administering Avaya IX™ Workplace Client for
Android, iOS, Mac, and Windows.

Before you begin

Ensure that your Windows or Mac device meets the following minimum hardware requirements:

« Dual-core processor
+ 2 GB of RAM
+ 1.5 GB free hard disk space

Download the Avaya IX™ Workplace Client build for Windows or Mac to your computer. You can get the build
location from your administrator.

For Avaya IX™ Workplace Client for Windows, ensure that:

+ You have Microsoft .NET Framework 4.8 or a later version. This is required with Windows 10 and with
Windows Server 2012, 2016, and 2019.

« Microsoft Visual C++ Redistributable for Visual Studio 2017 package is installed.

For Avaya IX™ Workplace Client for Mac, ensure that you have Mac 0S 10.11 or a later version.

Procedure
1. On the desktop for:

« Windows: Double-click the Avaya IX Workplace Setup 3.9.0.XXX.msi file.
» Mac: Double-click the Avaya IX Workplace-XX.dmg file.

2. Accept the terms of the license agreement, select the default values, and complete the installation.
By default, the installer installs Outlook Plugin. Additionally, the Windows installer installs Web Extension on

Microsoft Internet Explorer and Mozilla Firefox. Outlook Plugin uses the language of the Microsoft Office suite
and Web Extension uses the language of the web browser.
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3. Optional: On Avaya IX™ Workplace Client for Windows, if you do not want to install Outlook Plugin and Web
Extension by default:

1. Select the Custom setup type.

2. Disable the Outlook Plugin and Web Extension installation, and complete the installation.

Opening the Avaya IX Workplace Client application for
the first time

About this task

Use this procedure after you install Avaya IX™ Workplace Client and open it for the first time.

If you have an account, you can configure Avaya IX™ Workplace Client and log in to Avaya IX™ Workplace Client.
Alternatively, you can just join a meeting.

Procedure

+ To join a meeting, select Join a Meeting.

« To configure your account, select Configure my account.

Automatic configuration overview

You can configure the Avaya IX™ Workplace Client settings automatically using your email address or the
automatic configuration web address.

If you type your email address and the DNS check:

+ Is successful, the automatic configuration file is downloaded. If your administrator has provisioned more than
one environment, you must choose an environment before the automatic configuration file is downloaded.

+ Fails, your email address is automatically searched in the following accounts and in the following priority:

1. Avaya Spaces

2. Avaya Equinox® Meetings Online

By using Avaya Spaces or Avaya Equinox® Meetings Online, if the automatic configuration file is:

+ Found in the URL, the automatic configuration file is downloaded.
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+ Not found in the URL, you must enter a web address or manually configure the application.If the automatic
configuration file is found in the web address, the automatic configuration file is downloaded.

In both instances, if your administrator has provisioned more than one environment, you must choose an
environment before the automatic configuration file is downloaded.

If the automatic configuration file that is downloaded does not include your credentials for the various services,
you must manually enter your credentials to log in to each service.

You might be able to view further screens related to Avaya Cloud accounts depending on whether:

+ Your Avaya Cloud account exists for Spaces and Messaging.

+ Your administrator has enabled the Avaya Cloud Account setting for your account.

You can additionally configure your account to use the Avaya Equinox® Meetings Online service.

Configuring Avaya IX Workplace Client settings
automatically

About this task

Use this procedure if you have an Avaya IX™ Workplace Client account and want to sign in to Avaya IX™
Workplace Client. You can configure the Avaya IX™ Workplace Client settings automatically using your email
address or the automatic configuration web address.

Before you begin
Do one of the following:

+ Ensure that your administrator has set up the correct DNS records. In this case, you can automatically configure
Avaya IX™ Workplace Client using your email address.

+ Get the automatic configuration web address from your administrator.

Procedure

1. OnAvaya IX™ Workplace Client, select Configure my account.
You can configure your account in one of the following ways:

1. Optional: To use your work email address for auto discovery:

1. Inthe Emailfield, type your email address and select Next.

2. Choose the enterprise environment that you want to use and select Next if applicable.
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Avaya IX™ Workplace Client configures the settings automatically.

2. Optional: To use the automatic configuration web address for auto discovery:

1. Select : .

2. Select Use a web address.
3. Inthe Web Address field, type the web address and select Next.

Avaya IX™ Workplace Client configures the settings automatically.
3. Depending on what the screen displays, do one or more of the following:

« If the automatic configuration file includes support for OAuth, you can enter your enterprise credentials on
the IdP login page. However, if you close the page without performing OAuth authentication, Avaya IX™
Workplace Client displays the screen to type your email address.

« If the automatic configuration file includes support for Microsoft Modern, you can enter your exchange
calendar credentials on the Microsoft Modern Authentication login page. You can then access your Office 365
calendar in Avaya IX™ Workplace Client.

« If the automatic configuration file does not include your Single Sign-on (SSO) or Avaya Authorization
configuration for the various services, manually enter your credentials to log in to each service.

« If your Avaya Cloud account exists, type your credentials for Avaya Spaces and select Sign In.

« Alternatively, if you have an account on Google, Office365, Salesforce, or Avaya, select the corresponding icon
to log in to Spaces with your account credentials.

4. Optional: If you used your email address to configure Avaya IX™ Workplace Client and you have an Avaya
Equinox® Meetings Online account, do the following:

1. Type your credentials to access the Avaya Equinox® Meetings Online service.
2. Select Next.

Configuring the Avaya Equinox Meetings Online service
About this task

If you did not configure the Avaya Equinox® Meetings Online service during the automatic configuration process,
you can configure the Avaya Equinox® Meetings Online service using the Check for Services option. Avaya
Equinox® Meetings Online is cloud-based while Avaya IX™ Workplace Client is on-premise.

G Note:

If you configure Avaya Equinox® Meetings Online but want to revert later to use the on-premise client, your
administrator must enable Unified Portal using automatic configuration.
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Before you begin

Ensure that:

» You are noton a call.

+ Your administrator enabled Avaya Equinox® Meetings Online account discovery.

+ Your administrator disabled Unified Portal when setting up automatic configuration.This ensures that no other
Conferencing service exists.

Procedure

In the Avaya IX™ Workplace Client settings, select Check for Services.
In the Enter Email field, type your email address for Avaya Equinox® Meetings Online.

3. Do one of the following:

.

On mobile clients: Select Next.
On desktop clients: Select Continue.

Avaya IX™ Workplace Client checks for your Avaya Equinox® Meetings Online account and displays a dialog
box to configure the Avaya Equinox® Meetings Online service.

Select Configure.

Avaya IX™ Workplace Client logs you out and displays a screen for entering your Avaya Equinox® Meetings
Online credentials.

5. Type your credentials.
6. Select Next.

Avaya IX™ Workplace Client sets up the Avaya Equinox® Meetings Online service.
Select Let’s Go!.

Avaya IX™ Workplace Client logs you in and displays the Top of Mind screen with the configured Avaya
Equinox® Meetings Online service.

Using the Avaya IX Workplace Client menu

Procedure

1.

On mobile clients, on the Top of Mind screen, select .
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2. Toview a screen, select the corresponding option:

« Top of Mind: Only for UC and OTT signed-in users

« Join Meeting: Only for OTT users

« Favorites: Only for UC users

« Contacts: Only for UC users

« History

+ Messages: Only for UC users

+ Meetings: Only for UC and OTT signed-in users

« Features: Only on mobile clients for UC users

« Exit: Only on Avaya IX™ Workplace Client for Android

Manual configuration of Avaya IX Workplace Client
settings

You must configure the Avaya IX™ Workplace Client settings on the Services screen manually if you are not using
automatic configuration. For more information, see Services settings.

The following sections describe how to manually configure and update all client settings. You might need to
restart Avaya IX™ Workplace Client after you manually configure or update the client settings.

Avaya IX Workplace Client Top of Mind screen

Avaya IX™ Workplace Client displays the Top of Mind screen as the home screen. You can use the Top of Mind
screen to:

+ Join Avaya IX™ Workplace Client and Spaces meetings with one touch and view your meeting calendar.

G Note:

You cannot click to join an Avaya IX™ Workplace Client meeting from your calendar. However, if you are using the
Avaya IX™ Workplace Client add-in for Microsoft Outlook, you can click to join from the meeting invitation.

+ Respond to the latest messages and view your active conversations.

+ Return important missed calls and view your call activity.
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+ Start a meeting, join an Avaya IX™ Workplace Client meeting, log in to Spaces or open the Spaces dashboard, and
go to your meeting portal.

Configuring the layout of the Top of Mind screen
About this task

Use this procedure to configure what you want to view on the Top of Mind screen. For example, you might
choose to view the meeting calendar and meeting room details, but hide call history and messages.

Procedure

1. Onthe Top of Mind screen, select the Top of Mind filter.
2. Optional: If the Top of Mind switch is in the disabled state, select Top of Mind. Otherwise, go to the next step.
3. Do the following:

« To hide your meeting information, in the Next Meetings area, select Hide.

« To configure the number of meetings to be displayed on the Top of Mind screen, select Auto or Full Day.If you
select Auto, the number of meetings displayed depends on the Avaya IX™ Workplace Client logic. If you select
Full Day, Avaya IX™ Workplace Client displays the meetings for the current day.

« To configure the calendars that you want to display, select Calendars to show and select the option for the
corresponding account.

+ To hide your messages, in the Messages area, select Hide.
« To hide your call history, in the History area, select Hide.
« To hide your meeting room details, in the Workplace Meetings area, select Hide.

« To view the default layout on the Top of Mind screen, select Reset Layout to Default.

Using the Top of Mind screen
About this task

Use this procedure to perform most of your daily activities in the enterprise.

Procedure

« Start typing the name of the contact or the contact details that you want to look for in the following field:

« On mobile clients: find someone
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« On desktop clients: name or number
Avaya IX™ Workplace Client displays the contacts that match the search text.

+ In the Next Meetings area, you can select the following:

« 7 :To view additional meetings.

A meeting: To view more information about the meeting.

r-.f;' B:

or : To join the Avaya IX™ Workplace Client meeting.To view both the audio and video options for a
meeting entry, on Android devices, you must press and hold a meeting entry. While on iOS devices, you must
swipe to the right on a meeting entry. You can join a meeting using this option only if the conference bridge
number is in the Tel: URL format. For example, tel:+16135959132. You must include this format in the
Location field or the Body area of the email.

« "7 To join the Spaces meeting using the Spaces application only on mobile devices or the default
browser. For best experience, the default browser must be WebRTC compliant.

+ In the Messages area, you can select the following:

« 7:Toviewall your active conversations.
« A conversation: To view more information about the conversation.

+ In the History area, you can select the following:

« 7 :To view the complete call history.

« Acall: To view more information about the call.

y [

o« = or : To call the number.

+ In the My Meeting Room area, you can select the following:

« Start My Meeting: To start your meeting.

« Workplace Meetings: To join a meeting. By default, Avaya IX™ Workplace Client saves the details of your last
meeting.

« Spaces Dashboard: To open the Spaces dashboard.If you are not logged in to Avaya Cloud Services, you must
sign in to Spaces. If you do not have an account, you must sign up for Spaces.

+ Go to My Meeting Portal: To view the portal where you can configure your virtual room and other settings.

Configuring the display preferences
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About this task

Use this procedure only on desktop clients to configure the functionality of the Avaya IX™ Workplace Client main
window when you select X on the main window.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences.
2. Select Display.

3. Inthe Main Window X Preferences field, select one of the following:

+ Minimize to the taskbar

« Exit application

« Minimize to the notification area: Only on Avaya IX™ Workplace Client for Windows
4. Savethe changes.

Configuring the language preference on Windows
clients

About this task
You can set a language of your preference for Avaya IX™ Workplace Client.
Procedure

1. Inthe Avaya IX™ Workplace Client settings, click User Preferences.
2. Click Display.

3. Inthe Languages field, click the language that you want to use.

4. Save the changes.

Hidden mode

To enable the blind and visually impaired to use Avaya SIP phones, such as the J100 series, Avaya IX™ Workplace
Client for Windows supports the hidden mode. While using your deskphone for calls, Avaya IX™ Workplace Client
for Windows is not visible on your computer. This prevents unwanted interactions with screen readers.

In the hidden mode:
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+ Avaya IX™ Workplace Client is minimized to the notification area.

+ Notifications, dialogs, and pop-ups are not shown on the screen.

» All Avaya IX™ Workplace Client related windows are hidden, except:

» Screen Link, Options and Settings, Log out, and Close application: You can click these options from the right-
click menu of the Avaya IX™ Workplace Client icon in the Notification area.

« Login.

+ You receive audio notifications for incoming calls.

Configuring the hidden mode on Avaya IX Workplace
Client for Windows

About this task

To enable the blind and visually impaired to use Avaya SIP phones, such as the J100 series, Avaya IX™ Workplace
Client for Windows supports the hidden mode. While using your deskphone for calls, Avaya IX™ Workplace Client
for Windows is not visible on your computer. This prevents unwanted interaction with screen readers.

&Tip:

You can also enable the hidden mode by right-clicking the Avaya IX™ Workplace Client icon in the Notification
area and clicking the Turn Hidden Mode on option from the menu.

Before you begin

Ensure that your administrator enabled hidden mode when setting up automatic configuration.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, click User Preferences.

2. Click Display.

3. Ifthe Hidden Mode switch is in the disabled state, click Hidden Mode.
4. Savethe changes.

Narrator
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If you enable the narrator in Avaya IX™ Workplace Client for Windows, you can hear audio narrations through the
configured playback device on your Windows system. If you want to hear audio narrations through another
device, you must configure the playback device manually from the Windows system settings.

For example:

+ Foranincoming call with caller ID, you hear: Incoming Call from <Caller ID Name>.

+ If you enable Send All Calls, you hear: Send All Calls is now ON.
If you configure the keyboard shortcuts related to narrator, then you can:

« Stop the narration immediately.

+ Repeat the last narration.

Configuring the narrator on Avaya IX Workplace Client
for Windows

Procedure

1. Inthe Avaya IX™ Workplace Client settings, click User Preferences > Audio / Video.
Avaya IX™ Workplace Client displays the audio and video settings.

2. Click Narrator.
Avaya IX™ Workplace Client displays the Narrator screen.

If the Narrator switch is in the disabled state, click Narrator.

In the Voice field, click the voice in which you want to hear the audio narration.

Optional: To adjust the narration speed, move the Speed slider to the left or right.

Optional: To adjust the volume of the narration voice, move the Volume slider to the left or right.

N oo s w

. If you want the narrator to announce the caller ID for an incoming call, enable the Announce Caller ID for
ncoming Calls switch.
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8. Savethe changes.

Configuring keyboard shortcuts on Avaya IX Workplace
Client for Windows

About this task

Use this procedure to configure keyboard shortcuts on Avaya IX™ Workplace Client for Windows. If you configure
a keyboard shortcut as Global, you can use the shortcut key even when the application is not in focus.

The keyboard shortcuts are of the following types:

Main shortcuts: You can view these shortcuts at the top of the list, customize the shortcuts, and set the shortcuts
as global hotkeys.

Other shortcuts: You can view these shortcuts after the main shortcuts. These shortcuts are read only, and you
cannot set the shortcuts as global hotkeys.

The keyboard shortcut that you configure must:

Be unique. The shortcut cannot already be in use.
Include a minimum combination of a character and non-character key.
Not be a common shortcut that is used across applications.

Not be a global shortcut for Windows or any other application.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, click User Preferences > General.

2. Click Keyboard Shortcuts.

3. Forany command, in the Shortcut field, type the keyboard shortcut that you want to use.

4. To use the shortcut key even when the application is not in focus, select the corresponding Global check box.
5. Optional: To reset all changed shortcuts and global settings to their default values, click Reset to Defaults.

6. Save the changes.

Configuring the contact search settings on Avaya IX
Workplace Client for Android
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About this task

Use this procedure only on Avaya IX™ Workplace Client for Android. For iOS, you must use the local OS setting.

You can configure the contact search settings so that Avaya IX™ Workplace Client arranges and displays the list of
names by first name or last name.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, tap User Preferences.
2. Tap Contacts.

3. Inthe Display Preferences area, tap Name Display Preferences.
4. Tap one of the following:

« First Name First

« Last Name First
5. Inthe Display Preferences area, tap Name Sort Preferences.
6. Tap one of the following:

o First Name
« Last Name
7. Save the changes.

Avaya IX™ Workplace Client displays the contact search results according to the selected criteria the next time
that you perform a search.

Configuring the contact search settings on desktop
clients

About this task

You can configure the contact search settings so that Avaya IX™ Workplace Client arranges and displays the list of
names by first name or last name.

© Note:

On Avaya IX™ Workplace Client on desktop platforms, on the Favorites screen, you can arrange your favorite
contacts by dragging and dropping the contacts according to your preference.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, click User Preferences.
2. Click Contacts.
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3. Inthe Name Display Preferences area, click one of the following:

« First, Last
o Last, First

4. Inthe Name Sort Preferences area, click one of the following:

« First Name
» Last Name
5. To view local contacts, click Show Local Contacts.

6. Save the changes.

Avaya IX™ Workplace Client displays the contact search results according to the selected criteria the next time
that you perform a search.

Modifying contact settings
About this task

Use this procedure to enable Avaya IX™ Workplace Client to access your Contacts list.

For example, before you send an instant message, Avaya IX™ Workplace Client can check your contacts on the
Avaya Multimedia Messaging server to ensure that you can send a message to a contact. If the contact does not
exist on the Avaya Multimedia Messaging server, you cannot use Avaya IX™ Workplace Client to send an instant
message to that contact.

© Note:

Avaya collects data for quality improvement purposes. No personal identity information is tracked.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences.

2. Optional: If available on the Avaya IX™ Workplace Client platform, select Contacts. Otherwise, go to the next
step.

3. Select Messaging Address Validation.

4. Save the changes.

Modifying audio and video settings on mobile clients
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About this task

Use this procedure only on mobile clients.
'9 Note:

+ Currently, there is no option in Avaya IX™ Workplace Client for iOS to change the default ringtone for incoming
calls.

+ On Android devices, during a video call, you can switch the audio path between the speaker and earpiece if
external audio devices are unavailable. Avaya IX™ Workplace Client for iOS has a limitation that the earpiece
option is unavailable during video calls. iOS reduces the number of allowable audio routes to be only those that
are appropriate for video chat applications. Any external audio devices that are attached to the iOS device are
added to the routable output list so that you can switch the audio path.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences > Audio / Video.
Avaya IX™ Workplace Client displays the audio and video settings.
On Avaya IX™ Workplace Client for Android, do the following:

1. Select Ringtone.

2. Select the new ringtone, and save the changes.
On all mobile clients, do the following:
1. Select Use VolP for calls and then select one of the following:

+ Never: Avaya IX™ Workplace Client removes the VolP option from the Outgoing Calls screen.

« Prefer Wi-Fi: You can view the VoIP option on the Outgoing Calls screen if you log in to the VoIP service. This is
the default option.

« Wi-Fi only: If you are using Wi-Fi and you log in to the VolIP service, Avaya IX™ Workplace Client displays the
VolP option on the Outgoing Calls screen. If not, Avaya IX™ Workplace Client removes the VoIP option from
the Outgoing Calls screen.

« Prefer cellular data: You can view the VolP option on the Outgoing Calls screen if you log in to the VoIP
service.

2. Optional: To have video on a call, select Video Calling.

3. Optional: To have video on a call only over the cellular data network, select Video calling over cellular.

You cannot view the Video calling over cellular option if your administrator configures the VolP calling
parameter with value as Wi-Fi only.

4. Optional: To configure the microphone and camera settings when you join an Avaya Equinox® Conferencing
meeting, do the following:

» To mute your microphone, select Mute my Microphone when Joining Meeting.

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 48



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

+ To block your camera, select Block my Camera when Joining Meeting.

If your administrator hides or locks one or both of these settings, you cannot change the microphone and

camera settings.

5. Save the changes.

VolIP calls

Avaya IX™ Workplace Client maintains an internal variable to represent user preferences for the Use VolP for calls

setting:

« 0: Never
 1: Prefer Wi-Fi
« 2: Wi-Fionly

« 3: Prefer cellular data

Variable

VOIPCALLINGENABLED =
0

VOIPCALLINGENABLED =
1

August 4, 2020

Use VolIP for calls
= Never

Avaya IX™
Workplace Client
displays this
option as selected
by the
administrator. The
user cannot edit
the setting.

The user can select
this option.

Use VolIP for calls
= Prefer Wi-Fi

The user cannot
select this option.

Avaya IX™
Workplace Client
displays this
option as selected
by the
administrator.

The user can select
this option.

Use VolIP for calls
= Wi-Fi only

The user cannot
select this option.

The user can select
this option.
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Use VolP for calls
= Prefer cellular
data

The user cannot
select this option.

The user cannot
select this option.
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Use VoIP for calls Use VoIP forcalls Use VolP for calls Lt P el

SO = Never = Prefer Wi-Fi = Wi-Fi only Sl
data
Avaya IX™
Workplace Client
displays this
VOIPCALLINGENABLED = | The user can select ' The user cannot option as selected ' The yser cannot
2 this option. select this option. = by the select this option.
administrator.
The user can select
this option.
Avaya IX™
Workplace Client
displays this
VOIPCALLINGENABLED = | The user can select | The user cannot The user cannot option as selected
3 this option. select this option.  select this option. by the

administrator.

The user can select
this option.

Modifying audio and video settings on desktop clients
About this task

Use this procedure only on desktop clients.

& CAUTION:

You might face audio issues with some bluetooth headsets if you do not select the correct microphone and
speaker.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences > Audio / Video.
Avaya IX™ Workplace Client displays the audio and video settings.

2. Do the following:

« Select the microphone, speaker, and camera that you want to use.
«+ To decrease or increase the volume of the microphone and speakers, move the sliders to the left or right.
+ To have video on a call, select Video Calling.
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+ To mute your microphone when you join an Avaya Equinox® Conferencing conference, select Mute my
Microphone when Joining Meeting.If your administrator hides or locks this setting, you cannot change the
microphone setting.

« To block your camera when you join an Avaya Equinox® Conferencing conference, select Block my Camera
when Joining Meeting.If your administrator hides or locks this setting, you cannot change the camera setting.

3. Save the changes.

Configuring the video resolution
About this task

Use this procedure only on desktop clients to configure the video resolution.
Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Advanced.
2. Inthe Video Max. Resolution field, select one of the following:

« Auto: Avaya recommends the use of this option to automatically configure the video resolution.
. 1080p
« 720p
- 480p
. 360p
« 240p
. 180p
3. Save the changes.
4. Restart Avaya IX™ Workplace Client.

Modifying the voice quality setting
About this task

Use this procedure only on Avaya IX™ Workplace Client for Android to configure the Echo Cancellation setting.
Echo Cancellation is a process that removes echo from a voice communication to improve voice quality on a
telephone call.

If you face double-talk issues during a conference call, that is, issues when more than one person is speaking
simultaneously, you must select Acoustic Echo Cancellation (AEC).
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Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Advanced.
2. Select Echo Cancellation.

3. Inthe Echo Cancellation dialog box, select one of the following:

« AECM
« AEC
« Off

For Bluetooth audio outputs, Avaya IX™ Workplace Client disables the AEC and Acoustic Echo Cancellation
Mobile (AECM) options.

4. Savethe changes.

Client identity certificates

You can use client identity certificates to provide an identity of the client to the server. Each client has its own
unique identity certificate issued by the Certification Authority or Registration Authority. Avaya IX™ Workplace
Client can get the certificates issued in one of the following ways:

+ Through Simple Certificate Enrollment Protocol (SCEP) servers, such as Network Device Enrollment Service
(NDES) in Active Directory Certificate Services (AD CS).Avaya IX™ Workplace Client for Android and iOS support
the SCEP method of installing client identity certificates. If the SCEP certificate needs a password, you must
contact your administrator for the SCEP password.

« On Android devices, enter the password on the Identity Certificate screen.

« OniOS devices, tap the message to enter the SCEP password.

« By manualinstallation: You provide the necessary certificate file using out-of-band mechanism.Avaya IX™
Workplace Client for Android, Mac, and Windows support the manual method of installing client identity
certificates.

+ By a URL installation: The settings file contains the PKCS12URL location from where you can download the
certificate.Avaya IX™ Workplace Client for Android and iOS support the URL method of installing client identity
certificates.

If SCEP and PKCS12URL are available, PKCS12URL is used to install the client identity certificate.
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The server receives the client certificate through TLS mutual authentication and the certificate is verified. For
more information, see Administering Avaya Aura® Session Manager.

Installing a client identity certificate from the system
certificate store

About this task

Use this procedure only on Avaya IX™ Workplace Client on desktop platforms.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Advanced.
2. Select Identity Certificate.

3. IntheInstall new certificate area, do one of the following:

« On Avaya IX™ Workplace Client for Mac: In the Select from the keychain field, select a certificate.

+ On Avaya IX™ Workplace Client for Windows: In the Select from the system certificate store field, select a
certificate.

4. Inthe confirmation dialog box, confirm the action.

In the Installed certificate area, Avaya IX™ Workplace Client displays the client identity certificate that you
installed.

5. Save the changes.
6. Restart Avaya IX™ Workplace Client.

Installing a client identity certificate from a file
About this task

Use this procedure only on Avaya IX™ Workplace Client for Android and desktop platforms.

© Note:

Some versions of Android require the certificate file to have the .p12 extension as part of the file name.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Advanced.
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2. Do one of the following:

« On Avaya IX™ Workplace Client for Android: Select Client Certificate.
« On desktop clients: Select Identity Certificate.

On Avaya IX™ Workplace Client for Android, do the following:
1. Select Other options.
On all clients, do the following:

1. Select select from afile.

2. Select the certificate file that you want to install.

3. Inthe confirmation dialog box, confirm the action.

4. Inthe password prompt dialog box, type the password for the certificate and then select Next.

In the Installed certificate area, Avaya IX™ Workplace Client displays the client identity certificate that you
installed.

5. Save the changes.
On desktop clients, do the following:

1. Restart Avaya IX™ Workplace Client.

Removing a client identity certificate

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Advanced.
On Avaya IX™ Workplace Client for Android and desktop platforms:
1. Do one of the following:

« On Avaya IX™ Workplace Client for Android: Select Client Certificate.
« On desktop clients: Select Identity Certificate.

On all clients:
1. Do one of the following:

« On Avaya IX™ Workplace Client for Android: In the Installed certificate area, tap the X icon next to a certificate.
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« On Avaya IX™ Workplace Client for iOS: Select Delete Client Certificate.
« On desktop clients: In the Installed certificate area, select Remove certificate.

2. In the confirmation dialog box, confirm the action.

Avaya IX™ Workplace Client removes the selected client identity certificate.
3. Save the changes.
On desktop clients, do the following:

1. Restart Avaya IX™ Workplace Client.

Services settings

You can manually configure the settings for the following services in Avaya IX™ Workplace Client if you are not
using automatic configuration:

« Sign In Service

+ Phone Service

+ My Meeting Room

+ Enterprise Directory: Only on desktop clients

+ Multimedia Messaging

» Avaya Cloud Services

+ Device Services

+ Client Enablement (CES): Only on mobile clients

+ Voicemail

+ Exchange Calendar

+ EC500 Calling: Only on mobile clients

Selecting the authentication mechanism for each
service
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About this task

You can select one of the available authentication mechanisms to access one or more services in Avaya IX™
Workplace Client:

Avaya Authorization: To use your enterprise credentials. This authentication mechanism is unavailable for the
Microsoft Exchange Calendar service.

+ Manual: To manually enter your credentials.
+ Unified Login: To use the same set of credentials.

« Microsoft Modern: To use your calendar credentials. This authentication mechanism is only available for the
Microsoft Exchange Calendar service.

Before you begin

+ Avaya IX™ Workplace Client does not display the Sign In Service option if all services are disabled.

+ Avaya IX™ Workplace Client displays the Avaya Authorization option only if you perform automatic configuration
using Avaya Aura® Device Services.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Do one of the following:

« On mobile clients: Select Service Details.
« On desktop clients: Select Show Details.
3. Select Sign In Service.
4. For each available service, select one of the following:

« Avaya Authorization

+ Manual

« Unified Login

+ Microsoft Modern
5. Save the changes.

Modifying VolP settings
About this task

Use this procedure to enable VolP interoperability with Avaya IX™ Workplace Client.
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Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Optional: Do one of the following:

« On mobile clients: Select Service Details.
« On desktop clients: Select Show Details.
3. Select Phone Service.

4. Optional: If the Phone Service switch is in the disabled state, select Phone Service. Otherwise, go to the next
step.

5. Inthe Server Address field, type the IP address or the FQDN of the VolIP server.

6. Inthe Server Port field, type the VolP server port number.

7. Inthe Domain field, type the SIP domain to which Avaya IX™ Workplace Client must register.
8. To use a secure connection to the VolP server, select Use TLS.

By default, Avaya IX™ Workplace Client supports TLS and the port number for it is 5061. If you clear this
setting, the default port value changes to 5060. You can also manually configure the port value.

9. Inthe Adhoc Conference Address field, type the URL that defines the adhoc conference resource to be used by
the endpoint.

10. Save the changes.

Modifying messaging settings
About this task

Use this procedure to enable Avaya Multimedia Messaging interoperability with Avaya IX™ Workplace Client.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Optional: Do one of the following:

« On mobile clients: Select Service Details.
« On desktop clients: Select Show Details.
3. Select Multimedia Messaging.

4. Optional: If the Avaya Multimedia Messaging switch is in the disabled state, select Multimedia Messaging.
Otherwise, go to the next step.

5. Inthe Server Address field, type the IP address or the FQDN of the Avaya Multimedia Messaging server.
6. Inthe Server Port field, type the Avaya Multimedia Messaging port number.
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7. Inthe Polling Interval field, select the interval at which you want to refresh information between Avaya IX™
Workplace Client and the Avaya Multimedia Messaging server.

The default value is Continuous. Information between Avaya IX™ Workplace Client and the Avaya Multimedia

Messaging server is refreshed immediately.

8. Save the changes.

Modifying Avaya Cloud Services settings
About this task

Use this procedure to enable Avaya Cloud Services interoperability with Avaya IX™ Workplace Client. If you
enable Avaya Cloud Services, Avaya Spaces integrates with Avaya IX™ Workplace Client.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Optional: Do one of the following:

» On mobile clients: Select Service Details.

« On desktop clients: Select Show Details.
3. Select Avaya Cloud Services.
4. Optional: If the Avaya Cloud Services switch is in the disabled state, select Avaya Cloud Services.
5. Save the changes.

Modifying Avaya Aura Device Services settings
About this task
Use this procedure to enable Avaya Aura® Device Services interoperability with Avaya IX™ Workplace Client.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Optional: Do one of the following:

« On mobile clients: Select Service Details.
« On desktop clients: Select Show Details.
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3. Select Device Services.

4. Optional: If the Avaya Aura® Device Services switch is in the disabled state, select Device Services. Otherwise,
go to the next step.

5. Inthe Server Address field, type the IP address or the FQDN of the Avaya Aura® Device Services server.
6. Inthe Server Port field, type the Avaya Aura® Device Services port number.
7. Save the changes.

Modifying Client Enablement Services settings
About this task

Use this procedure only on mobile clients to enable Client Enablement Services interoperability with Avaya IX™
Workplace Client.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Optional: Select Service Details.

3. Select Client Enablement (CES).
4

. Optional: If the Client Enablement Services switch is in the disabled state, do one of the following. Otherwise,
go to the next step.

« On Avaya IX™ Workplace Client for Android: Select CES.

+ On Avaya IX™ Workplace Client for iOS: Select Client Enablement Services.
5. Inthe Server Address field, type the IP address or the FQDN of the Client Enablement Services server.
6. Inthe Server Port field, type the Client Enablement Services port number.
7. Select Calls to My Phones, and select one of the following:

« Primary: When you receive a call on the primary extension, the telephone numbers listed in My Phones also
receive a call.

« All Extensions: When you receive a call on the primary extension or the bridged extension, the telephone
numbers listed in My Phones also receive a call.

8. Save the changes.

Modifying Exchange Calendar settings
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About this task

Use this procedure to enable Microsoft Exchange Calendar interoperability with Avaya IX™ Workplace Client. This
is only applicable if you are getting the Exchange Calendar information through Exchange Web Services. On
Android and iOS devices, you can access the Exchange Calendar information in Avaya IX™ Workplace Client using
the device’s native calendar support. If the Exchange server has been configured to prevent mobile access, you
cannot access the Exchange Calendar information.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Optional: Do one of the following:

« On mobile clients: Select Service Details.
« On desktop clients: Select Show Details.
3. Select Exchange Calendar.

4. Optional: If the Exchange Calendar switch is in the disabled state, select Exchange Calendar. Otherwise, go to
the next step.

5. Inthe Domain field, type the Exchange server domain to which Avaya IX™ Workplace Client must register.
For example, avaya . com.

6. Inthe Server Address field, type the IP address or the FQDN of the Exchange server.
For example, usmail.avaya.com.

7. Save the changes.

Modifying conference settings
About this task

Use this procedure if you want to use the conferencing features of Avaya Equinox® Conferencing.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Optional: Do one of the following:

» On mobile clients: Select Service Details.
« On desktop clients: Select Show Details.
3. Select My Meeting Room.
4. Modify the values in the fields as required.
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5. Save the changes.

My Meeting Room field descriptions

Name

My Meeting
Room

Meeting Address

Conference
Access Number

Moderator Code

Participant Code

Participant URL

Description

To enable or disable your meeting room.

This is applicable only to Avaya Equinox® Conferencing.

The conference portal address. This parameter is used to:
Populate the meeting invitation location field with the URL for participants to
join the meeting.

Connect to portal to retrieve meeting invitation template.

The primary conference access number.

This parameter is only used by the Avaya IX™ Workplace Client Add-in for
Microsoft Outlook for the Avaya Aura® Conferencing bridge, not for the Avaya
Equinox® Conferencing bridge where the email template is auto-discovered.
The code needed to host a conference.

This is applicable only to Avaya Aura® Conferencing.

The code needed to participate in a conference.

This is applicable only to Avaya Aura® Conferencing.

This parameter is used to populate the meeting template and the location field
with the URL to join the meeting.

This is applicable only to Avaya Aura® Conferencing and is currently supported
only on desktop clients.

Avaya IX™ Workplace
Client support

Available on all
platforms

Available on all
platforms

Available on desktop
clients

Available on all
platforms

Available on all
platforms

Available on all
platforms

Modifying enterprise directory settings
About this task

Use this procedure only on desktop clients to enable enterprise directory interoperability with Avaya IX™

Workplace Client.
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Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Optional: Select Show Details.

3. Select Enterprise Directory.
4

Optional: If the Enterprise Directory switch is in the disabled state, select Enterprise Directory. Otherwise, go

to the next step.

5. Inthe Server Address field, type the IP address or the FQDN of the Enterprise Directory server.
6. Inthe Server Port field, type the Enterprise Directory port number.

7. Touse SSL, select Use TLS.

8. Inthe LDAP Search Base field, type the Enterprise Directory search base.

For example, cn=users,dc=svucacloud, dc=com.

9. Save the changes.

EC500 settings

You can use EC500 (Extension to Cellular) to integrate your mobile phone with your Avaya PBX number. With

EC500, you can answer calls to your telephone number on your mobile phone and transfer them between your

deskphone and mobile phone without interrupting the call.
© Note:

Calls ring on your EC500 cellular number only when you do not log in to your Avaya IX™ Workplace Client on
mobile platforms.

You can configure the following EC500 settings using Avaya IX™ Workplace Client:

Idle Appearance Select: To identify an idle line on your extension when you make a call.

Active Appearance Select: To join a call on your deskphone using your mobile phone.

Off PBX Call Enable: To enable your mobile phone to ring when you receive a call on your deskphone.

Off PBX Call Disable: To disable your mobile phone from ringing when you receive a call on your deskphone.
Call Forward All Enable: To activate call forwarding for all calls.

Call Forward All Disable: To disable call forwarding.

Send All Calls Enable: To send all calls to a predefined number set on the server by your administrator. The
number is usually your corporate voice mail number.

Send All Calls Disable: To disable the sending of all calls to a predefined number set on the server by your
administrator.
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© Note:

To configure the Station Security feature, contact your administrator. The Station Security feature reduces the
risk of toll fraud by appending a valid station security code with the EC500 FNE for all outgoing EC500 calls from
Avaya IX™ Workplace Client.

Configuring the EC500 settings manually
About this task

Use this procedure only on mobile clients.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.
2. Optional: Select Service Details.

3. Select EC500 Calling.
4

. Optional: If the EC500 calling switch is in the disabled state, select EC500 Calling. Otherwise, go to the next
step.

5. To configure or update the required EC500 setting, select the corresponding option.
6. Type the appropriate feature name extension (FNE).
7. Savethe changes.

Modifying voice mail settings
About this task

Use this procedure to change the voice mail PIN, voice mail number, and SMS notification setting in Avaya IX™
Workplace Client. On desktop clients, you can only change the voice mail number.

To change the voice mail PIN on the voice mail server, you must make a call to the voice mail server and use the
server menus. You must then use this procedure to set the new voice mail PIN in Avaya IX™ Workplace Client.

Before you begin

Avaya IX™ Workplace Client displays, hides, or disables the voice mail settings depending on the services that
you configure:

+ If you configure Client Enablement Services, Avaya IX™ Workplace Client displays the System Number field as
read-only.

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 63



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

« If you configure VolIP and not Client Enablement Services, Avaya IX™ Workplace Client does not display the
Voicemail setting in Avaya IX™ Workplace Client.

« If you do not configure VoIP and Client Enablement Services and configure EC500, Avaya IX™ Workplace Client
displays the Voicemail setting and the System Number field is editable.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Services.

2. Optional: Do one of the following:

« On mobile clients: Select Service Details.
« On desktop clients: Select Show Details.
3. Select Voicemail.

4. Optional: If available on the Avaya IX™ Workplace Client platform, select System Number. Otherwise, go to
the next step.

1. Change the voice mail number.

2. Ifavailable on the Avaya IX™ Workplace Client platform, select Save. Otherwise, go to the next step.
Avaya IX™ Workplace Client verifies and saves the setting.

5. Select PIN.
6. Change the voice mail PIN.

7. Optional: If available on the Avaya IX™ Workplace Client platform, select Save. Otherwise, go to the next step.
Avaya IX™ Workplace Client verifies and saves the setting.

8. Select Voicemail SMS Notification.

On Avaya IX™ Workplace Client for Android, do the following:

1. Inthe Voicemail SMS Notification dialog box, select one of the following:

« Off: The device does not receive any notification when a voice mail arrives on the Client Enablement Services
server.

+ Urgent Only: The device receives an SMS notification only for those voice mails that the sender marks as
urgent.

« All: The device receives an SMS notification for all voice mails.
On Avaya IX™ Workplace Client for iOS, do the following:

1. Inthe E-mail to SMS address field, type a valid SMS or email address.
2. Select Notify Me About and select one of the following:

+ All Messages: The device receives an SMS notification for all voice mails.
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+ Urgent Messages Only: The device receives an SMS notification only for those voice mails that the sender
marks as urgent.

On all clients, do the following:

1. Savethe changes.

Configuring dialing rules manually
About this task

Avaya IX™ Workplace Client populates the following dialing rules when you use automatic configuration:

+ The number to dial to access an outside line.

+ Your country code.

+ Your area or city code.

+ The main prefix of the PBX.

» The number to dial for long distance calls.

» The number to dial for international calls.

+ The length of internal extensions.

+ The length of national phone numbers.

« The option to remove the area or city code for local calls.
+ The option to apply dialing rules to plus sign (+) numbers.

Use this procedure to manually configure or update the dialing rules with the correct values after consulting with
your administrator.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Advanced.

2. Select Dialing Rules.

3. Ifthe Dialing Rules switch is in the disabled state, select Dialing Rules.
4. Configure or update the required dialing rules setting.
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5. Save the changes.

Enabling or disabling the EC500 features
About this task

Use this procedure only on mobile clients to enable or disable the following EC500 features:

Join Active Call: To join a call on your deskphone using your mobile device.

Simultaneous Ring: To activate simultaneous ringing on your deskphone and mobile device when a call arrives
on your deskphone. You cannot select this option when you enable Client Enablement Services.

Call Forward: To forward all calls to another telephone number of your choice.

Send All Calls: To route all calls to your corporate voice mail number.
Before you begin

Configure the EC500 settings.

Procedure

1. Onthe Avaya IX™ Workplace Client menu, select Features > EC500 Features.
2. Toenable or disable a specific EC500 feature, select that feature.

Avaya IX™ Workplace Client makes a cellular call. You can then hear the confirmation tone.

Changing the time delay between the ringing of the
feature name extension number and the destination
number

About this task

Use this procedure only on mobile clients to configure the delay in seconds between the EC500 call being placed
and the transmission of digits for EC500. The purpose of this setting is to address call setup delays with specific
regions and trunk providers.

'0' Important:

Change this setting only on the instruction of your administrator.
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Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Advanced.
2. Select FNE Setup Delay.
3. Inthe FNE Setup Delay dialog box, select one of the following:

+ 3 Seconds
+ 6Seconds
+ 9Seconds
+ 12 Seconds
+ 15 Seconds

Avaya IX™ Workplace Client displays the new value.

4. Savethe changes.

Configuring the Avaya IX Workplace Client add-in for
Microsoft Outlook setting

About this task

Use this procedure only on Avaya IX™ Workplace Client on desktop platforms to configure the Microsoft Outlook
add-in setting.

Before you begin

Login asaUCuseroraOTT named user.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Desktop Integration.
2. Select Outlook Add-in.

3. Select Enable Outlook Add-in.

4

. Optional: On Avaya IX™ Workplace Client for Windows, to allow calls from Microsoft Outlook contacts, select
Allow calls from Outlook contacts.

5. Save the changes.
6. Restart Avaya IX™ Workplace Client.
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7. Restart Microsoft Outlook.

Configuring the browser add-in setting
About this task

Use this procedure only on Avaya IX™ Workplace Client for Windows to configure the browser add-in setting. After
you enable this add-in, you can make calls from the highlighted numbers on Google Chrome and Microsoft
Internet Explorer browsers.

Before you begin

+ LoginasaUCuser.

« InInternet Explorer, go to Tools > Internet options > Advanced and select Enable third-party browser extensions.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Desktop Integration.
2. Select Browser Add-in.

3. Select Enable Browser Add-in.

4.

Save the changes.

After you restart your browser, the browser extension is enabled.

Pausing iTunes during calls
About this task

Use this procedure only on Avaya IX™ Workplace Client for Mac.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences.
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2. Select General > Pause iTunes when making / receiving a call.

Viewing the configured call features on mobile clients
Before you begin

Your administrator must configure the call features for your extension. Features might include Automatic
Callback, Call Pickup, Call Pickup Directed, Call Pickup Extended, and Call Unpark.

Procedure

1. On the Avaya IX™ Workplace Client menu, select Features.
Avaya IX™ Workplace Client displays the configured call features for your extension.

2. Optional: If there are other extensions for which you want to enable the feature buttons, in the Features for
Other Extensions area, select the extension and enable the feature.

Viewing the configured call features on desktop clients
Before you begin

Your administrator must configure the call features for your extension. Features might include Automatic
Callback, Call Pickup, Call Pickup Directed, Call Pickup Extended, and Call Unpark.

Procedure

1. Select “— and then select Features.
Avaya IX™ Workplace Client displays the configured call features for your extension.

2. Optional: If there are other extensions for which you want to enable the feature buttons, in the Features for
Other Extensions area, select the extension and enable the feature. Otherwise, go to the next step.

3. Optional: If your administrator has configured one of the following for your station in Communication
Manager:

« Autodial button: Configure the label and number of each button in the Autodials area.Use Autodials buttons
as shortcuts to start calls to the specific numbers.
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« Busy indicator button: Make calls to the numbers associated with the busy indicator in the Busy Lines area.

Viewing release and version information

Procedure

In the Avaya IX™ Workplace Client settings, select Support > About.

Viewing the certificates that Avaya IX Workplace Client
uses

About this task

If you are using private trusted credentials, you can view a list of certificates that Avaya IX™ Workplace Client
uses.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Advanced.

2. Optional: On Avaya IX™ Workplace Client for Windows, to use both the platform and private trust store, select
Use coalesced Trust Store.

3. Do one of the following:

» On mobile clients and Avaya IX™ Workplace Client for Windows: Select Certificates.
« On Avaya IX™ Workplace Client for Mac: Select SSL Certificates.

4. To view the details of a particular certificate, select that certificate.

Viewing the legal information
About this task

Use this procedure to view the End User License Agreement (EULA), third-party licensing, and data privacy
information for Avaya IX™ Workplace Client.

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 70



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

If your administrator does not provision the data privacy URL, Avaya IX™ Workplace Client does not display the
Data Privacy link.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Support.
2. Select Legal.
3. Select one of the following:

« EULA
« Third Party Licensing

« Data Privacy: Avaya IX™ Workplace Client opens the link using the default browser on the platform.

Rating the application
About this task
Use this procedure only on mobile platforms to rate and review Avaya IX™ Workplace Client.
Before you begin
Ensure that your administrator enabled you to rate the application when setting up automatic configuration.
Procedure

1. Inthe Avaya IX™ Workplace Client settings, tap Support.
2. Tap Rate this app.

3. Rate and provide your review comments in the application store.

Logging in and out of the Avaya IX Workplace Client
services

About this task

Use this procedure to view all your Avaya IX™ Workplace Client services and the accounts that you are using to
authenticate to each service. If you enable:

« Avaya Authorization for one or more services, Avaya IX™ Workplace Client displays the Avaya Authorization area.
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+ Unified Login for one or more services, Avaya IX™ Workplace Client displays the Workplace area.

'9 Note:

If you do not know or have forgotten your credentials, you must contact your local administrator or IT
department for assistance.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Accounts.
Avaya IX™ Workplace Client displays the Accounts screen.
2. Login to the following services using your credentials:

+ Phone Service
« Client Enablement Services: Only on mobile clients
« Enterprise Directory: Only on desktop clients
+ Avaya Multimedia Messaging
» Avaya Aura® Device Services
+ Exchange Calendar
+ My Meeting Room
3. Do one of the following:

« On mobile clients: Select Connect.
« On desktop clients: Select Done.
4. To log out of Avaya IX™ Workplace Client, select Sign Out.

You can also log out from Avaya IX™ Workplace Client by selecting the presence status indicator and then
selecting Sign Out.

Maximizing the battery life of the device
About this task

Use this procedure only on Avaya IX™ Workplace Client for Android.

If you use a service, such as VolIP, the battery consumption on the device increases. If you do not use Avaya IX™
Workplace Client outside business hours, you can exit Avaya IX™ Workplace Client to maximize the battery life.

Procedure

Go to the Avaya IX™ Workplace Client menu and then select Exit.
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You are signed out from Avaya IX™ Workplace Client, and the Avaya IX™ Workplace Client application window
is closed.

Configuring the setting to automatically start and log in
to Avaya IX Workplace Client

About this task

Use this procedure to configure the setting so that Avaya IX™ Workplace Client starts by default when the
operating system starts and you are logged in automatically.

G Note:

« You cannot use this procedure on Avaya IX™ Workplace Client for iOS.

+ Depending on the Android version, you might need to unlock the device after a reboot to receive calls and
messages.

Before you begin

On the Accounts screen, do one of the following :

« On mobile clients: Select Remember passwords.

+ On desktop clients: Select Remember Password.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences.
2. Select General > Auto Start/Login.

3. Save the changes.

Notifications on mobile clients

A notification is a message that Android or iOS displays outside your application's Ul. Notifications include
reminders, communication from other people, or other timely information from your application. You can tap
the notification to open your application or take an action directly from the notification.
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You receive notifications even if you exit the application. If you do not want to receive notifications after business
hours, you must log out from the application or turn on the Send All Calls feature or a similar feature. You can
then log in to the application or turn off the Send All Calls feature when you return to office.

Android notifications

Each application can have multiple notification channels. As the application categorizes notifications into
channels, you can disable specific notification channels for Avaya IX™ Workplace Client for Android instead of
disabling all your notifications. You can control the visual and auditory options for each channel. You can also
specify the importance level of your notifications on each channel.

For example, the notification channel might be for an incoming call or incoming message from Avaya IX™
Workplace Client for Android. Android devices display these notifications through a notification, such as a
banner or alert.

To view the notifications related to Avaya IX™ Workplace Client for Android in the notification drawer, you must
configure the notification settings for Avaya IX™ Workplace Client for Android on your Android device.

You can view the notifications until you tap or clear any one notification. For example, if you tap an Avaya
Multimedia Messaging notification, the conversation opens in Avaya IX™ Workplace Client for Android and all
Avaya Multimedia Messaging notifications are cleared from the notification drawer.

'9 Note:
You cannot clear the Avaya IX™ Workplace Client Online or Error notification.

You can perform different actions depending on the type of notification. For example, for an Avaya Multimedia
Messaging notification, you can mark the message as read or reply to the message.

iOS notifications

Apple Push Notification service (APNs) is a platform notification service created by Apple Inc. With this service,
third-party application developers can send notification events to applications installed on Apple devices when
the application is idle in the background.

For example, the notification event might be for an incoming call or incoming message from Avaya IX™
Workplace Client for iOS. Apple devices display these notifications through an iOS notification, such as a banner
oralert.

To view the notifications related to Avaya IX™ Workplace Client for iOS in Notifications Center, you must do the
following:

« Connect to the VolIP service on Avaya IX™ Workplace Client for iOS.

+ Configure the notification settings for Avaya IX™ Workplace Client for iOS on your Apple device.
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You can view the notifications until you tap or clear any one notification. For example, if you tap an Avaya
Multimedia Messaging notification, the conversation opens in Avaya IX™ Workplace Client for iOS and all Avaya
Multimedia Messaging notifications are cleared from Notifications Center.

You can perform different actions depending on the type of notification. For example, for an Avaya Multimedia
Messaging notification, you can mark the message as read or reply to the message.
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Making and handling calls

Using Avaya IX™ Workplace Client, you can:

« Make audio or video calls.
« Access call control functionality, such as mute, hold, resume, or end calls.
+ Merge or transfer calls.

» Answer calls on your mobile device if EC500 is configured. You can also choose to extend calls or send all calls to
your EC500 device.

« Join or answer calls from multiple devices if MDA or Dual Registration is configured.

Escalate from an audio call to a video call, a point-to-point call to a conference call, or an IM session to a call.

© Note:

You can escalate an IM session to a call only if Avaya Aura® Device Services or LDAP is provisioned by your
administrator. You cannot escalate an IM session to a call with Avaya Spaces directory.

Call management overview

With Avaya IX™ Workplace Client, you can additionally manage calls using the following:

+ Headsets: On Avaya IX™ Workplace Client for Mac and Windows
« CallKit: On Avaya IX™ Workplace Client for i0OS
« Siri: On Avaya IX™ Workplace Client for i0S

Call management using a headset

You can use a headset with Avaya IX™ Workplace Client for Mac or Windows to perform call control actions. The
actions that you perform using your desktop device and the headset are synchronized.

You can use a USB connection from your Avaya L100 Series headset to your desktop device with Avaya IX™
Workplace Client for Mac or Windows to do the following:

+ Answer an incoming call.You can also answer an incoming call while you are on an active call. Avaya IX™
Workplace Client places the active call on hold.
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+ Dismiss an incoming call.

» Mute or unmute the call.

» Hold or retrieve the call.

+ Swap between the active and most recently held call.
+ End the call.

+ Redial your last call when no callis in progress.

© Note:

+ Desk Phone mode and Other Phone mode do not support headset call control functionality.

« If you have other applications, which are also using your headset, then the headset call control functionality such
as answer, mute, hold, or end do not work. You can then use the headset only for audio. Avaya IX™ Workplace
Client displays a notification about the limited call control functionality when Avaya IX™ Workplace Client
chooses the headset either at start-up or when you select the headset in Avaya IX™ Workplace Client.

« You can also use other headsets to perform call control actions. Consult your headset manufacturer to know
more about the supported features.

Call management using iOS CallKit

Introduced in iOS 10, CallKit is a new framework developed by Apple. CallKit enables VolP applications on iOS to
adopt the native phone Ul for calls. For example, before CallKit, incoming calls on third-party VolP applications,
such as Avaya IX™ Workplace Client for iOS, were available only as simple local notifications. With CallKit,
incoming calls are displayed fully using the native phone Ul.

With CallKit, you can:
+ Set Avaya IX™ Workplace Client for iOS as the default calling application using Mobile Device Management or

Apple Configurator.

+ Long press the Call button on a contact to override the phone application and use Avaya IX™ Workplace Client for
ioS.

+ Use your iOS do-not-disturb setting to suppress incoming calls. If you receive calls from blocked iOS contacts,
Callkit suppresses those calls.

« Use custom ringtones for a contact.

+ Handle multiple calls with the same user experience as you did while handling multiple cellular calls. Incoming
VolIP calls have the same priority as cellular calls.

» Make and answer VolP calls using a Bluetooth headset.You can also answer calls using steering wheel controls.
+ Make a call from a number of screens on the iOS device using Avaya IX™ Workplace Client for iOS.

« Use Apple CarPlay to view the call appearance on the in-car display with controls for end and mute.
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+ Receive the same user experience for VolIP calls as native cellular calls for call alerts and when you answer a call.

G Note:

If you answer an incoming video call, the video is paused. You must resume the video using Avaya IX™ Workplace
Client foriOS.

Call management using Siri

SiriKit is a new framework developed by Apple, which you can use to make calls using voice commands on Avaya
IX™ Workplace Client for iOS.

Avaya IX™ Workplace Client for iOS supports the SiriKit framework on iOS 11 and later versions. The SiriKit
framework is enabled by default.

You can use the following voice commands with Siri:

+ Call <Local contact> with Workplace.

+ Call <phone number>with Workplace.

+ Call my next meeting with Workplace.

+ Dial next meeting with Workplace.

« Video call <Local contact> on Workplace.

+ Video call my next meeting with Workplace.

« Call my virtual room on Workplace with video.

You can use Siri to call only local contacts using Avaya IX™ Workplace Client. You cannot use Siri to call enterprise
contacts using Avaya IX™ Workplace Client.

Siri functionality
If you have:

+ Overlapping meetings in your calendar, Avaya IX™ Workplace Client calls the first meeting in the meeting list that
has the Click to Join button.

« Two contacts with the same first name in the contacts list, Avaya IX™ Workplace Client calls the contact that you
created first.To avoid this situation, use the full name or nick name to call a specific contact. For example, Call
Brian Smith with Workplace.

« Multiple virtual rooms, Avaya IX™ Workplace Client calls your default virtual room.

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 78



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

+ A contact with multiple phone numbers, Avaya IX™ Workplace Client selects the first number in the list for that
contact.

Selecting the configured service to make a call
About this task

On mobile clients, you can use Avaya IX™ Workplace Client to make calls using any service that you configured:
« VoIP
« EC500
+ Client Enablement Services

With Client Enablement Services, you can use Avaya IX™ Workplace Client to select any off-pbx number that you
configure in the My Phones list for call back.

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.
2. Go to the Outgoing Calls screen.

3. Select the option that you want to use for making calls.

Avaya IX™ Workplace Client uses the option that you selected as the default option for all calls that originate
from Avaya IX™ Workplace Client.

Selecting the primary extension or BLA
About this task

Use the Bridged Lines screen to:

» Select the primary extension or a bridged line to make an outgoing call.
+ View all your bridged lines and the active calls on each bridged line.

+ Make, answer, join, and end Bridged Line Appearance (BLA) audio calls.You can also make BLA audio calls from
any screen in the Avaya IX™ Workplace Client application after you select a bridged line using this procedure.

Before you begin

« Ensure that your administrator provisioned the BLA feature on your extension.
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+ Add a contact for the BLA line owner.If you add this contact, Avaya IX™ Workplace Client displays the line owner
name when you select a BLA line in the Call as field and for incoming call alerts.

Procedure

1. Do one of the following:

» On mobile clients: On the Avaya IX™ Workplace Client menu, select Bridged Lines.

+ On desktop clients: Select "= and then select Bridged Lines.

2. Inthe Call asfield, select the primary extension or the BLA line that you want to use to make a call.

If you select a BLA line, Avaya IX™ Workplace Client displays a BLA icon next to the presence status indicator
on the Top of Mind screen.

3. Optional: If you select a BLA line and want Avaya IX™ Workplace Client to automatically return to the primary
extension as the default setting after a call, do one of the following. Otherwise, go to the next step.

« On mobile clients: Select Reset to “Me” after one call.
« On desktop clients: Select Auto-revert back to “Me” after one call.
4. Savethe changes.

Enabling the Desk Phone mode
About this task

Use this procedure to enable the Desk Phone mode on desktop clients to make and receive calls. By default, the
desktop client uses your computer to make and receive calls.

In the Desk Phone mode, you can use Avaya IX™ Workplace Client to control your Avaya SIP phone, such as the
J100 series. You cannot use the Desk Phone mode on mobile clients.

Before you begin

Log in to your deskphone.

Procedure

1. On Avaya IX™ Workplace Client, click -
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2. Inthe Place and Receive Calls Using field, click My Desk Phone.

Making an audio or video call
About this task

In Avaya IX™ Workplace Client, you can make an audio or video call from:

+ The dialpad

+ A contact card

« An enterprise search card
« Acall history record card

+ An instant message card

Use this procedure to make a call by selecting a contact person or typing a number. You can also make a call
using the alphanumeric URI. However, the steps involved in making such a call are different and are covered in a
different procedure.

G Note:

The maximum number of calls that you can make at a time using Avaya IX™ Workplace Client depends on the
system configuration. Consult your system administrator for this capability.

Procedure

1. Select one of the following:

« Dialpad

« Top of Mind screen

« Contacts screen

« History screen

+ Messages screen

» Enterprise user you want to call
2. To make a call from:

« The dialpad: Enter the number to call.
« The Top of Mind screen: In the find someone or name or number field, type the number.
« An enterprise search result or an Avaya IX™ Workplace Client screen: Select the contact person or number.

3. Select one of the following:

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 81



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

Making a call using the alphanumeric URI on mobile
clients

About this task

Use this procedure to make a voice or video call using the alphanumeric Uniform Resource Identifier (URI). For
example, you can use the alphanumeric URI to call an external user, such as a Skype for Business user, using
123john@telenor.com.

,i'\Tip:

In the New Contact area, you can perform the following actions on the alphanumeric URI to view the option to
make a call:

+ OniOS devices, depending on the OS version, you might be able to swipe left or full swipe to the right.

+ On Android devices, you can press and hold.

Procedure

1. Onthe Top of Mind screen, in the find someone field, type a valid alphanumeric URI.
Avaya IX™ Workplace Client displays the alphanumeric URI in the New Contact area.
2. Tap the alphanumeric URI.
Avaya IX™ Workplace Client displays the Contact Details screen.

3. Inthe Make a Call area, next to the alphanumeric URI, tap one of the following:
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Avaya IX™ Workplace Client dials the alphanumeric URI.

Making a call using the alphanumeric URI on desktop
clients

About this task

Use this procedure to make a voice or video call using the alphanumeric Uniform Resource Identifier (URI). For

example, you can use the alphanumeric URI to call an external user, such as a Skype for Business user, using
123john@telenor.com.

Procedure

1. Onthe Top of Mind screen, in the name or number field, type a valid alphanumeric URI.
2. Next to the alphanumeric URI, click one of the following:

=l

X

Avaya IX™ Workplace Client dials the alphanumeric URI.

Making a voice or video call to a group of contacts on
mobile clients

About this task

If the adhoc conference settings in Avaya IX™ Workplace Client are configured, Avaya IX™ Workplace Client starts
an Adhoc audio or video conference call using Avaya Equinox® Conferencing.

'9 Note:

If the adhoc conference settings in Avaya IX™ Workplace Client are kept blank, you cannot make a group call.

Communication Manager supports adhoc conference only by merging two calls or adding one participant into an
active call.

Procedure

1. Go to the Contacts screen.
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2. Tap

3. Tap one of the following calling options:

« New Group Voice Call
« New Group Video Call

Avaya IX™ Workplace Client displays the Choose contacts for your call screen.

4. Select the contacts whom you want to call.
5. Tap Next.

Avaya IX™ Workplace Client displays the Confirm contacts for your call screen.
6. Tap Call.

Avaya IX™ Workplace Client makes a group call to the selected contacts.

Making a voice or video call to a group of contacts on
desktop clients

About this task

If the adhoc conference settings in Avaya IX™ Workplace Client are configured, Avaya IX™ Workplace Client starts
an Adhoc audio or video conference call using Avaya Equinox® Conferencing.

G Note:

If the adhoc conference settings in Avaya IX™ Workplace Client are kept blank, you cannot make a group call.
Communication Manager supports adhoc conference only by merging two calls or adding one participant into an
active call.

Procedure

1. Click New conversation.
2. Dragand drop contacts or contact groups.
3. Click one of the following:

. <’ To start an audio call.

X

. : To start a video call.
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Avaya IX™ Workplace Client starts a conference call with all members who have a valid phone number.

Starting a call with all members of a contact group on
mobile clients

About this task

Avaya IX™ Workplace Client starts the conference call using Avaya Equinox® Conferencing.

Before you begin

+ Enable and log in to Avaya Aura® Device Services.

+ Configure the ad hoc conference URI in the Adhoc Conference Address field.

Procedure

1. Go to the Contacts screen.
2. Identify the contact group to start an audio or video call.
3. On the contact group name, do one of the following:

+ On Android devices: Press and hold.
+ OniOS devices: Swipe to the right.
4. Tap one of the following:

. = To start an audio call.
. L3 : To start a video call.

Avaya IX™ Workplace Client displays the Confirm contacts for your call screen.

5. Tap Call.
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Avaya IX™ Workplace Client starts a conference call with all members of the group who have a valid phone
number.

Starting a call with all members of a contact group on
desktop clients

About this task

Avaya IX™ Workplace Client starts the conference call using Avaya Equinox® Conferencing.

Before you begin

Enable and log in to Avaya Aura® Device Services.

Configure the ad hoc conference URI in the Adhoc Conference Address field.

Procedure

1. Go to the Contacts screen.

2. Identify the contact group to start an audio or video call.
3. On the contact group name, hover the cursor.

4. Click one of the following:

. < To start an audio call.
. [ : To start a video call.
5. Optional: If a contact has multiple numbers, choose the number that you want to call for that contact.

6. Depending on the choice that you made in Step 4, you can click one of the following:

« Start a Voice Conference

Start a Video Conference

Avaya IX™ Workplace Client starts a conference call with all members of the group who have a valid phone
number.

Answering or ignoring a call
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About this task

If you are already on a call, Avaya IX™ Workplace Client alerts you with a beep for waiting calls.

If your administrator configures the Team Button feature for your extension, you can view a visual notification
with the monitored station name for incoming calls.

You might use applications such as Skype or Viber for VolIP calls. If you are on such a VolIP call and use Avaya IX™
Workplace Client to answer an incoming call, Avaya IX™ Workplace Client might display an error message. You
see the error message when Avaya IX™ Workplace Client cannot get audio resources to support the incoming call.

9 Note:

If CallKit is disabled and you receive a video call in Avaya IX™ Workplace Client for iOS when your device is
locked, you must unlock your iOS device to answer the call. If CallKit is enabled and you answer a video call, the
application pauses the video. You must resume the video using Avaya IX™ Workplace Client for iOS.

Procedure

« To receive the call, select .
+ To dismiss the call, select “

« Optional: If your administrator hides the Caller ID for the Team Button feature, to view the Caller ID, select @ .

Managing calls

Using Avaya IX Workplace Client as the default
application for telephony services

About this task

Use this procedure only on desktop clients to configure Avaya IX™ Workplace Client as the default application for
telephony services. By using this procedure, you can use Avaya IX™ Workplace Client as the primary application
to make and receive calls instead of Microsoft Lync, Skype, or any other desktop applications.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences.
2. Select General.
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3. Select Use Avaya IX Workplace as default application for telephony services.

4. Savethe changes.

Viewing the phone numbers that ring for an incoming
call

About this task

Use this procedure only on mobile clients to view the phone numbers that ring when you receive a call on your
deskphone.

Before you begin

+ Enable and log in to Client Enablement Services.

+ Set the following options in the Incoming Calls screen to Off:

« Send All Calls
« Forward Calls
« Forward Calls Busy/No Answer

+ Enhanced Call Forwarding

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.
2. Go to the Incoming Calls screen.

The Calls will ring on area displays the phone numbers that ring for an incoming call.

3. To add more numbers to the Calls will ring on area, select the switch next to the phone number.

Activating simultaneous ringing for VolP users
About this task

If you are a VolIP user, use this procedure to activate simultaneous ringing on your deskphone and device for a
call that arrives on your deskphone.

© Note:

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

88



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

Do not use this procedure if you are only using Client Enablement Services. Use the Ring Phones feature of Client

Enablement Services to configure the numbers that must ring for an incoming call on your deskphone.

Before you begin

Ensure that your administrator configured the EC500 feature for your extension.

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.
2. Do one of the following:

» On mobile clients: Go to the Incoming Calls screen and select EC500 Calls.
+ On desktop clients: In the Incoming Call Features field, select EC500.

Forwarding all VoIP calls
About this task

Use this procedure to forward calls to another telephone number of your choice.

When a user A makes a call to user B who has forwarded calls to user C, then user A can view:

« User Cin the call appearance.

« The number of user B in the call history.

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.

2. Do one of the following:

« On mobile clients: Go to the Incoming Calls screen and select Forward Calls.
+ On desktop clients: In the Incoming Call Features field, select Call Forward.
3. Type the telephone number to which you want to forward your calls.
4. Select OK.
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Avaya IX™ Workplace Client saves the setting.

Forwarding VolP calls when you are busy or do not
answer

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.

2. Do one of the following:

« On mobile clients: Go to the Incoming Calls screen and select Forward Calls Busy/No Answer.
+ On desktop clients: In the Incoming Call Features field, select Call Forward Busy / No Answer.
3. Type the telephone number to which you want to forward your calls.
4. Select OK.

Avaya IX™ Workplace Client saves the setting.

Configuring enhanced call forwarding for VoIP users
About this task

Use this procedure to configure the enhanced call forwarding features for internal and external calls.

Before you begin

Ensure that your administrator configured the Enhanced Call Forwarding feature for your extension.

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.

2. Do one of the following:

« On mobile clients: Go to the Incoming Calls screen and select Enhanced Call Forwarding.
«» On desktop clients: In the Incoming Call Features field, select Enhanced Call Forwarding.

3. Optional: On mobile clients, if the Enhanced Call Forwarding switch is in the disabled state, select Enhanced
Call Forwarding. Otherwise, go to the next step.
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4. Inthe Unconditional Forwarding area, select the following:

« Internal Calls: To configure the number to which internal calls must be forwarded every time.
« External Calls: To configure the number to which external calls must be forwarded every time.
5. Inthe Forward When Busy area, select the following:

« Internal Calls: To configure the number to which internal calls must be forwarded when you are busy.
« External Calls: To configure the number to which external calls must be forwarded when you are busy.
6. Inthe Forward When No Answer area, select the following:

« Internal Calls: To configure the number to which internal calls must be forwarded when you do not answer a
call.

« External Calls: To configure the number to which external calls must be forwarded when you do not answer a
call.

7. Savethe changes.

Sending all VoIP calls to voice mail
About this task

Use this procedure to route all calls to a predefined number set on the server by your administrator. The number
is usually your corporate voice mail number.

Before you begin
Ensure that your administrator configured on the server the number to which you can route all calls.

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.
2. Do one of the following:

« On mobile clients: Go to the Incoming Calls screen and select Send All Calls.
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+ On desktop clients: In the Incoming Call Features field, select Send All Calls.

Sending all calls to voice mail when your presence
status is set to “Do not disturb”

About this task

Use this procedure if you want Avaya IX™ Workplace Client to send all incoming calls to voice mail when you set
your presence status to “Do not disturb (DND)”.

Before you begin

Enable and log in to the VolIP service.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences.

2. Optional: If available on the Avaya IX™ Workplace Client platform, select General. Otherwise, go to the next
step.

3. Select Activate SAC When DND Is Set.
Avaya IX™ Workplace Client sends all your incoming calls to voice mail when your presence status is DND.

4. Savethe changes.

Entering digits during a call
About this task

Use the keypad to enter any DTMF inputs during a call. For example, to interact with a conference bridge or an
Interactive Voice Response (IVR) system.

Procedure

1. While on a call, select &.
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2. On the keypad, enter the digits as required.

Muting and unmuting a call

Procedure

1. While on a call, to mute the audio, select
Avaya IX™ Workplace Client mutes the microphone.

2. Tounmute the audio, select the button again.

Placing a call on hold and resuming the call

Procedure

1. To place acall on hold:

« On mobile clients: Selectn and then select

+ On desktop clients: Select
Avaya IX™ Workplace Client puts the call on hold.

2. To resume the call, select the button again.
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On mobile clients, if you are on a different screen in Avaya IX™ Workplace Client while resuming the call, you
must select Resume.

Escalating an audio call to a video call or an instant
message to a call

About this task

Use this procedure to escalate an audio call to a video call or an instant message to a call. If you escalate the call
to a video call, the person at the other end of the call must unblock the camera.

G Note:

If you are in a multi-party instant messaging conversation, you cannot start a Communication Manager adhoc
conference call. You must use Avaya Equinox® Conferencing.

Procedure
« While on an active audio call, select L3 .

Avaya IX™ Workplace Client starts video on the call.

+ While in a point-to-point instant messaging conversation, select one of the following from the conversation
window:

If the participant has more than one number, you can choose a number.

» While in a multi-party instant messaging conversation, select one of the following from the conversation
window:

« = and then Start a Voice Conference

. L3 and then Start a Video Conference

If the participant has more than one number, you can choose a number.

« While in an instant messaging conversation, in the Participants list, right-click or press and hold a participant and
select one of the following:
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« Start a Voice Call
« Start a Video Call

If the participant has more than one number, you can choose a number.

Pausing and resuming a video call
About this task

When you pause a video call, Avaya IX™ Workplace Client stops transmitting your video to the other party. When

avideo call is paused, you can still receive video from the other party and your audio is still transmitted to the
other party.

Procedure

1. To pause a video call, do one of the following:

and then select -

« On mobile clients: Select

« On desktop clients: Select -

Avaya IX™ Workplace Client pauses the video call.

2. Toresume transmitting video, select the button again.

Avaya IX™ Workplace Client resumes the video call.

Stopping the video transmission in a call
About this task

Use this procedure to stop the video transmission during a call. The call becomes audio-only.

Stopping video during a call does not disconnect the call.

Procedure

Do one of the following:
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« On mobile clients: Select and then select Stop Video.

+ On desktop clients: Select

The video transmission stops and the Video area closes.

Sharing information on a call
About this task

You can share your desktop or application only on a video call on desktop clients.

» If you configure the adhoc conference URI, that is, the value in the Adhoc Conference Address field, Avaya IX™
Workplace Client starts an adhoc conference for sharing.

« If your administrator enables BFCP and disables MSS, Avaya IX™ Workplace Client uses BFCP for sharing.

Before you begin

Ensure that you have sharing permission.

Procedure

1. Whileonacall, selectn and then select Start Sharing.

Avaya IX™ Workplace Client displays the Conference screen.

2. Select and share specific information in the conference.

Excluding MDA devices from joining the existing call
About this task

Use this procedure to disallow other MDA devices from joining the existing call.
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Before you begin

Your administrator must configure the Automatic Exclusion feature for your extension on Communication
Manager.

Procedure

While on a call, selectm and then select Exclusion.

Extending the call to a cellular network
About this task

Use this procedure to move your active VolIP call to the cellular network.

Before you begin

Ensure that your administrator configured the Extend Call feature for your extension.

Procedure

1. While on acall, select u

2. Do one of the following:

« On mobile clients: Select Handoff to Cellular.
« On desktop clients: Select Extend Call.

You receive a call from Communication Manager on your EC500 number.
3. Do one of the following:

« On mobile clients: Answer the cellular call.

« On desktop clients: Answer the cellular call and end the VolP call.

Call transfer

The following call transfer options are available:
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+ Blind transfer: Transfer the call to a person without talking to that person to inform that you are transferring the
call.

+ Consultative transfer: Talk to the person to whom you are transferring the call before you perform the transfer.

Performing a blind transfer
About this task

Use this procedure to transfer a call to a person without talking to that person to inform that you are transferring
the call.

Procedure

1. While on acall, select M

2. Select .

3. To transfer the call, choose:

« A contact: Only on mobile clients
« From history: Only on mobile clients
« Anumber to enter

Avaya IX™ Workplace Client transfers the call to the selected number.

Performing a consultative transfer
About this task

Use this procedure to talk to the person to whom you are transferring a call before you perform the transfer.
Procedure

1. While on acall, dial the number of the user to whom you want to transfer the call.

2. Select m

3. Select .
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4. To transfer the call, choose the existing held call.

Avaya IX™ Workplace Client transfers the call.

Parking or retrieving a parked call on mobile clients
About this task

Use the Call Park feature to park an active call. You can park only one call at a time.

© Note:

Avaya IX™ Workplace Client used in the Dual Registration mode with H.323 client cannot unpark a parked call.
Before you begin
Ensure that your administrator configured the Call Park and Call Unpark feature for your extension.

Procedure

1. To parkthe active call, selectu and then select Park Call.
2. To retrieve the parked call:

+ On the same device: Select Park Call.
« On the same device: If you are on the Active Call screen, select Unpark.

« On adifferent mobile device: On the Avaya IX™ Workplace Client menu, select Features > Pre-call Features >
Unpark Call and enter the extension number that is holding the parked call.

« On a desktop device: Select "~ _> Features > Call Unpark and enter the extension number that is holding the
parked call.

+ On a different device: Dial the FAC followed by the extension number that is holding the parked call.

Parking or retrieving a parked call on desktop clients
About this task

Use the Call Park feature to park an active call. You can park only one call at a time.

'9 Note:

Avaya IX™ Workplace Client used in the Dual Registration mode with H.323 client cannot unpark a parked call.
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Before you begin
Ensure that your administrator configured the Call Park and Call Unpark feature for your extension.

Procedure

1. To park the active call, selectm and then select Park Call.
2. Toretrieve the parked call:

« On the same device: Select *— -> Features > Call Unpark and enter the extension number that is holding the
parked call.

« On a mobile device: On the Avaya IX™ Workplace Client menu, select Features > Pre-call Features > Unpark
Call and enter the extension number that is holding the parked call.

« On a different device: Dial the FAC followed by the extension number that is holding the parked call.

Automatic callback overview

When a caller makes a call to a busy or an unanswered internal telephone, the caller activates the Automatic
Callback feature and disconnects the call.

Communication Manager monitors the called party. When the called party is available to receive the call,
Communication Manager automatically initiates Automatic Callback. The caller receives priority ringing. The
caller then lifts the handset, and the called party receives the call.

Configuring automatic callback
Before you begin

Your administrator must configure the Automatic Callback feature for your extension.
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Procedure

When the called party is busy or does not answer the call, selectm and then select Automatic Callback.

Disabling automatic callback on mobile clients
Before you begin

+ Ensure that your administrator configured Automatic Callback for your extension.

« Enable Automatic Callback for a call.

Procedure

1. Onthe Avaya IX™ Workplace Client menu, tap Features.
2. Tap Cancel Automatic Callback.

Avaya IX™ Workplace Client disables automatic callback for the call.

Disabling automatic callback on desktop clients
Before you begin

+ Ensure that your administrator configured Automatic Callback for your extension.

« Enable Automatic Callback for a call.

Procedure

1. Click o~ , and click Features.
2. Click Automatic Callback.

3. Click .

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 101



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

Avaya IX™ Workplace Client disables automatic callback for the call.

Viewing call details

Viewing the call quality statistics
About this task

Use this procedure to know the call quality statistics, such as audio codec, round trip time, media encryption
type, packets received, and packets transmitted.

Call quality statistics are only available when a call is in progress.

Procedure
Do one of the following:

« On mobile clients: While on a call, press and hold the timer on the call.

+ On desktop clients: While on a call, selectu and then select Call Statistics.

Viewing call history
About this task
If your administrator has configured the:

+ Bridged Line Appearance (BLA) feature on your extension, the call logs display additional information for BLA
calls.

+ Offline Call Journaling feature, you have a consistent view of call logs that are generated whether a device is
logged in or not.

Procedure

1. Go to the History screen.

2. Filter the call history using the following options:
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All History
Missed Calls
Outgoing Calls

.

Incoming Calls

Voicemail: Only on mobile clients

Avaya IX™ Workplace Client displays the relevant call history.
3. Tofurther filter the call history, select

4. Select or clear the following:

« Your History: To access personal history logs.
+ Bridged Line Calls: To access BLA history logs.
5. Save the changes.

Offline Call Journaling overview

On mobile platforms, by default the Avaya IX™ Workplace Client application prefers the Client Enablement
Services call history and Client Enablement Services call journaling. This default functionality is applicable only
when when 24x7 Call Journaling and Client Enablement Services are available. If your administrator enables the
Offline Call Journaling feature, you cannot view the Client Enablement Services call history including voice mail.

With this feature, active synchronization of call history between Session Manager and the endpoints is minimal
after the initial login or download. However, when a user attempts to delete a call history from an endpoint, the
endpoint sends a PPM request to delete the corresponding call history from the central repository of Session
Manager.

Call history download is initiated by the client when the client:

+ Registers with Session Manager.

+ Recovers from a network outage or outage due to a network change.

Call history functionality
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To view the Client Enablement Services call history and visual voice mail in Avaya IX™ Workplace Client on mobile platforms,
you must have one of the following configurations:

ENABLE_PPM_CALL_JOURNALING parameter in the auto- PPM call journaling on Client Enablement

configuration file server Services service
0 (Disabled) Disabled Enabled
1 (Enabled) Disabled Enabled
Not defined Enabled Enabled
Not defined Disabled Enabled

Call journaling functionality with dual registered
extensions

The following table outlines the expected 24x7 call journaling functionality with dual registered extensions:

SIP client H'.323 Scenario Call Logs
client

Answer and end an incoming call from the ' Incoming call entry in the SIP client

Loggedin ' Logged in H.323 client. and the H.323 client.

Answer and end an incoming call fromthe ' Incoming call entry in the SIP client

Loggedin ' Loggedin | ¢\ jiant. and the H.323 client.

1. Answer and end an incoming call from
the H.323 client. Incoming call entry in the SIP client

Logged off | Logged in and the H.323 client.

2. Loginto the SIP client.
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SIP client H'.323
client
Loggedin  Logged off

Logged off = Logged off

Logged off Logged in

Logged off = N.A.

N.A. Logged off

Scenario

1. Answer and end an incoming call from

the SIP client.
2. Logintothe H.323 client.

Incoming call is missed as no client is
logged in.

1. Logintothe SIP and H.323 clients.

1. Answer the incoming call from the H.323

client.

2. Loginto the SIP client.The SIP client
displays the active call on the H.323 client.

3. End the call from the H.323 client.

1. Delete all call logs from the H.323 client.

2. Loginto the SIP client.

1. Delete all call logs from the SIP client.

2. Login to the H.323 client.

Call Logs

Incoming call entry only in the SIP
client, not in the H.323 client.

Missed call entry only in the SIP client,
not in the H.323 client.

Incoming call entry in the SIP client
and the H.323 client.

Calllogs not in sync.

Logs that are available in the SIP
client before logging in are displayed
though all call logs were deleted from
the H.323 client.

The H.323 client synced with the SIP
client.

Displays no call logs, as all entries
were deleted from the SIP client

Deleting a call history entry

Procedure

1. Go to the History screen.
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2. Do one of the following:

+ On Avaya IX™ Workplace Client for Android: Press and hold the call entry and then select Delete.
« On Avaya IX™ Workplace Client for iOS: Swipe the call entry and then select Delete.

« On Avaya IX™ Workplace Client for Windows and Mac: Select the entry, select n, and then select Remove
from call history.

Avaya IX™ Workplace Client deletes the call history entry.

Deleting all call history

Procedure

1. Go to the History screen.
2. Filter the call history and select Delete All History.

3. Optional: If available on the Avaya IX™ Workplace Client platform, in the confirmation dialog box, select
Delete.

Listening to voice mails
About this task

Use this procedure to listen to voice mails in VolP deployments without Client Enablement Services. If you
enable Client Enablement Services, you can view all your voice mails using the Voicemail filter on the History
screen.

If you have unread voice mails, Avaya IX™ Workplace Client displays EH.

Before you begin

Your administrator must configure the Voicemail number field on System Manager.

Procedure

Select EH.
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Avaya IX™ Workplace Client dials the voice mail access number and you can listen to your voice mail
messages.

Ending a call

Procedure

While on a call, select E

Avaya IX™ Workplace Client ends the call.

Emergency calls

Do not use Avaya IX™ Workplace Client to make emergency calls. Avaya recommends that you check the product
documentation that accompanies your mobile device to learn about the emergency calling features available on
your device.

If you have any questions or concerns, contact your support team.

My Phones overview

Use the My Phones feature on mobile clients to configure the phones associated with your account. Use the Ring
Phones feature to configure which numbers must ring for an incoming call. If you cannot answer an incoming
call, Avaya IX™ Workplace Client automatically sends the call to your office voice mail.

Your deskphone routes calls to the destination numbers that you specify in the Calls will ring on list. You can add,
update, and delete the destination numbers in the My Phones list.

Avaya IX™ Workplace Client creates the deskphone and the mobile phone destinations automatically when you
sign up for Avaya IX™ Workplace Client. You must add your mobile phone number. If you do not want your mobile
phone to ring, do not select the corresponding option in the Calls will ring on list.

'9 Note:
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The mobile phone number is mandatory and you cannot delete it. You also cannot delete or change the
deskphone number.

You can add any number of telephones to the My Phones list. However, you can select only four telephones to
ring simultaneously, including your mobile phone, when you receive a call on your deskphone.

Limitations

Features that you enabled when connected to VolIP, such as Send All Calls or Call Forward, interfere with the
capability of call routing to your ring phones. If you enable such features using the Incoming Calls or Outgoing
Calls screen and then lose connectivity to the VoIP server, Avaya IX™ Workplace Client does not display these
configured features. If you then connect to Client Enablement Services, the Ring Phones feature of Client
Enablement Services functions incorrectly. The reason is that ring phones have the lowest priority in terms of call
routing features for your extension.

Adding a telephone number to your phones list
About this task

Use this procedure only on mobile clients.

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.
2. Go to the Incoming Calls or Outgoing Calls screen, and select Manage my phones.
3. Select il

Avaya IX™ Workplace Client displays the Add Phone dialog box.
4. Type the name of the new telephone in the following field:

« On Avaya IX™ Workplace Client for Android: Name

« On Avaya IX™ Workplace Client for iOS: Label
5. Inthe Number field, type the new telephone number.
6. Select Save.
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Avaya IX™ Workplace Client displays the new name with the number in the My Phones list.

Updating a telephone number in your phones list
About this task

Use this procedure only on mobile clients.

Procedure

1
2
3.
4. Select the telephone number that you want to update.

. On the Top of Mind screen, select the presence status indicator.

. Go to the Incoming Calls or Outgoing Calls screen, and select Manage my phones.

Optional: If available on the Avaya IX™ Workplace Client platform, select Edit. Otherwise, go to the next step.

You cannot change the deskphone number.
In the Edit Phone dialog box, you can update the following:

The name of the telephone.
The number of the telephone.

The SMS or email address.This option is available if you selected the Mobile option for update. You must
enter the value in the following format: xxx@abc . com.

Select Save.

Avaya IX™ Workplace Client displays the new name with the number in the My Phones list.

Deleting a telephone number from your phones list
About this task

Use this procedure only on mobile clients.

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.

2. Go to the Incoming Calls or Outgoing Calls screen, and select Manage my phones.

3. Delete the telephone number.
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The mobile phone number is mandatory. You cannot delete the number. Also, you cannot delete the
deskphone number.

4. Optional: If available on the Avaya IX™ Workplace Client platform, select Delete. Otherwise, go to the next
step.

Avaya IX™ Workplace Client displays the confirmation dialog box.
5. Select Delete.

Avaya IX™ Workplace Client deletes the telephone number from the My Phones list.

Other Phone mode overview

You can use the Other Phone mode when you are working from your home office or other remote location. You
can make and handle audio calls through Avaya IX™ Workplace Client, while using a separate telephone line at
your remote location to speak and listen.

If you make a call using Avaya IX™ Workplace Client when the Other Phone mode is active, your other phone
device rings. You must then answer the call using the other phone device to initiate the call to the remote party. If
the remote party answers the call, the audio call between the other phone device and the remote party is
established.

If you receive a call on Avaya IX™ Workplace Client when the Other Phone mode is active:

+ Thereis no audible ringing on Avaya IX™ Workplace Client. However, your other phone device rings.
+ You can view an incoming call notification on Avaya IX™ Workplace Client.

+ The Answer button is inactive on Avaya IX™ Workplace Client. However, you can answer the call using the other
phone device.

« The Ignore button is active on Avaya IX™ Workplace Client. You can dismiss the incoming call notification on
Avaya IX™ Workplace Client and stop the ringing alert on the other phone device.You can view the ignored call in
the Avaya IX™ Workplace Client call stack. If the remote party does not end the call, you can choose to click the
Answer button in the call stack. The other phone device then starts ringing and you can answer the call using the
other phone device.

You can pause, resume, and end a call using Avaya IX™ Workplace Client when the call is active on the other
phone device.
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In the Other Phone mode, you can merge calls, manage conference calls, and perform collaboration.

Adding an other phone number on desktop clients
About this task

Use this procedure to add an other phone number on desktop clients.

G Note:

The other phone numbers that you add are saved locally. Hence, these other phone numbers are unavailable
with MDA or any other devices.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences > Other Phones.
2. Click Add Phone.

Avaya IX™ Workplace Client adds a new phone entry with Other as the default label.
3. Toadd a custom label for the other phone number, do the following:

1. Inthe Other field, click Custom.
2. Inthe Labelfield, type a custom label.
3. Click OK.

4. Inthe Number field, type an other phone number.
5. Save the changes.

Updating an other phone number on desktop clients

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences > Other Phones.
2. To update the label of an other phone number, do the following:

1. Inthe labelfield, click Custom.
2. Inthe Labelfield, type a custom label.
3. Click OK.
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3. Inthe custom label field, update the other phone number.
4. Savethe changes.

Deleting an other phone number on desktop clients

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences > Other Phones.
2. Inthe label field, click Remove Phone.
3. Save the changes.

Enabling the Other Phone mode
About this task

Use this procedure to enable the Other Phone mode and use desktop clients for audio calls. By default, the
desktop client uses your computer for audio calls.

Before you begin

Configure other phones.

Procedure

‘; L R
1. OnAvaya IX™ Workplace Client, click -

2. Inthe Place and Receive Calls Using field, click Other Phones.

3. Click any of the available phones.

Avaya IX™ Workplace Client enables the Other Phone mode.

Hunt Groups overview
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Your administrator can use the Hunt Groups feature to set up a group of extensions that can handle multiple calls
to a telephone number. Additionally, your administrator can choose the call distribution method to route calls.
For each call to the number, the system hunts for an available extension in the hunt group, and connects the call
to that extension.

A hunt group is especially useful when an administrator expects a high number of calls to a particular telephone
number. A hunt group might consist of people who are trained to handle calls on specific topics. For example, the
group might be a:

« Benefits department within a company

« Service department for products that a company sells

+ Travel reservations service

» Pool of attendants
End-users can be members of multiple hunt groups.

Avaya IX™ Workplace Client supports the Hunt Group Busy feature. If your administrator configures this feature,
the user can activate this feature to avoid receiving calls on the user’s extension from a particular hunt group.

Using the Hunt Groups feature on mobile clients
Before you begin

Ensure that your administrator has configured the Hunt Groups feature for your extension.

Procedure
1. On the Avaya IX™ Workplace Client menu, tap Hunt Groups.
Avaya IX™ Workplace Client displays the Hunt Groups screen.

2. To avoid receiving calls on your extension for a particular hunt group, do the following:

1. Tap 2.
2. Tap Set Position as Busy.

Avaya IX™ Workplace Client changes the status from Available to Busy for that hunt group.

3. To change the default name for a particular hunt group, do the following:

1. Tap 2.
2. Inthe Edit Label area, tap the hunt group name.
3. Type a new name for the hunt group.
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4. Save the changes.

Using the Hunt Groups feature on desktop clients
Before you begin

Ensure that your administrator has configured the Hunt Groups feature for your extension.

Procedure

1. OnAvaya IX™ Workplace Client, click “— and then click Hunt Groups.

2. To avoid receiving calls on your extension for a particular hunt group, select the check box next to the
appropriate hunt group.

Avaya IX™ Workplace Client changes the status from Available to Busy for that hunt group.
3. To change the default name for a particular hunt group, do the following:
1. Hover the cursor next to a hunt group name.
2. Click .
Avaya IX™ Workplace Client displays the Edit Hunt Group dialog box.

3. Inthe Label field, type a new name for the hunt group.
4. To save the changes, click OK.

Team Button overview

Avaya IX™ Workplace Client on mobile platforms and Avaya IX™ Workplace Client for Windows support the Team
Button feature. If your administrator configures this feature, the user at the monitoring station can do the
following:

« View the state of a monitored station.

+ View all calls that ring on the monitored station and selectively answer any.

+ Speed dial, that is, place a call, to the monitored station.

« Blind transfer any call to the monitored station.

+ Configure the audible ringing and visual alert notification.
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Monitoring Station

The station which is used to monitor the state of another station. This is the station that displays the Team
Button and information is presented to the user.

Monitored Station

The station whose state is being monitored.

Using the Team Button feature on mobile clients
About this task

Use this procedure only on the monitoring station.

If contact matching functionality is available, you can view the presence and contact name of the monitored
station. Additionally, the monitored station’s call line displays one of the following call states:

« Idle: Indicates the absence of active calls.
« On a call: Indicates there are one or more active calls.

+ Incoming: Indicates there is an incoming call.

Before you begin
Ensure that your administrator has configured the Team Button feature for your extension.

Procedure

1. On the Avaya IX™ Workplace Client menu, tap Team.
A\ Tip:
On the Team screen, you can perform quick actions on a monitored station entry.

+ OniOS devices, depending on the OS version, you might be able to swipe left, swipe right, full swipe to
the left, and full swipe to the right to trigger different actions.

« On Android devices, you can press and hold to view the different actions that you can perform.

2. For a monitored station entry, tap ?.

If the following features are active on the monitored station, the screen displays the ITncoming Call
Feature is On text:

« Send All Calls
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+ Call Forwarding
+ Enhanced Call Forwarding

3. Tap the following depending on the monitored station’s call line:

« Call <Monitored_Station>: Speed dial to the default endpoint.This option is only available for the Idle and On
a call states. You can only make an audio call using speed dial. If your administrator configures the Team
Button feature with priority ringing, the user at the monitored station can differentiate between the normal
and team calls.

« Answer Incoming Call for <Monitored_Station>: Answer the incoming call for this station.Only available for
the Incoming call state. If there is more than one incoming call, a single tap displays a menu with a list of
incoming calls. You must choose the call you want to answer.

« Transfer Call: Blindly transfer the active call.Only available when you have minimum one active call at the
monitoring station. For more than one active call, a single tap displays a menu with a list of active calls. You
must choose the call you want to transfer.

4. Optional: If the monitored station includes active Incoming Call Features and you tap Call
<Monitored_Station>, depending on the Team Button configuration, you might be able to tap one of the
following:

« Override: Overrides Call redirection and continues your call.
« Call with redirection: Calls with redirection.
« Cancel: Cancels your call.

5. Inthe Call Notification Options area:

« To configure audible ringing, tap Audible Ringing.If your administrator configures the Team Button feature
with no ringing, Avaya IX™ Workplace Client disables the audible ringing option.

« To configure the visual alert notification, tap Visual Alert Notification.If your administrator disables the visual
alert notification setting, Avaya IX™ Workplace Client disables this option.

6. Save the changes.

Using the Team Button feature on Avaya IX Workplace
Client for Windows

About this task

Use this procedure only on the monitoring station.

If contact matching functionality is available, you can view the presence and contact name of the monitored
station. Additionally, the monitored station’s call line displays one of the following call states:

« Idle: Indicates the absence of active calls.

« Onacall: Indicates there are one or more active calls.
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+ Incoming: Indicates there is an incoming call.

Before you begin

Ensure that your administrator has configured the Team Button feature for your extension.

Procedure

1. On Avaya IX™Workplace Client, click = and then click Team.
2. Hover the cursor on a monitored station entry.

If the following features are active on the monitored station, replaces the Presence icon on the hovered
line:

+ Send All Calls
+ Call Forwarding
+ Enhanced Call Forwarding
3. Click the following depending on the monitored station’s call line:

)

[ e

. : Speed dial to the default endpoint.This option is only available for the Idle and On a call states. You can
only make an audio call using speed dial. If your administrator configures the Team Button feature with
priority ringing, the user at the monitored station can differentiate between the normal and team calls.

0y
. : Answer the incoming call for this station.This option is only available for the Incoming call state. If there
is more than one incoming call, a single click displays a menu with a list of incoming calls. You must choose
the call you want to answer.

. .E: Blindly transfer the active call.This option is only available when you have minimum one active call at
the monitoring station. For more than one active call, a single click displays a menu with a list of active calls.
You must choose the call you want to transfer.

. E: Configure the audible ringing and visual alert notification.If your administrator configures the Team
Button feature with no ringing, Avaya IX™ Workplace Client disables the audible ringing option. If your
administrator disables the visual alert notification setting, Avaya IX™ Workplace Client disables this option.

4. Optional: If the monitored station includes active Call redirection features and you click — , depending on
the Team Button configuration, you might be able to click one of the following:

« Override: Overrides Call redirection and continues your call.

« Call with redirection: Calls with redirection.
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« Cancel: Cancels your call.

Avaya IX Workplace VDI overview

You can use Avaya IX™ Workplace Client for Windows in a virtual environment, such as provided by Citrix or
VMware, in the Desk Phone mode either with a SIP deskphone or with Avaya IX™ Workplace VDI.

Avaya IX™ Workplace VDI is a Virtual Desktop Infrastructure (VDI) soft client that enhances the audio and video
quality of calls by processing the audio and video locally on your VDI endpoint. A VDI endpoint might be a thin
client or a Windows-based personal computer. The controlling client, such as Avaya IX™ Workplace Client for
Windows, is deployed on virtual desktops running in the data center and provides the user interface for unified
communications.

To connect with a VDI endpoint, you must use the controlling clients in the Desk Phone mode. To ensure proper
feature coordination between Avaya IX™ Workplace Client for Windows and Avaya IX™ Workplace VDI, the
configuration must be aligned. If Avaya IX™ Workplace VDI registers properly in the Desk Phone mode with Avaya

IX™ Workplace Client for Windows, Avaya IX™ Workplace VDI displays the icon.

The following call features are available on Avaya IX™ Workplace Client for Windows in a virtualized environment
when there is an active call on Avaya IX™ Workplace VDI:

+ Make a call

+ Answer a call

» Hold and resume a call

+ Mute and unmute a call

« Transfer a call

+ Make a conference call
© Note:
Avaya IX™ Workplace VDI does not support advanced adhoc conferencing.

» Pause and resume your video during a video call
+ Escalate an audio call to a video call

» De-escalate a video call to an audio call

The following call features are available on Avaya IX™ Workplace VDI when there is an active call on Avaya IX™
Workplace Client for Windows:

« Make a call

« Answer a call
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+ Hold and resume a call

+ Mute and unmute a call

» Pause and resume your video during a video call
+ De-escalate a video call to an audio call

The following features are also available when there is an active call on Avaya IX™ Workplace Client for Windows
or Avaya IX™ Workplace VDI:

+ Mute sync: The audio mute state is synchronized between Avaya IX™ Workplace Client for Windows and Avaya
IX™ Workplace VDI.

+ Remote mute: If the moderator mutes you during a conference call, Avaya IX™ Workplace Client for Windows
displays the remote mute icon and Avaya IX™ Workplace VDI also goes on mute.

Paired sigh-on

Avaya IX™ Workplace Client for Windows supports paired sign-on with Avaya IX™ Workplace VDI in the Desk
Phone mode. Avaya IX™ Workplace Client for Windows sends the user credentials to Avaya IX™ Workplace VDI
that is running on a thin client using a virtual connection. Using these credentials and the Avaya Aura®
configuration information, Avaya IX™ Workplace VDI logs in with the same extension. If Avaya IX™ Workplace VDI
is already logged in and you log in to Avaya IX™ Workplace Client for Windows using a different extension, Avaya
IX™ Workplace VDI is logged out and the paired sign-on process begins.

If the log in process is successful, you can use Avaya IX™ Workplace Client for Windows to control the Avaya IX™
Workplace VDI client.

Logging out from Avaya IX™ Workplace Client for Windows also logs you out from Avaya IX™ Workplace VDI.

Logging out from Avaya IX™ Workplace VDI does not log you out from Avaya IX™ Workplace Client for Windows.
However, the telephony services become unavailable.

In case of a connection failure at Avaya IX™ Workplace Client for Windows, you can continue to use Avaya IX™
Workplace VDI for calls.
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Conferencing using Communication Manager

Depending on the communications system in your company and how Avaya IX™ Workplace Client is configured,
you can start and manage audio and video conference calls:

Check with your system administrator whether your deployment uses Communication Manager or Avaya
Equinox® Conferencing.

Advanced conferencing features are supported only if your deployment includes Avaya Equinox® Conferencing.
Communication Manager conferencing provides basic conferencing features.

Starting a basic adhoc conference call using
Communication Manager on mobile clients

About this task

Use this procedure to start an adhoc audio conference call using Communication Manager.

Before you begin

Do not enter any value in the Adhoc Conference Address field.

Procedure

1. Starta call by doing one of the following:

« On the Contacts, History, or Messages screen, search for a contact.

« Dial the telephone number.

2. Tap &
3. Forthe active call, tap M and then tap -
4. Inthe Add someone to the meeting area, tap one of the following:

« Choose a contact
« Enter a number

5. Do one of the following:

» Select the contact from your contacts list.
+ Dial a number.
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6. Tap Complete Addition.

Avaya IX™ Workplace Client starts the conference call.

Starting a basic adhoc conference call using
Communication Manager on desktop clients

About this task

Use this procedure to start an adhoc audio conference call using Communication Manager.

Before you begin

Do not enter any value in the Adhoc Conference Address field.

Procedure
1. Start a call by doing one of the following:

« On the Contacts, History, or Messages screen, search for a contact.
« Dial the telephone number.

2. Click < .

3. For the active call, clickm and then click Add Someone to Call.
4. ldentify the number to call by doing one of the following:

« Type a number.

« Select a number from your contacts list.
5. Click Add to call.
6. Click Merge.

Avaya IX™ Workplace Client starts the conference call.

Dropping the last added participant from a basic adhoc
conference call
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Before you begin

+ Ensure that a basic adhoc conference call is in progress.

© Note:

The drop last participant capability is disabled in an enhanced adhoc conference call and MDA or BLA bridged
calls.

« Add the last participant.

Procedure

On the Conference screen, select u and then select Drop Last Participant.

Avaya IX™ Workplace Client drops the last participant that you added from the conference.

Ending a conference

Procedure

While on a conference call, select u

Avaya IX™ Workplace Client ends the conference call.
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Conferencing using Avaya Equinox Conferencing

Avaya Equinox® Conferencing continues the evolution of Conferencing with the following features:

« Meeting participation extended to include the WebRTC participant. You do not need any plug-in to participate.

« Anintegrated portal that detects the browser or device you are on and connects you to the meeting. This is
possible using WebRTC or the native application.

« Audio participation extended to thousands.

« Automatic cloud provisioning for room systems.

Advanced conferencing features are supported only if your deployment includes Avaya Equinox® Conferencing.

Conference screen

The following figure shows the components of the Conference screen on Avaya IX™ Workplace Client on desktop
platforms. You can also see an active conference call.
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No. Name
1 Leave
2 Media
3 Present
4 Meeting controls
5 Video Call
6 Audio Call
7 Share
Link Quality Indicator
8 Layout controls
9 Full screen
10  Self-view
11 Chat
12 View participants
13 Filter
14  Sort

Description
Leave the conference.

Check the audio and video links for the conference. You can also mute the microphone and
block the video.

Share a portion of the screen, the entire desktop, applications, or virtual whiteboards.

Access the moderator controls functionality. For example, to add someone to a call, extend a
call, and view call statistics.

Block or unblock your video on the conference. When the video is blocked, the button is blue.
Mute or unmute your audio for the call. When the call is muted, the button is blue.

Attach or detach the Sharing screen with the Conference screen.

View the link quality indicator that provides an indication of the network quality.

Hide or show your display name and self-view.

Fit the Web Collaboration interface to the window size.

Move self-view to different corners of the screen.

Send pubic or private messages during a web collaboration session.

View the participants in the conference.

Filter the participants. For example, to view participants that have dropped, view recent
talkers, and view participants accessing collaboration.

Sort the participants alphabetically or according to order of arrival.

Download and installation of Avaya Equinox
Conferencing client

The Avaya Equinox® Conferencing portal detects whether you have installed Avaya IX™ Workplace Client.

« If Avaya IX™ Workplace Client is installed, Avaya IX™ Workplace Client is used to join a conference.

« If Avaya IX™ Workplace Client is not installed, the portal prompts users to use the WebRTC browser client only on
desktops. Otherwise, you must install Avaya IX™ Workplace Client to join the conference.
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« If Avaya IX™ Workplace Client is installed but not logged-in, you can join the conference without configuring your
account.

The portal provides a mechanism to detect the version of the installed client and install any required update,
linking to the app store as appropriate for mobile clients.

User types

You can log in using your authorized credentials or log in as guest users.
Users with authorized credentials can be of the following types:

+ UC users: These users use Avaya IX™ Workplace Client as a primary client for voice and video calls, voice
workflow features, audio and video conferences, and instant messaging and presence. A UC user can be a
moderator, participant, or guest of any conference.

+ OTT named users: These users might use Avaya IX™ Workplace Client as a primary client. These users have a
virtual room and associated features, such as recording resources and minutes.

OTT guest users do not use Avaya IX™ Workplace Client as a primary client, but need to join conferences with
audio and video as a guest. They might need to present using screen sharing.

Avaya IX™ Workplace Client for Windows supports Integrated Windows Authentication (IWA) for logging into an
Avaya IX™ Workplace Client conference. If IWA is enabled, you can use your Windows login credentials to log in to
the conference.

Virtual rooms overview

In Avaya Equinox® Conferencing, a virtual room, also known as a meeting room, offers a virtual meeting place for
adhoc or scheduled conferences. Administrators can configure multiple virtual rooms for a user.

Avaya Equinox® Conferencing displays a virtual room containing the video images of participants and a

presentation if it is being shared. You can also browse the list of participants, chat with others, control the video
layout, and adjust the volume and camera settings.
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With your virtual room, you can access the portal resources such as recordings and conference settings. You can
schedule meetings using the Portal or Avaya IX™ Workplace Client Add-in for Microsoft Outlook.

Moderator role

Moderator role is determined automatically in the UC environment when you join from Avaya IX™ Workplace
Client. If you go to the conference portal first, the moderator role is determined based on the login status of the

portal.

When you join a conference, the Place participants in a ‘waiting room’ until the moderator joins option might be
selected by default. In this case, you are assigned the participant role automatically and placed in a waiting room
state. To become a moderator, you must make a request and enter the moderator PIN. You can then start the
conference.

Starting a meeting

Procedure
1. Do one of the following:

« If you are logged in to Avaya IX™ Workplace Client, on the Top of Mind screen, select Start My Meeting.

« If you are not logged in to Avaya IX™ Workplace Client, on the Join Meeting screen, enter the details to start a
meeting.

2. Optional: To use Avaya IX™ Workplace Client for audio and video during the meeting, ensure that Use
Workplace for Audio + Video is enabled by default.

3. Optional: To call back your number, disable Use Workplace for Audio + Video and do one of the following:

» On mobile clients: Select Call Me Back and enter your number.
« On desktop clients: Select Callback my video number and enter your number.

4. Optional: To view only the presentation, disable Use Workplace for Audio + Video and do one of the
following:

« On mobile clients: Clear Call Me Back.
« On desktop clients: Clear Callback my video number.

5. Do one of the following:

« On mobile clients and Avaya IX™ Workplace Client for Windows: Select Join.
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+ On Avaya IX™ Workplace Client for Mac: Join Meeting.

Starting an advanced adhoc conference by adding
contacts on mobile clients

About this task

Use this procedure to start an Adhoc audio or video conference call.

Before you begin

Configure the adhoc conference URI, that is, the value in the Adhoc Conference Address field.

Procedure

1. Starta call by doing one of the following:

« On the Contacts, History, or Messages screen, search for a contact.
« Dial the telephone number.
+ Open an active Avaya Multimedia Messaging conversation.

2. Tap one of the following:

. = : To start an audio call.
. L3 : To start a video call.

Do one of the following:

1. Dial the number of a person that you want to add to the conference by doing the following:

1. Forthe active call, tap n and then tap -

2. Choose a contact or enter a number using the dialpad.
Avaya IX™ Workplace Client starts the conference call.

2. Make an audio or video conference call from the Contacts screen by doing the following:

1. Tap
2. Tap one of the following calling options:
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« 1. New Group Voice Call
« 2. New Group Video Call

Avaya IX™ Workplace Client displays the Choose contacts for your call screen.

3. Select the contacts whom you want to call.
4. Tap Next.

Avaya IX™ Workplace Client displays the Confirm contacts for your call screen.
5. TapCall.

Avaya IX™ Workplace Client starts the conference call.

Starting an advanced adhoc conference by adding
contacts on desktop clients

About this task

Use this procedure to start an Adhoc audio or video conference call.

Before you begin

Configure the adhoc conference URI, that is, the value in the Adhoc Conference Address field.

Procedure

1. Start a call by doing one of the following:

« On the Contacts, History, or Messages screen, search for a contact.
« Dial the telephone number.
« Open an active Avaya Multimedia Messaging conversation.

2. Click one of the following:

. = :To start an audio call.
. L3 : To start a video call.

Do one of the following:

1. Start a conference call from the Contacts, History, or Messages screen by doing the following:
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1. Dragthe card of the contact that you want to include in the conference and drop it over the existing call.
You cannot drag the card of a contact group and drop it over the existing call.

2. Click Merge.

Avaya IX™ Workplace Client starts the conference call.

2. Dial the number of a person that you want to add to the conference by doing the following:

1. Forthe active call, clicku and then click Add Someone to Call.
2. Dial the telephone number.
3. Click Add to call.

Avaya IX™ Workplace Client starts the conference call.
3. Start a conference call from the New Conversation screen by doing the following:

1. Click New conversation.
2. Onthe New Conversation screen, drag and drop contacts or contact groups.

3. Click = or (3 .

Avaya IX™ Workplace Client starts the conference call.

Merging two point-to-point calls to create a conference

call
Before you begin

You must have multiple calls in progress.

Procedure

1. Do one of the following:

« On mobile clients: For the active call, selectm and then select Merge and the call that you want to merge.
+ On desktop clients: Drag the contact card of the held call and drop it over the card of the active call.

2. Optional: If available on the Avaya IX™ Workplace Client platform, confirm whether you want to merge the
calls. Otherwise, go to the next step.

Avaya IX™ Workplace Client creates a conference.
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3. Resume the held call.

Escalating a point-to-point call to a conference call
About this task

During a point-to-point call, you can escalate the call to conference to become the moderator.

Procedure

1. For the active call, select m and then select Merge and then select the conference call.

2. Optional: If available on the Avaya IX™ Workplace Client platform, confirm whether you want to merge the
calls. Otherwise, go to the next step.

Avaya IX™ Workplace Client merges the active call to the conference call.

3. Resume the held call.

Joining a meeting

Joining a meeting from the Top of Mind screen
About this task
You can use Avaya IX™ Workplace Client to join a conference as a signed-in user or as a guest user.
Before you begin

If you join a conference as a signed-in user, you must obtain login credentials from the conference administrator.
The conference might be configured so that only authenticated users can participate in meetings, access
webcasts, or watch recordings.

Procedure

1. Open Avaya IX™ Workplace Client.
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2. On the Top of Mind screen, select Workplace Meetings.
Avaya IX™ Workplace Client displays the Workplace Meetings screen.

. Inthe Your Name field, type the name that you want to display during the meeting.

3
4. Inthe Meeting ID field, type the meeting ID of the virtual room.
5. Inthe Meeting Address field, type the conference address.

6.

Optional: To use Avaya IX™ Workplace Client for audio and video during the meeting, ensure that Use
Workplace for Audio + Video is enabled.

7. Optional: To call back your number, disable Use Workplace for Audio + Video and do one of the following:

» On mobile clients: Select Call Me Back and enter your number.
« On desktop clients: Select Callback my video number and enter your number.

8. Optional: To view only the presentation, disable Use Workplace for Audio + Video and do one of the
following:

« On mobile clients: Clear Call Me Back.
« On desktop clients: Clear Callback my video number.

9. Do one of the following:

« On mobile clients and Avaya IX™ Workplace Client for Windows: Select Join.

+ On Avaya IX™ Workplace Client for Mac: Join Meeting.

Joining a meeting as a guest user

Procedure

=

Open Avaya IX™ Workplace Client.

»

To join a meeting, select Join a Meeting.
Avaya IX™ Workplace Client displays the Join Meeting screen.

3. Inthe Your Name field, type the name that you want to display during the meeting.
4. Inthe Meeting ID field, type the meeting ID of the virtual room.

5. Inthe Meeting Address field, type the conference address.
6.

Optional: To use Avaya IX™ Workplace Client for audio and video during the meeting, ensure that Use
Workplace for Audio + Video is enabled by default.

7. Optional: To call back your number, disable Use Workplace for Audio + Video and do one of the following:

« On mobile clients: Select Call Me Back and enter your number.
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« On desktop clients: Select Callback my video number and enter your number.

8. Optional: To view only the presentation, disable Use Workplace for Audio + Video and do one of the
following:

« On mobile clients: Clear Call Me Back.
« On desktop clients: Clear Callback my video number.
9. Do one of the following:

» On mobile clients and Avaya IX™ Workplace Client for Windows: Select Join.
« On Avaya IX™ Workplace Client for Mac: Join Meeting.

Joining a meeting by signing in
Before you begin

Obtain login credentials from the conference administrator. The conference might be configured so that only
authenticated users can participate in meetings, access webcasts, or watch recordings.

Procedure

1. Open Avaya IX™ Workplace Client.
2. Tojoin a meeting, select Join a Meeting.

Avaya IX™ Workplace Client displays the Join Meeting screen.

Select Sign In.
In the URL field, type the meeting address.
Select Next.

Enter your credentials for the meeting portal.

No v kW

Select one of the following:

« Next
« Signin

Adding a participant to a meeting on mobile clients
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About this task

Use this procedure to invite participants to an ongoing video conference from any endpoint. You can invite both
individual users and people in meeting rooms equipped with room systems. With Avaya Equinox® Conferencing,
you can invite participants using:

» The participant's name from the organization's directory.
+ The number of the room system or the dedicated endpoint.
+ The phone number, E.164 address, IP address, or SIP address of the room system or dedicated endpoint.
You must have moderator's rights to invite participants. By default, any participant in a video conference can be a

moderator, unless a virtual room is protected by its owner. You still might be able to invite other users to a video
conference if the owner of the video conference shares the moderator PIN with you.

Procedure

1. Onthe Conference screen, do one of the following:

. Tap“and then tap -

« On the Participants screen, tap .

2. Inthe Add participant to the meeting area, tap one of the following:

« Choose a Contact or Terminal
« Enter a Number or Address

3. Select the contact or terminal from your contacts list or dial a number or address.

Avaya IX™ Workplace Client adds the participant to the meeting.

Adding a participant to a meeting on desktop clients
About this task

Use this procedure to invite participants to an ongoing Avaya IX™ Workplace Client video conference from any
endpoint. You can invite both individual users and people in meeting rooms equipped with room systems. With
Avaya Equinox® Conferencing, you can invite participants using:

» The participant's name from the organization's directory.

+ The number of the room system or the dedicated endpoint.

+ The phone number, E.164 address, IP address, or SIP address of the room system or dedicated endpoint.
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You must have moderator's rights to invite participants. By default, any participant in a video conference can be a
moderator, unless a virtual room is protected by its owner. You still might be able to invite other users to a video
conference if the owner of the video conference shares the moderator PIN with you.

Procedure
Do one of the following:

+ On the Contacts screen or the History screen, drag the card of a contact or terminal and drop it over the existing
conference card that includes the participants.

You cannot drag the card of a contact group and drop it over the existing conference card that includes the
participants.

Avaya IX™ Workplace Client adds the participant to the meeting.

« From the Conference screen, dial the number of a person or terminal that you want to add to the conference:

Click or u

Click Add Someone to Call.
Dial the telephone number or address.

Click Add to Meeting.

> w N

Avaya IX™ Workplace Client adds the participant to the meeting.

Requesting access to join a meeting
About this task
Use this procedure to request access to a meeting that is locked. The moderator can accept or deny your request.
Procedure

1. Enterthe participant code to enter the meeting.

The moderator receives a notification and you can view a message stating that you are requesting access.

2. Do one of the following:

+ Wait for the moderator to allow you to join the meeting.
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+ End Call: Disconnect the call without joining the meeting.

Accessing your meeting portal
About this task

Use this procedure to access your meeting portal. You can use the meeting portal to access recordings, schedule
your meetings, and configure the virtual room settings.

Procedure

On the Top of Mind screen, select Go to My Meeting Portal.

Video layout

Avideo layout is an arrangement of participant images as they appear on the monitor in a conference. If the
meeting includes a presentation, a layout can also refer to the arrangement of the presentation image together
with the meeting participants.

Avaya Equinox® Conferencing offers a wide variety of video layouts and features that make your conferencing
experience optimal.

The automatic video layout dynamically adjusts the number of frames displayed to the participants in the
conference. When someone joins the conference, it automatically switches the layout by adding a new frame.
The automatic video layout is usually used as the default layout.

Alternatively, you can choose video layouts with a fixed number of participants on display. The change that you
make to your video layout is not saved by Avaya Equinox® Conferencing. Hence, when you access your virtual
room the next time, the default layout is used.

You can use the Self-view feature to see your own video without transmitting it to other users.

Pinning a participant’s video
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About this task

Use this procedure to see the video of some participants in a conference. To make the video always visible, you
need to pin the participant's video in the required sub frame of the incoming video.

'9 Note:

You cannot pin the video of those participants that are hosted by slave MCU when cascading is used.

Procedure

1. Onthe Conference screen, in the Participants area, select the contact card of the participant.
2. Right-click or press and hold the contact card, and select Pin Video.

3. On the Conference screen, pin the participant to the required sub-frame of the incoming video screen.

Hiding your self-view

Procedure

1. Onthe Conference screen, select Eg

2. To hide the self view, select the Hide Self-view check box.

Multi-stream Switching video support

Avaya IX™ Workplace Client on desktop platforms support Multi-stream Switching (MSS) when you are connected
to an Avaya Equinox® Conferencing-based meeting if Avaya IX™ Workplace Client is configured for switching.
Avaya IX™ Workplace Client can render up to four streams of video based on screen real-estate, connection
quality, and decoding capability of the underlying device.

Configuring the Multi-stream Switching video settings
About this task

Use this procedure only on desktop clients. If you change the number of video streams, Avaya Equinox®
Conferencing saves your preference for the next conference call.
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Procedure

1. Onthe Conference screen, select Ea
2. Toview the name banners, select the Show Name Banners check box.
3. Inthe Number of Video Streams during the call field, select one of the following:

4
«3
2
1

Avaya Equinox® Conferencing limits the number of incoming streams for the call depending on your
preference.

Avaya Mobile Link

Users connected on a video conference can use Avaya Mobile Link to transfer the video conference onto an XT
Series endpoint. You can transfer the video conference without connecting the mobile or desktop device to the
endpoint with a cable. The XT Series endpoint is used for audio, video, and presentation of the meeting. Avaya
Equinox® Conferencing continues to run on the device in the Companion mode to support moderation and chat.
Companion mode includes everything except the audio and video capture and rendering features.

With Avaya Mobile Link, you can enjoy the XT Series endpoint’s crystal-clear audio, HD camera, and large display
during a video conference.

The Mobile Link and Screen Link features differ from one another in one significant way. You can use the Mobile
Link feature only during a conference call. However, you can use the Screen Link feature without being on a
conference call.

Transferring a video conference to an XT Series
endpoint

About this task

Use this procedure to transfer a video conference to an XT Series endpoint.

© Note:
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If you bridge onto a Mobile Link paired call from an MDA device, the call is dropped.

Before you begin

Ensure that the mobile or desktop device on which Avaya Equinox® Conferencing is running is on the same
network as the endpoint.

If the device and endpoint are in different networks, ensure that there is no NAT or firewall between them.
» For automatic pairing, use proximity sensing. The device’s speakers must be able to play audio at up to 19KHz.

« Set the device speaker volume to the maximum.
« Do not connect a headset.

Proximity pairing works in proximity to the endpoint’s microphone. The optimal distance is 1-1.5 m. The exact
distance depends on the type of microphone pod used one way or three way and the device’s gain levels.

+ When automatic proximity does not work, use manual pairing.

Procedure

To search for an endpoint:

1. Onthe Conference screen, do one of the following:

« On mobile clients: Selectn and then select Mobile Link.

) L
+ On desktop clients: Select - and in the Mobile Link area, select Search.

Avaya IX™ Workplace Client searches for accessible XT Series endpoints and displays a list of endpoints that
you can connect to.

2. Select the XT Series endpoint that you want to use.
To connect to an endpoint using the IP address of the endpoint:

1. Select Enter a Manual Location.
2. Enter the IP address of the endpoint on your device and do one of the following:

« On mobile clients: Select OK.

« On desktop clients: Select Connect.
If the XT Series endpoint is protected with a password:
1. Enter the password displayed on the endpoint screen and select OK.

Avaya IX™ Workplace Client transfers the video conference to the endpoint.
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To transfer the video conference back to your device:

1. On the Conference screen, do one of the following:

« On mobile devices: Selectn and then select Mobile Link.

; L
+ On desktop clients: Select and then select Stop Mobile Link.

2. Select one of the following:

« Disconnect Endpoint from the meeting

+ Keep Endpoint in the meeting

Avaya Screen Link

Users can present content from a laptop on an XT Series monitor without connecting it to the XT Codec Unit
using the Avaya Screen Link feature. If you are also using the XT Series monitor for a video conference, the
content is shared with all participants of the meeting, located in the same room and remotely.

Presenting content using an XT Series endpoint
About this task

Depending on its security configuration, an XT Series endpoint functions in one of the following ways:

+ Rejects Screen Link: The endpoint does not allow anyone to connect to it for screen sharing.

Requires password: The endpoint generates a one-time password that you must enter on your laptop to connect
toit.

+ Authenticates Avaya Equinox® Conferencing: The endpoint connects seamlessly.

Before you begin

« To present content to local participants only, ensure that the XT Series endpoint is not currently used for a video
conference. If you use the endpoint for an audio-only call, you can share the presentation with participants in the
meeting room.

» To present content during a conference, bring the laptop into a video conference room equipped with an XT
Series endpoint.
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+ To display your laptop’s content on the XT Series endpoint using Avaya Screen Link, ensure that the laptop on
which Avaya Equinox® Conferencing is running is in the same network as the endpoint. If the laptop and
endpoint are in different networks, ensure that there is no NAT or firewall between them.

« For automatic pairing, use proximity sensing. In this case, the laptop’s speakers must be able to play audio at
up to 19KHz. Hence, set the laptop speaker volume to the maximum.Proximity pairing works in proximity to

the endpoint’s microphone. The optimal distance is 1-1.5 m. The exact distance depends on the type of
microphone pod used one way or three way and the laptop’s gain levels.

« When automatic proximity does not work, use manual pairing.

Procedure
To search for an endpoint:

1. Inthe Notification area of your laptop, right-click ** and select Screen Link > Search for Endpoints.

Avaya IX™ Workplace Client searches for accessible XT Series endpoints and displays a list of endpoints that
you can connect to.

2. Select the XT Series endpoint that you want to use.

To connect to an endpoint using the IP address of the endpoint:

1. Inthe Notification area of your laptop, right-click ** and select Screen Link > Enter a Manual Location > Enter
a Manual Location.

2. Enterthe IP address of the endpoint on your laptop and select Connect.
If the XT Series endpoint is protected with a password:
1. Enter the password displayed on the endpoint screen and select OK.

Avaya IX™ Workplace Client displays the content on the screen of the XT Series endpoint or the content is
shared with remote participants.

To stop presenting your content on the endpoint screen:

1. Inthe Notification area of your laptop, right-click ** and select Screen Link > End Screen Link.

Requesting to become a moderator
About this task

If you join a conference that is protected by a moderator PIN, you get the participant role automatically. You get
the moderator role and capabilities after you enter the moderator PIN.
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Procedure

1. Onthe Conference screen, do one of the following:

« On mobile and desktop clients: Select u

+ On desktop clients: Select .

2. Do one of the following:

thf

« On Avaya IX™ Workplace Client for Mac: Select Moderator Controls.

« On mobile clients: Select

» On Avaya IX™ Workplace Client for Windows: Select Conference Features.
3. Select Become Moderator.
4. Use the keypad to enter the moderator code.

You become the conference moderator.

Managing the conference as a moderator

Recording a meeting
About this task

You can only do this task if you are a moderator.

If the meeting recording fails, all participants receive a notification stating that the recording has stopped.
Additionally, the moderator gets a failed notification.

Procedure

1. Onthe Conference screen, do one of the following:

« On mobile and desktop clients: Select H

« On desktop clients: Select .
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2. Do one of the following:

616

+ On mobile clients: Select !

» On Avaya IX™ Workplace Client for Mac: Select Moderator Controls.

« On Avaya IX™ Workplace Client for Windows: Select Conference Features.
3. Tostartrecording, select Recording.

4. Add an appropriate name and description to identify the recording.
Avaya IX™ Workplace Client starts recording the meeting.

5. Optional: You can pause and resume the recording.
6. To stop recording, select Recording.

Avaya Equinox® Conferencing saves the recording on the Conferencing server.

Disabling the mute option for all participantsina
conference

About this task

When the moderator enables the Lecture mode feature, all participants are muted in the conference. The
participants can only listen to the moderator and cannot unmute their audio.

When an event conference starts, the Lecture mode feature is enabled automatically. Participants are muted, but
presenters are not.

Procedure

1. Onthe Conference screen, do one of the following:

« On mobile and desktop clients: Select u

+ On desktop clients: Select .
2. Do one of the following:

th|

« On Avaya IX™ Workplace Client for Mac: Select Moderator Controls.

« On mobile clients: Select

» On Avaya IX™ Workplace Client for Windows: Select Conference Features.
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3. Totoggle the Lecture Mode feature on and off, select Lecture Mode.

Locking or unlocking the conference
About this task

The moderator can lock the conference to prevent new participants from joining the call. However, the
moderator can continue to add participants to the conference.

Procedure

1. Onthe Conference screen, do one of the following:

« On mobile and desktop clients: Select m

+ On desktop clients: Select .

2. Do one of the following:

o1

+ On mobile clients: Select o1

« On Avaya IX™ Workplace Client for Mac: Select Moderator Controls.

» On Avaya IX™ Workplace Client for Windows: Select Conference Features.
3. Totoggle the Lock Meeting feature on and off, select Lock Meeting.

Muting or unmuting all participants in a conference
About this task

Use this procedure to mute the audio of all participants in a conference, including participants with presenter

privileges. When you mute all participants, the participants can only listen to the moderator. Anyone can unmute
themselves.

Procedure

1. Onthe Conference screen, do one of the following:

« On mobile and desktop clients: Select u
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« On desktop clients: Select .
2. Do one of the following:

th]

« On Avaya IX™ Workplace Client for Mac: Select Moderator Controls.

« On mobile clients: Select

« On Avaya IX™ Workplace Client for Windows: Select Conference Features.
3. To mute all participants in the conference, select Mute Everyone.

4. To unmute all participants in the conference, select Unmute Everyone.

Granting permission to a participant to speak in the
Lecture mode

About this task

You can only do this task if you are a moderator.

Procedure

1. Onthe Conference screen, in the Participants area, select the contact card of the participant with the raised
hand.

2. Right-click or press and hold the contact card, and select Lower Hand.
3. Unmute the participant.

The unmuted participant receives a notification.

Changing the position and zoom of the endpoint’s
camera

About this task

Use the Far End Camera Control feature to change the position and zoom of the endpoint’s camera. You can only
do this task if you are a moderator.
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Before you begin

Camera rooms must be present in the meeting.

Procedure

1. On the Conference screen, do one of the following:

« On mobile and desktop clients: Select m

On desktop clients: Select .
ol
. .y g
2. Optional: On mobile clients, select

3. Select Control Camera, and select the camera of the participant that you want to control.
4. Choose the action that you want to perform:

« Up: Move the camera upwards.

« Down: Move the camera downwards.

» Right: Move the camera to the right.

+ Left: Move the camera to the left.

+ In: Zoom in the camera to make the focus area nearer.

« Out: Zoom out the camera to make the focus area farther away.

Viewing the dial-in information

Procedure

1. Onthe Conference screen, do one of the following:

« On mobile and desktop clients: Select H

« On desktop clients: Select .
[I:I fl':.
. I I']ﬂ
2. Optional: On mobile clients, select
3. Select Dial-in Information.

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 145



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

You can view the dial-in information.

Approving or declining a participant request to join a
locked meeting

About this task

You can only do this task if you are a moderator.

Before you begin

A participant must request access to join the locked meeting.

Procedure

1. Onthe Conference screen, in the Participants area, select the notification request.
2. Inthe Requesting Admission area, do one of the following:

« Select the participant name and then select Admit to Meeting or Refuse Admittance.
« Admit All.

« RefuseAll.

Extending the meeting end time
About this task

Use this procedure to extend the scheduled or adhoc meeting if the meeting policy has a specified end time. You
can only do this task if you are a moderator.

Before you begin

+ A meeting must be in progress.

+ The meeting is scheduled for a particular duration.

Procedure

1. Onthe Conference screen, do one of the following:
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« On mobile and desktop clients: Select “

On desktop clients: Select .
[I:I rl.'
. Lo IJH
2. Optional: On mobile clients, select

3. Select Extend Meeting.
4. Select one of the following:

o 15 minutes
« 30 minutes

« 60 minutes

All participants in the conference receive an audible message that states that the meeting is extended.

Handling conference calls

Viewing the call statistics of a conference call
About this task

Use this procedure to view the audio and video statistics of a conference call.

Procedure

Do one of the following:

« On mobile clients: Press and hold the call timer.

« On desktop clients: On the Conference screen, select and then select Call Statistics.
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« On desktop clients: On the Conference screen, select n and then select Call Statistics.

Viewing the link quality indicator
About this task

If you are on an advanced conference call, you can view the link quality indicator. The link quality indicator
provides an indication of the network quality.

Procedure

While on a conference call, check the link quality indicator next to the call timer.

The number of bars in the link quality indicator indicates the quality of the network.

.

5 bars: Indicates that network conditions are optimal.

4 bars: Indicates that there are minor network issues.

3 bars: Indicates that network issues have been detected.

2 bars: Indicates that there are moderate network issues.

1 bar: Indicates that there are severe network issues.

0 bar: Indicates that Avaya IX™ Workplace Client does not have any audio or video media. Avaya IX™

Workplace Client also displays this state when you are on a held call, Desk Phone mode call, or presentation-
only mode call.

Extending the conference call to a cellular network
About this task

Use this procedure to move your active VolIP call to the cellular network.

Before you begin

Ensure that your administrator configured the Extend Call feature for your extension.
Procedure

1. Onthe Conference screen, do one of the following:
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« On mobile and desktop clients: Select m

+ On desktop clients: Select .
2. Do one of the following:

« On mobile clients: Select Handoff to Cellular.

« On desktop clients: Select Extend Call.
You receive a call from Communication Manager on your EC500 number.
3. Do one of the following:

« On mobile clients: Answer the cellular call.
+ On desktop clients: Answer the cellular call and end the VolP call.

Managing the local video
About this task

Use this procedure to change the placement of the local video on the Conference screen.

This procedure is applicable to Avaya Equinox® Conferencing with Multi-stream Switching (MSS). This procedure
is not applicable when you use the Self-view feature.

Procedure

Press and drag the local video to any corner of the Conference screen.

Requesting permission to speak in the Lecture mode
About this task

Use this procedure to request permission from the moderator to speak. In the Lecture mode, all participants are
muted except the lecturer.

Procedure

1. Onthe Conference screen, in the Participants area, select your contact card.

2. Right-click or press and hold the contact card, and select Raise Hand.
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Avaya IX™ Workplace Client displays a raised hand in the Participants area next to your contact card.

Viewing the meeting encryption status
About this task

Use this procedure to receive the meeting encryption status when you enter a meeting or when the status
changes during a‘ call.

Procedure

On the Conference screen, a lock icon indicates whether the conference is encrypted, not encrypted, or partially
encrypted.

Managing conference participants

Selecting a participant as a lecturer
About this task

You must have moderator's rights to set yourself or any other participant as a lecturer. In the Lecture mode, all

participants are muted except the lecturer, unless the moderator unmutes a participant who requests permission
to speak.

This mode is tailored for distance learning, but you can also use it for other purposes such as an executive
addressing employees during companywide gatherings.

Procedure

1. Onthe Conference screen, in the Participants area, select the contact card of the participant.
2. Right-click or press and hold the contact card, and do one of the following:

« On mobile clients: Select Promote to Lecturer.
« On desktop clients: Select Lecturer.

3. Inthe confirmation dialog box, confirm the action.

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 150



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

Avaya IX™ Workplace Client promotes the participant to a lecturer.

Demoting a lecturer to a participant
About this task

You must have moderator's rights to demote a lecturer to a participant.

Before you begin

Ensure that the Lecture mode is active.
Procedure

1. Onthe Conference screen, in the Participants area, select the contact card of the lecturer.
2. Right-click or press and hold the contact card, and do one of the following:

« On mobile clients: Select Demote from Lecturer.
« On desktop clients: Select Lecturer.

3. Inthe confirmation dialog box, confirm the action.

Avaya IX™ Workplace Client demotes the lecturer to a participant.

Muting or unmuting a participant in a conference
About this task

Use this procedure to mute or unmute the audio of a participant in a conference.

You can only do this task if you are a moderator.
Procedure

1. Onthe Conference screen, in the Participants area, select the contact card of the participant.

2. To mute a participant, right-click or press and hold the contact card, and do one of the following:

« On mobile clients: Select Mute Participant.
« On desktop clients: Select Mute.

3. Tounmute a participant, right-click or press and hold the contact card, and do one of the following:
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« On mobile clients: Select Unmute Participant.
« On Avaya IX™ Workplace Client for Mac: Select Unmute.
« On Avaya IX™ Workplace Client for Windows: Toggle Mute.

Blocking or unblocking the video of a participantina
conference

About this task

You can only do this task if you are a moderator.

Procedure

1. Onthe Conference screen, in the Participants area, select the contact card of the participant.
2. To block the video, right-click or press and hold the contact card, and do one of the following:

« On mobile clients: Select Block Camera.
« On desktop clients: Select Block video.

3. Tounblock the video, right-click or press and hold the contact card, and do one of the following:

« On mobile clients: Select Unblock Camera.
« On Avaya IX™ Workplace Client for Mac: Select Unblock video.
+ On Avaya IX™ Workplace Client for Windows: Toggle Block video.

v
4. To view the participants not in the video conference, select and then select Not in Video.

Promoting a participant to moderator or presenter

Procedure

1. Onthe Conference screen, in the Participants area, select the contact card of the participant.

2. To promote a participant to moderator, right-click or press and hold the contact card, and do one of the
following:

« On mobile clients: Select Promote to Moderator.
+ On desktop clients: Select Moderator.
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3. To promote a participant to presenter, right-click or press and hold the contact card, and do one of the

following:

« On mobile clients: Select Promote to Presenter.
« On desktop clients: Select Presenter.

4. Inthe confirmation dialog box, confirm the action.

Dropping a participant from a conference
About this task

You can only do this task if you are a moderator.

Procedure

1. Onthe Conference screen, in the Participants area, select the contact card of the participant.

2. Right-click or press and hold the contact card, and do one of the following:

« On mobile clients: Select Drop from meeting.
« On desktop clients: Select Drop from call.

3. Inthe confirmation dialog box, confirm the action.

Viewing the participants in a conference

Procedure

1. Onthe Conference screen, in the Participants area, select
2. Do one of the following:

« On Avaya IX™ Workplace Client for iOS: Select Everyone.
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« On Avaya IX™ Workplace Client for Android and desktop platforms: Select All Participants.

Viewing the recent speakers in the conference

Procedure

vy
1. Onthe Conference screen, in the Participants area, select

2. Select Recent Talkers.

Viewing the web collaboration participants

Procedure

1. Onthe Conference screen, in the Participants area, select
2. Toview the participants in the web collaboration:

« On Avaya IX™ Workplace Client for iOS: Select In Collab.
« On Avaya IX™ Workplace Client for Android and desktop platforms: Select In Collaboration.
3. Toview the participants not currently accessing the web collaboration:

« On Avaya IX™ Workplace Client for iOS: Select Not in Collab.

« On Avaya IX™ Workplace Client for Android and desktop platforms: Select Not in Collaboration.

Viewing the participants who dropped from a
conference
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Procedure
1. Onthe Conference screen, in the Participants area, select
2. Do one of the following:

« On mobile clients: Select Dropped.

« On desktop clients: Select Dropped Participants.

Viewing participants with raised hands
About this task

You can only do this task if you are a moderator.

Procedure

1. Onthe Conference screen, in the Participants area, select
2. Select Raised Hands.

Sorting the participants in the conference
About this task

Use this procedure to sort the participants on the Conference screen alphabetically or according to their order of
arrival.

Procedure

A
1. Onthe Conference screen, in the Participants area, select *

On mobile clients, do the following:
1. Select one of the following:

« Alphabetic - Ascending
+ Alphabetic - Descending
+ Most Recent First
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+ Most Recent Last
Avaya IX™ Workplace Client sorts the participants on the Conference screen according to your selection.
On desktop clients, do the following:

1. Select one of the following:

Alphabetically

Reverse alphabetically
Order of arrival

« Reverse order of arrival

Avaya IX™ Workplace Client sorts the participants on the Conference screen according to your selection.

Messages

The Chat area on the Conference screen contains a list of messages exchanged by conference participants. The
Chat area also has a field where you can type messages.

You can view the participant name and time stamp with each message. You can send public messages to all
participants in a conference or private messages to an individual participant.

© Note:

Guest users do not have a Conferencing profile and cannot send or receive messages in a public chat.

Sending messages to all participants in a conference
About this task
Use this procedure to send public messages during a conference.
Procedure

1. Onthe Conference screen, go to the Chat area.
2. Type a message in the following field:

« On mobile clients: Enter Message to Everyone
« On desktop clients: Enter public message
3. Send the message.
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On desktop clients, the participants see the message immediately.

On mobile clients, the message pops up briefly and other participants in the conference can see an updated
number of unread messages.

9 Note:

On Android devices with operating system 5.1 and later, the device does not display pop-up messages.

4. On mobile clients, participants can select the pop-up message to open it or open the Chat area on the
Conference screen.

Avaya IX™ Workplace Client displays the message in the list with your name and the time that you sent the
message.

Sending a private message to a participantina
conference

Procedure

1. On the Conference screen, go to the Chat area.

2. Do one of the following:

« On mobile clients: Select

+ On desktop clients: Select M
3. Select the participant with whom you want to start a private chat.
4. Enter your message.
5. Send the message.

Ending a conference
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About this task

If you are a conference owner or PIN-protected moderator and use H on desktop clients to end the
conference, you can view the following options:
+ End for Me: If you select this option, the meeting continues without you.

+ End for Everyone: If you select this option, all participants receive an audio alert that the meeting is ending and
then the meeting ends for everyone.

Procedure

1. On the Conference screen, do one of the following:

» On mobile and desktop clients: Select m

« On desktop clients: Select .
2. Do one of the following:

&L
I ]
« On mobile clients: Select > End Meeting For Everyone.
» On Avaya IX™ Workplace Client for Mac: Select Moderator Controls > End Meeting For Everyone.
« On Avaya IX™ Workplace Client for Windows: Select Conference Features > End Meeting For Everyone.

3. Inthe confirmation dialog box, confirm the action.

Desk Phone mode limitations

Using Avaya IX™ Workplace Client in the Desk Phone mode on desktop platforms has the following limitations:

+ Video calling is disabled.
+ Multi-party call cannot be initiated using the New conversation area.
+ Adhoc conferences use the Communication Manager conference feature, not rich conferencing.

+ Screen sharing cannot be initiated from a point-to-point call.

You cannot use the Desk Phone mode on mobile clients.
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Sharing information

Currently, Avaya IX™ Workplace Client provides the sharing capabilities only on desktop clients. Mobile clients
can only receive the shared content.

Moderators and presenters can use web collaboration to share a portion of the screen, the entire desktop,
applications, or virtual whiteboards with participants in a conference.

Sharing information in a new or existing conference
Before you begin

Ensure that you have sharing permission.

Procedure

1. Onthe Conference screen, select .

2. Share one of the following:

« Entire display screen.

« Part of the screen: Drag the Annotations toolbar to the area of the screen to share.

9 Note:

If you share a part of the screen and then maximize an application, you lose screen sharing controls.

« Application window: Choose the application to share and select Share.

« Whiteboard: Share text or drawings with other participants.

Shared content might take time to display on the participant’s device. The download time depends on the
server throttling of downloaded content. For example, full screen content has more pixels and might take up
to 30 seconds to download.

BFCP sharing

By default, Avaya IX™ Workplace Client uses the Multi-stream Switching (MSS) feature. However, BFCP is not
supported with MSS. If you are in a P2P video call and BFCP is enabled while MSS is disabled, you can view the
option to share the following:
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« Entire display screen
« Part of the screen

+ Application window
G Note:

The Whiteboard option is unavailable for BFCP sharing.

If you de-escalate from video to audio, the BFCP sharing stops.

Navigation in presentation content

Use the Slider feature to view the presentation content that was presented previously during the meeting. The
Slider feature provides navigation keys at the top of the screen, above the presentation content.

Presentation content navigation tools

Button Name Description
E Content Slider Displays the presentation slides.
\_\ Zoom out Decreases the size of the screen content.
9 Magnification slider Changes the size of the screen content.
i_“. Zoomin Increases the size of the screen content.
x Auto fit Fits the screen content in the Web Collaboration interface.
_I-.-1_| Expand to full screen | Expands the Web Collaboration interface to the window size.
Previous Slide Goes to the previous slide of the presentation content.
Next Slide Goes to the next slide of the presentation content.
. Previous Page Goes to the previous page of the presentation content.
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Button Name

t == Scroll bar
J—

Next Page

Description
Scrolls to the left or right of the presentation content.

Goes to the next page of the presentation content.

Displays the current slide of the presentation content.

Annotations in shared content

Web collaboration provides various tools for annotating shared content, applications and screens, and a drawing
on a virtual whiteboard. You can add text, lines, and stamps to the shared content.

A presenter or a moderator can annotate all shared content. A participant can annotate only on a virtual

whiteboard.

The available tools depend on the content you are sharing. However, the icons are the same.

Shared content annotation tools

Button Name Description

Selection tool Selects an annotation. You can move the annotation with the mouse.

Inserts a stamp in the currently selected color. Use this tool to call attention to items you

are sharing.
Stamp tool A
Tip:

Use the color picker tool to choose the stamp color.

E Pen tool Draws a freehand line.

Highlights text or graphics.

Marker tool A Tip:

N

Use the color picker tool to choose the highlighting color.
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Button Name Description

Draws a straight line in the currently selected color.

Line tool .& Tip:

You can choose one of three line widths in the fly-out to choose the line thickness.
Rectangle tool Chooses a rectangle: filled or outline.

Draws a filled ellipse or circular ellipse in the currently selected color.
You can choose a filled ellipse or outline in the fly-out.

@ Circle tool l& Tin:

The button shows the ellipse type.

Adds text annotation in the currently selected color.

You can choose one of three text sizes in the fly-out: small, medium or large.

& Tip:

The button shows the text size.

Text tool

]

Deletes the selected annotation or all drawings.

Delete tool A Tip:
The button shows the delete type.

Moves the whiteboard when it is zoomed in and when the actual size of the whiteboard is

Move tool bigger than the visible area.

Selects a color for annotation.

Choose the color in the fly-out

.& Tip:

The current color is shown on the button.

Color picker tool

Show pointer tool Displays a pointer tool.
Sharing tool Provides an option to change what you are currently sharing.

Provides an option to give control of sharing your computer to a participant in the
conference.

AEE EE & B

Remote sharing tool

Pause sharing tool = Pauses or resumes sharing.

=
—
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Button Name Description
OR Stop Sharing Stops sharing the content.

Ending sharing
About this task

Use this procedure to stop sharing during a conference call.

9 Note:

Only the presenter or moderator of a conference can stop screen sharing. However, any participant of a
conference can stop whiteboard sharing.

Procedure

Do one of the following:

=1
« On the Conference screen, select and then select Stop Sharing.Only the active presenter can view the Stop
Sharing option on the Conference screen.

» On the Sharing screen, select .
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Managing contacts

The Contacts feature provides information about the following:

« All Contacts
« Workplace Contacts
 Favorite Contacts

« Local Contacts
Use the Contacts feature to:

« View the details of local, Workplace, and enterprise contacts.

+ Create a new contact or contact group.

+ Add an enterprise contact to your Workplace Contacts list.

+ Add a contact to your contact group.

+ Make a voice or video call to a contact or a group of contacts.

« Start an instant messaging conversation with an enterprise contact or a group of contacts.

+ Send an email to any contact using the email applications installed on your device.
You can access local contacts in Avaya IX™ Workplace Client if:

+ Contact accounts, such as SIM, Google, and Phone, are available in your address book

+ Contact groups, such as Friends and Family, are available in your address book

+ Contacts are listed in the default Contacts folder and sub-folders of Contacts folder in Microsoft Outlook
Enterprise contacts include contacts stored on various servers. Avaya IX™ Workplace Client displays enterprise

contacts from only those servers that your administrator has configured for display. If you have configured
Exchange on your mobile, you can search for an enterprise contact using Microsoft ActiveSync.

Viewing the self-contact information
About this task

Avaya IX™ Workplace Client retrieves and displays the self-contact information from various directories according
to the following priority:

1. Avaya Aura® Device Services
2. Client Enablement Services or LDAP

3. Avaya Cloud Services

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 164



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

4, Local

Before you begin

Ensure that Avaya Aura® Device Services, Client Enablement Services, LDAP, or Avaya Cloud Services are
configured properly.

Procedure

On the Top of Mind screen, select the presence status indicator.

Avaya IX™ Workplace Client displays the self-contact information with your picture.

Searching for a contact on mobile clients
About this task

When you search for a contact, Avaya IX™ Workplace Client performs a search for that contact in directories
according to the following priority:

1. Avaya Aura® Device Services

2. Client Enablement Services or LDAP
3. Avaya Cloud Services
4

. Local

You can perform an advanced search for enterprise contacts only if you use Avaya Aura® Device Services Release
7.1.6 and later. You cannot perform an advanced search for contacts that you added as Local or Workplace
contacts.

Before you begin

Ensure that Avaya Aura® Device Services, Client Enablement Services, LDAP, and Avaya Cloud Services are
configured properly.

Procedure

1. Inthe find someone field, start typing the name of the contact or the contact details that you want to look for.
Avaya IX™ Workplace Client displays the contacts that match the search text.

To perform an advanced search for enterprise contacts, do the following:

1. Inthe find someone field, tap ™.
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2. Type the search keywords in one or more of the following fields:

+ Name

« Location

« Department
3. Tap Search.

Avaya IX™ Workplace Client displays the contacts that match the search text.

Searching for a contact on desktop clients
About this task

When you search for a contact, Avaya IX™ Workplace Client performs a search for that contact in directories
according to the following priority:

1. Avaya Aura® Device Services

2. LDAP

3. Avaya Cloud Services

4. Local

You can perform an advanced search for enterprise contacts only if you use Avaya Aura® Device Services Release

7.1.6 and later. You cannot perform an advanced search for contacts that you added as Local or Workplace
contacts.

Before you begin

Ensure that Avaya Aura® Device Services, LDAP, and Avaya Cloud Services are configured properly.

Procedure

1. Inthe name or number field, start typing the name of the contact or the contact details that you want to look
for.

Avaya IX™ Workplace Client displays the contacts that match the search text.

To perform an advanced search for enterprise contacts, do the following:

1. Inthe name or number field, click ™.

2. Type the search keywords in one or more of the following fields:

« Name
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« Location
» Department
3. Click Search.

Avaya IX™ Workplace Client displays the contacts that match the search text.

Filtering contacts on mobile clients

Procedure

1. Go to the Contacts screen.

2. Filter the contacts using one of the following:

+ All Contacts: To view your Local and Workplace contacts when you log in to the VolP service, Avaya Aura®
Device Services, or Avaya Cloud Services. To view your Local and Client Enablement Services favorite
contacts when you log in to only Client Enablement Services.Workplace contacts include your PPM, Avaya
Aura® Device Services, and Avaya Spaces favorite contacts.

« Workplace Contacts: To view your Workplace contacts. Avaya IX™ Workplace Client displays this option when
you log in to the VolP service, Avaya Aura® Device Services, or Avaya Cloud Services.

+ Local Contacts: To view the contacts stored in your address book or local storage.

Avaya IX™ Workplace Client filters the contacts according to the option that you select.

Filtering contacts on desktop clients

Procedure

1. Go to the Contacts screen.
2. Filter the contacts using one of the following:

« All Contacts: To view your Local and Workplace contacts when you log in to the VolP service, Avaya Aura®
Device Services, or Avaya Cloud Services.Workplace contacts include your PPM, Avaya Aura® Device Services,
and Avaya Spaces favorite contacts.

« Workplace Contacts: To view your Workplace contacts. Avaya IX™ Workplace Client displays this option when
you log in to the VolP service, Avaya Aura® Device Services, or Avaya Cloud Services.

« Local Contacts: To view the contacts stored in your address book or local storage.
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Avaya IX™ Workplace Client filters the contacts according to the option that you select.

Adding an enterprise contact to your Workplace
Contacts

Procedure

1. Go to the Contacts screen.

2. Start typing the name of the contact or the contact details that you want to look for in the following field:

« On mobile clients: find someone
« On desktop clients: name or number

Avaya IX™ Workplace Client displays the contacts that match the search text.

Locate the enterprise contact that you want to add.
Select the contact.

Open the Contact Details or Directory Details screen.

o Uk w

Do one of the following:

« On mobile clients: Select Add to Contacts.
+ On Avaya IX™ Workplace Client for Mac: Select Add.
« On Avaya IX™ Workplace Client for Windows: Select Add Contact.

Avaya IX™ Workplace Client adds the enterprise contact to your Workplace Contacts list.

Adding a contact using the messaging address search
results

About this task

Use this procedure to add a contact using the messaging address search results only on mobile clients.

Procedure

1. Onthe Top of Mind screen, in the find someone field, type a valid messaging address.
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Avaya IX™ Workplace Client displays the New Contact area if the messaging address has no matches in the
local, enterprise, or PPM contacts list.

2. Inthe New Contact area, tap the messaging address.
Avaya IX™ Workplace Client displays the New Contact screen.

3. Tap Add to Contacts.
4. Enter the information in the mandatory fields.

5. Tap Done.

Avaya IX™ Workplace Client adds the contact.

Creating a hew contact
About this task

Use this procedure to create a new contact. Avaya IX™ Workplace Client adds the contact to your Workplace
Contacts list.

Procedure

1. Go to the Contacts screen.

2. Select
3. Optional: On mobile clients, select New Contact.

4. Enter the appropriate values in the fields.

+ Enter the first name and last name.
+ Enter an email address or a phone number or both.
+ Enter only one work email address.
5. Save the changes.
6. Optional: To update the contact details, select the contact, select Edit, and perform the changes.

Deleting a contact
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About this task

Use this procedure to delete a contact from your Workplace Contacts list. When you delete a contact, Avaya IX™
Workplace Client removes the contact from the associated contact groups.

'9 Note:

You can delete a local contact only from the contacts stored in the local address book.

Procedure

. Go to the Contacts screen.

. Filter the contacts using the Workplace Contacts option.

1
2
3. Locate the contact that you want to delete.
4. Select the contact.

5

. Do one of the following:
« On mobile clients: On the Contact Details screen, select Remove Contact.

+ On desktop clients: Select n and then select Remove Contact.
6. Confirm your selection.

Avaya IX™ Workplace Client removes the contact from your Workplace Contacts list.

Contact groups

Contact groups are only available with Avaya Aura® Device Services Release 7.1.6 and later. You can use Avaya IX™
Workplace Client to group your Workplace Contacts to better organize them. You can then initiate calls and
instant messages to the groups. For example, you might have separate groups for your project team, subordinate
team members, and response teams. The groups that you create are available across multiple devices.

You can perform the following actions in contact groups:

+ Create, rename, or delete a group.
+ Add a contact to a group.

+ Remove a contact from a group.
Contacts can be a part of multiple groups. However, contacts do not need to belong to any group.
You can perform the following actions on contacts in groups:

+ Add a contact to an existing group.

« Remove a contact from an existing group.
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+ View the list of groups to which a contact belongs.

Viewing and hiding a contact group
Before you begin

Enable and log in to Avaya Aura® Device Services.

Procedure

1. Go to the Contacts screen.

2. Inthe Contact Groups area, you can view all contact groups.

The contact groups are sorted alphabetically according to the group name.

3. Toview the contacts in a contact group, next to the contact group name, select ™ .

Avaya IX™ Workplace Client displays the contacts in that contact group.

4. To hide the contacts in a contact group, next to the contact group name, select *

Avaya IX™ Workplace Client hides the contacts in that contact group.

Creating a contact group on mobile clients
About this task

Create groups of your Workplace Contacts to better organize them. You can then initiate calls and instant
messages to the groups. For example, you might have separate groups for your project team, subordinate team
members, and response teams. The groups that you create are available across multiple devices.

If you use this procedure to add a local or enterprise contact to your contact group, Avaya IX™ Workplace Client
displays a dialog box to first add the contact to your Workplace Contacts list. If the value of any required field is
missing in the contact details, Avaya IX™ Workplace Client displays a screen for you to edit the contact details
before adding the contact to your Workplace Contacts list.

You can create a maximum of 75 contact groups.

Before you begin

Enable and log in to Avaya Aura® Device Services.
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Procedure

1. Go to the Contacts screen.

3. Tap New Contact Group.

2. Tap

Avaya IX™ Workplace Client displays the Choose contacts for your group screen.
4. Select the contacts to add to your group.

You can also use the find someone field to search and select a contact. You must select a minimum of one
contact.

5. Tap Next.
Avaya IX™ Workplace Client displays the Confirm contacts for your group screen.
6. Tap Done.
Avaya IX™ Workplace Client displays the Enter Group Name dialog with the default group name.

7. Optional: Type a new group name.
8. Tap OK.

Avaya IX™ Workplace Client creates the group with the selected contacts.

Creating a contact group on desktop clients
About this task

Create groups of your Workplace Contacts to better organize them. You can then initiate calls and instant
messages to the groups. For example, you might have separate groups for your project team, subordinate team
members, and response teams. The groups that you create are available across multiple devices.

If you use this procedure to add a local or enterprise contact to your contact group, Avaya IX™ Workplace Client
displays a dialog box to first add the contact to your Workplace Contacts list. If the value of any required field is
missing in the contact details, Avaya IX™ Workplace Client displays a screen for you to edit the contact details
before adding the contact to your Workplace Contacts list.

You can create a maximum of 75 contact groups.

Before you begin

Enable and log in to Avaya Aura® Device Services.
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Procedure
1. Go to the Contacts screen.
Click

Click New Group.
In the Enter Group Name field, type a new group name.

o ko

In the Setup Stage area, drag and drop contacts to add to your group.
You must drag and drop a minimum of one contact.
6. Click Create Group.

Avaya IX™ Workplace Client creates the group with the selected contacts.

Renaming a contact group on mobile clients
Before you begin

Enable and log in to Avaya Aura® Device Services.

Procedure

1. Go to the Contacts screen.
2. ldentify the contact group to rename.
3. On the contact group name, do one of the following:

« On Android devices: Press and hold, and then tap u
« OniOS devices: Full swipe to the left.

Avaya IX™ Workplace Client displays the More menu.

4. Tap Edit Group Name.
5. Type a new group name.
6. Tap OK.
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Avaya IX™ Workplace Client saves the contact group with the updated name.

Renaming a contact group on desktop clients
Before you begin

Enable and log in to Avaya Aura® Device Services.

Procedure

1. Go to the Contacts screen.
2. ldentify the contact group to rename.

3. On the contact group name, do one of the following:
+ Right-click.

« Hover the cursor and click m
4. Click Edit Group Name.
5. Type a new group name.
6. Click OK.

Avaya IX™ Workplace Client saves the contact group with the updated name.

Adding a contact to a contact group on mobile clients
About this task

If you use this procedure to add a local or enterprise contact to your contact group, Avaya IX™ Workplace Client
displays a dialog box to first add the contact to your Workplace Contacts list. If the value of any required field is
missing in the contact details, Avaya IX™ Workplace Client displays a screen for you to edit the contact details
before adding the contact to your Workplace Contacts list.

You can add maximum 250 contacts to each contact group.

&Tip:

You can also add a contact to a contact group from the:

+ More menu of an Workplace contact in the Contacts screen or another contact group.

« Contact Details screen of a local, Workplace, or enterprise contact.
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Before you begin

Enable and log in to Avaya Aura® Device Services.

Procedure

1. Go to the Contacts screen.
2. Identify the contact group to add a contact.
3. On the contact group name, do one of the following:

On Android devices: Press and hold, and then tap u
On iOS devices: Full swipe to the left.

Avaya IX™ Workplace Client displays the More menu.
4. Tap Add Contact to Group.

Avaya IX™ Workplace Client displays the Choose contacts for your group screen.
5. Select the contacts to add to your group.

You can also use the find someone field to search and select a contact.
6. Tap Next.

Avaya IX™ Workplace Client displays the Confirm contacts for your group screen.
7. Tap Done.

Avaya IX™ Workplace Client adds the selected contacts to the contact group.

Adding a contact to a contact group on desktop clients
About this task

If you use this procedure to add a local or enterprise contact to your contact group, Avaya IX™ Workplace Client
displays a dialog box to first add the contact to your Workplace Contacts list. If the value of any required field is
missing in the contact details, Avaya IX™ Workplace Client displays a screen for you to edit the contact details
before adding the contact to your Workplace Contacts list.

You can add maximum 250 contacts to each contact group.

&Tip:

You can also add a contact to a contact group from the:
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+ More menu of an Workplace contact in the Contacts screen or another contact group.

+ Contact Details screen of an Workplace or enterprise contact.

Before you begin

Enable and log in to Avaya Aura® Device Services.

Procedure

1. Go to the Contacts screen.
2. Identify the contact group to add a contact.
3. On the contact group name, do one of the following:

+ Right-click.

+ Hover the cursor and click u
4. Click Add Contact to Group.
5. Inthe Setup Stage area, drag and drop contacts that you want to add to your group.
6. Click Add to Group.

Avaya IX™ Workplace Client adds the selected contacts to the contact group.

Removing a contact from a contact group on mobile
clients

About this task

When you remove a contact from a contact group, Avaya IX™ Workplace Client does not remove the contact from
your Workplace Contacts list.

,/l\Tip:

You can also remove a contact from a contact group from the More menu of an Workplace contact in the Contacts
screen or another contact group.

Before you begin

Enable and log in to Avaya Aura® Device Services.

Procedure

1. Go to the Contacts screen.
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Locate the Workplace or enterprise contact to remove from a contact group.
Tap the contact.

On the Contact Details screen, in the Groups area, tap * next to a group name.

ok w

In the confirmation dialog box, confirm the action.

Avaya IX™ Workplace Client removes the contact from the selected contact group.

Removing a contact from a contact group on desktop
clients

About this task

When you remove a contact from a contact group, Avaya IX™ Workplace Client does not remove the contact from
your Workplace Contacts list.

&Tip:

You can also remove a contact from a contact group from the More menu of an Workplace contact in the Contacts
screen or another contact group.

Before you begin

Enable and log in to Avaya Aura® Device Services.

Procedure

Go to the Contacts screen.
Locate the Workplace or enterprise contact to remove from a contact group.
Double-click the contact.

On the Contact Details screen, in the Groups area, click * next to a group name.

ok W

In the confirmation dialog box, confirm the action.

Avaya IX™ Workplace Client removes the contact from the selected contact group.

Removing a contact group on mobile clients
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About this task

Remove a contact group that you do not use anymore. When you remove a contact group, Avaya IX™ Workplace
Client does not remove the contacts in that group from your Workplace Contacts list.

Before you begin

Enable and log in to Avaya Aura® Device Services.

Procedure

1. Go to the Contacts screen.
2. Identify the contact group to remove.
3. On the contact group name, do one of the following:

« On Android devices: Press and hold, and then tap n
« OniOS devices: Full swipe to the left.

Avaya IX™ Workplace Client displays the More menu.

4. Tap Remove Group.

5. Inthe confirmation dialog box, confirm the action.

Avaya IX™ Workplace Client removes the contact group.

Removing a contact group on desktop clients
About this task

Remove a contact group that you do not use anymore. When you remove a contact group, Avaya IX™ Workplace
Client does not remove the contacts in that group from your Workplace Contacts list.

Before you begin
Enable and log in to Avaya Aura® Device Services.

Procedure

1. Go to the Contacts screen.
2. ldentify the contact group to remove.

3. On the contact group name, do one of the following:
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+ Right-click.

« Hover the cursor and click m

4. Click Remove Group.
5. In the confirmation dialog box, confirm the action.

Avaya IX™ Workplace Client removes the contact group.
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Using Avaya IX™ Spaces

Avaya Spaces overview

Avaya Spaces is a cloud-based team collaboration and meeting application. It seamlessly integrates voice, video,
tasks, sharing, and more into your browser or the Spaces application.

You can use the Spaces area in the dashboard to start a new conversation. In fact, the first time you start using
Avaya Spaces, you can view the option to create your own Space. You can invite participants to your Space by
entering their email addresses. You can set different permissions for each participant based on the type of
actions you want them to be able to take within your Space. If you have many Spaces, you can categorize the
frequently used ones as favorites.

You can privately share documents and even escalate your chat with audio or video. The Posts area includes all
the documents and files that you or your teammates shared. You can click on any of the posts to make
comments, download the file, or attach more items, perhaps a revised version if you are editing a document.

You can assign tasks to other members of your space. Tasks are simply things that need to get done. You can also
set due dates and post additional comments.

Avaya Spaces integrates with Avaya IX™ Workplace Client. You can use Avaya IX™ Workplace Client :

» To exchange instant messages with other users using Avaya Spaces Direct Messaging.
+ To join a Spaces meeting.

« To open your Spaces dashboard.

Signing up for Avaya Spaces from Avaya IX Workplace
Client

Before you begin

Enable Avaya Cloud Services.

Procedure

1. Onthe Top of Mind screen, in the Workplace Meetings area, select Spaces Sign in / Sign up.

The Spaces URL opens in the default browser.
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2. Type your work email address.

Alternatively, if you have an account on Google, Office365, Salesforce, or Avaya, you can select the
corresponding icon to log in to Spaces with your account credentials.

3. Select Yes, sign me up!.
You receive an email to confirm your email address.

4. Follow the stepsin the email to complete your account.

Logging in to Avaya Spaces
About this task

Use this procedure to log in to Spaces from Avaya IX™ Workplace Client.

Before you begin

Ensure that you have an account on Spaces.

Procedure

1. Onthe Top of Mind screen, in the Workplace Meetings area, select Spaces Sign in / Sign up.
The Spaces URL opens in the default browser.

2. Enter your email address.

Alternatively, if you have an account on Google, Office365, Salesforce, or Avaya, you can select the
corresponding icon to log in to Spaces with your account credentials.
3. Inthe Password field, type your password.

4. Optional: To enable the application or browser to store your login credentials, select Keep me Signed in.
5. Select Sign In.

Opening Avaya Spaces from within Avaya IX Workplace
Client
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Before you begin

Log in to Avaya Cloud Services.

Procedure
On the Top of Mind screen, in the Workplace Meetings area, select Spaces Dashboard.
The dashboard opens in one of the following:

+ The Spaces application if the application is installed on your mobile device.

« The default browser if the application is not installed.If the browser is already open, the dashboard opensin a
new window.
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Presence and instant messaging

Presence Services is an application that indicates the availability or presence of a person by states, such as
“Available”, “Busy”, or “Offline”. From Avaya IX™ Workplace Client, you can:

+ Change your presence status.To update your presence status automatically to states such as Away or On a Call
using Presence Services, you must set your presence status to “Automatic” in Avaya IX™ Workplace Client. If you
set your presence status to a manual state, your administrator can configure the Presence server to change your
presence status back to Automatic after a period of time.

+ Change your custom presence status message.

Configure which users can view your presence status.

Presence Services supports the presence information gathered from a diverse range of sources and aggregates
this information for each user. Presence Services then makes this information available to Avaya IX™ Workplace
Client users.

You can exchange text-based instant messages with users. You can receive image, audio, video, and generic
attachments in an Instant Messaging (IM) conversation. Users with enhanced privileges can send generic
attachments and use the built-in recording feature of Avaya IX™ Workplace Client to attach audio, video, orimage
files.

© Note:

Desktop clients do not need enhanced privileges to send generic attachments.

Changing your presence status manually
About this task

Use this procedure to update your Avaya IX™ Workplace Client presence status manually.

You can also choose to have your status updated automatically by selecting the Automatic option. For example,
if your presence status is Automatic and:

« You are available, your presence status is updated automatically to Available(Auto).

« You lock your device, your presence status is updated automatically to Away(Auto).

Before you begin

Ensure that your administrator has not hidden all presence states using automatic configuration.
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Procedure

1. Onthe Top of Mind screen, select the presence status indicator.
2. Inthe My Presence area, select the presence status.

3. Select one of the following presence states to indicate your availability:

« Automatic
Available

» Busy
Unavailable: If Client Enablement Services is enabled and VolP is disabled

Away: If VoIP is enabled

« Do not disturb: If VoIP is enabled
« Out of office

« Offline

Configuring the interval after which your presence
status is automatically set to “Away”

About this task

You can configure the interval after which Avaya IX™ Workplace Client automatically sets your presence status to
“Away” when both the following conditions are met:

« Your presence status is set to “Automatic”.

+ You have not used Avaya IX™ Workplace Client for the selected interval.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences.

2. Optional: If available on the Avaya IX™ Workplace Client platform, select General. Otherwise, go to the next
step.

3. Optional: If available on the Avaya IX™ Workplace Client platform, select Auto Set to Away. Otherwise, go to
the next step.

4. Select one of the following time intervals:

* Never

« after 5 minutes: Only on desktop clients
« after 10 minutes

« after 15 minutes
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« after 30 minutes
« after 1 hour
« after 1.5 hours
« after 2 hours
5. Save the changes.

Management of incoming calls and instant messages
during DND

Incoming calls

The following sections describe how Avaya IX™ Workplace Client handles incoming calls and instant messages
when you set your presence status to “Do not disturb”.

In the Avaya IX™ Workplace Client settings, you can enable Activate SAC When DND Is Set. Incoming calls are then
forwarded to voice mail and do not ring on Avaya IX™ Workplace Client.

You can make outgoing calls as usual.

Instant messages

You receive IMs without any notifications.

Changing your presence status message

Procedure

1. Onthe Top of Mind screen, select the presence status indicator.
2. Inthe What are you up to? field, type your status message.

Configuring the presence followers setting on desktop
clients
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About this task

Use this procedure to configure which users can view your presence status.

Before you begin

« Enable Phone Service.

+ Ensure that your administrator has set the Presence Server policy for Access Control List (ACL) to Confirm.

Procedure

1. In Avaya IX™ Workplace Client settings, click Services > Presence Followers.
Do one or more of the following:

1. Optional: To stop people from following your presence status:

1. Click People Following Me.
2. Next to the name of a person, click * and then click Block.

2. Optional: To allow people to follow your presence status:

1. Click Blocked Followers.
2. Next to the name of a person, click -+ and then click Allow.

3. Optional: To configure the pending requests of users who want to follow your presence status:

1. Inthe Pending Requests area, next to the name of a person, click
2. Click Allow or Block.

4. Savethe changes.

Acknowledging the presence notification requests on

desktop clients
Before you begin

« Enable Phone Service.

« Ensure that your administrator has set the Presence Server policy for Access Control List (ACL) to Confirm.

Procedure

In the custom notification toast:
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+ If there is only one pending request for following your presence, click one of the following:

« Allow: To allow the user to follow your presence status.
« Block: To block the user from following your presence status.
+ If there are multiple pending requests for following your presence, click one of the following:
« View: To open the Presence Followers screen.Use this screen to configure which users can view your presence
status.

« Not Now: To ignore the pending requests for now.

Instant messaging using Avaya Multimedia Messaging
and Avaya Spaces Direct Messaging

You can exchange instant messages with other users using Avaya Multimedia Messaging and Spaces Direct
Messaging. Avaya Multimedia Messaging is used as the default over Spaces Direct Messaging. If you are not
logged into both, chat is disabled.

If your configuration includes both Avaya Multimedia Messaging and Spaces, the Messages screen retrieves:

+ All active Avaya Multimedia Messaging conversations.

+ The latest 100 Spaces Direct Messaging conversations.
Avaya IX™ Workplace Client displays unread messages from:

» Avaya Multimedia Messaging in red text.

+ Spaces Direct Messaging in bold text.

If your configuration includes both Avaya Multimedia Messaging and Spaces, the Contact Details screen displays
the following icons:

« 1" 7: To start a Spaces Direct Messaging conversation.

. : To start an Avaya Multimedia Messaging conversation.

If your configuration includes either Avaya Multimedia Messaging or Spaces, the Contact Details screen displays

the icon.
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You cannot invite non-members to join you on Spaces using Avaya IX™ Workplace Client.

Working with instant messages

Starting an instant message conversation on mobile
clients

About this task

Use this procedure to start an instant message conversation with contacts using Avaya Multimedia Messaging or
Avaya Spaces Direct Messaging. You cannot use Spaces to have a multiparty conversation.

You can also start an instant message conversation using the messaging address. However, the steps involved in
starting such a conversation are different and are covered in a different procedure.

Procedure

1. Go tothe Messages screen.

+ .

2. Tap
Avaya IX™ Workplace Client displays the Choose contacts for your conversation screen.

3. Select the contacts whom you want to include in the conversation.
4. Tap Next.

Avaya IX™ Workplace Client displays the Confirm contacts for your conversation screen.

5. Tap Add.
6. Optional: Type a subject and tap Done.
7. Inthe Enter message text field, type your message.

8. Optional: To add an animated emoji, tap and select the animated emoji that you want to use.

You can add a static emoji anywhere in the text using the native keyboard.
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9. Optional: If you have enhanced privileges, send generic attachments and use the built-in recording feature of
Avaya IX™ Workplace Client to attach audio, video, or image files.

10. Tap

Avaya IX™ Workplace Client starts a new conversation.

Starting an instant message conversation on desktop

clients
About this task

Use this procedure to start an instant message conversation with contacts using Avaya Multimedia Messaging or

Avaya Spaces Direct Messaging. You cannot use Spaces to have a multiparty conversation.

You can also start an instant message conversation using the messaging address. However, the steps involved in
starting such a conversation are different and are covered in a different procedure.

Procedure
1. Click New conversation.
2. Dragand drop contacts or contact groups.
3. Click
Avaya IX™ Workplace Client displays a new conversation window.
4. Optional: To type a subject:
1. On the conversation window, click ~.
2. Click Edit Subject.
3. Type asubject.
4. Click Done.
5. Inthe Enter message text field, type your message.
Py
6. Optional: To add a static emoji, click 2/ and select the static emoji that you want to use.
©
7. Optional: To add an animated emoji, click "= and select the animated emoji that you want to use.

8. Optional: If you have enhanced privileges, send generic attachments and use the built-in recording feature of
Avaya IX™ Workplace Client to attach audio, video, or image files.
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9. Click

Avaya IX™ Workplace Client sends the message.

Starting an instant messaging conversation using the
messaging address on mobile clients

About this task

Use this procedure to start an instant messaging conversation using the messaging address.

&Tip:

In the New Contact area, you can perform the following actions on the messaging address to view the option to
start an instant messaging conversation:

+ OniOS devices, depending on the OS version, you might be able to swipe left or full swipe to the left.

On Android devices, you can press and hold.
Before you begin
Enable and log in to Multimedia Messaging or Avaya Spaces Direct Messaging.

Procedure

1. Onthe Top of Mind screen, in the find someone field, type a valid messaging address.

2. Inthe New Contact area, tap the messaging address.

3. Inthe Send a Message area, next to the messaging address, tap L,
4. Inthe Enter message text field, type your message.

5. Optional: To add an animated emoji, tap and select the animated emoji that you want to use.

You can add a static emoji anywhere in the text using the native keyboard.

6. Tap
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Avaya IX™ Workplace Client starts a new conversation.

Starting an instant message conversation using the

messaging address on desktop clients
Before you begin

Enable and log in to Multimedia Messaging or Avaya Spaces Direct Messaging.

Procedure

6.
1.

On the Top of Mind screen, in the name or number field, type a valid messaging address.

Next to the messaging address, click 0O,

Optional: To type a subject:

1. On the conversation window, click —.
2. Click Edit Subject.

3.

4. Click Done.

Type a subject.

In the Enter message text field, type your message.

N

Optional: To add a static emoji, click \~/ and select the static emoji that you want to use.

Optional: To add an animated emoji, click "=/ and select the animated emoji that you want to use.

'y

Optional: If you have enhanced privileges, send generic attachments and use the built-in recording feature of
Avaya IX™ Workplace Client to attach audio, video, or image files.

8. Click

Avaya IX™ Workplace Client sends the message.

Starting a conversation with all members of a contact

group on mobile clients
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About this task

You can have a multiparty conversation using Avaya Multimedia Messaging. You cannot use Avaya Spaces Direct
Messaging to have a multiparty conversation.

If some members in the contact group do not have a valid messaging address, you can proceed to have a
conversation without these members.

Before you begin

+ Enable and log in to Avaya Aura® Device Services.

» Enable and log in to Multimedia Messaging.

Procedure

1. Go to the Contacts screen.
2. Identify the contact group to start a conversation.
3. On the contact group name, do one of the following:

« On Android devices: Press and hold.
« OniOS devices: Swipe to the left.
4. Tap O,

Avaya IX™ Workplace Client starts a conversation with all members of the group who have a valid messaging
address.

Starting a conversation with all members of a contact
group on desktop clients

About this task

You can have a multiparty conversation using Avaya Multimedia Messaging. You cannot use Avaya Spaces Direct
Messaging to have a multiparty conversation.

If some members in the contact group do not have a valid messaging address, you can proceed to have a
conversation without these members.

Before you begin

+ Enable and log in to Avaya Aura® Device Services.

+ Enable and log in to Multimedia Messaging.
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Procedure

1. Go to the Contacts screen.
2. ldentify the contact group to start a conversation.

3. Onthe contact group name, hover the cursor.
4. Click &2,

Avaya IX™ Workplace Client starts a conversation with all members of the group who have a valid messaging
address.

Limitations of using the messaging address for instant
message conversations

If you use a messaging address to start an instant messaging (IM) conversation, the following limitations exist:

+ You cannot add a non-enterprise contact to an existing IM conversation with a non-enterprise contact.

+ You might not be able to send attachments to a non-enterprise contact using Avaya Multimedia Messaging.You
can send attachments to all contacts using Avaya Spaces Direct Messaging.

Formatting a message on Android clients
About this task

You can format a complete message or a part of the message with any combination of the following:

» Bold
« ltalic

« Underline

Before you begin
+ Use one of the following:

+ Avaya Multimedia Messaging Release 3.5 and later
» Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1.2 and later

+ Enable and log in to Multimedia Messaging.
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Procedure

1. Inthe Enter message field, type your message.
2. Inthe text box area, press and hold the message in the Enter message field.
3. Do one of the following:

+ To select the complete message, tap Select All.
+ To select a partial message, move the slider to select a part of the message.
4. Tap one of the following:

- Bold
« ltalic
« Underline

5. If you want to add more than one type of formatting, repeat steps 2 to 4.

Formatting a message on iOS clients
About this task

You can format a complete message or a part of the message with any combination of the following:

» Bold
« ltalic

« Underline

Before you begin

+ Use one of the following:

+ Avaya Multimedia Messaging Release 3.5 and later
+ Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1.2 and later

+ Enable and log in to Multimedia Messaging.

Procedure

1. Inthe Enter message field, type your message.
2. Inthe text box area, press and hold the message in the Enter message field.
3. Tap one of the following:

+ Select All: To select the complete message.
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« Select: To select a part of the message.

4. If you tap Select, move the slider to select the desired part of the message.

5. Tap .

6. Tap one of the following:

« Bold
« Italic
« Underline

7. Optional: If you want to add more than one type of formatting, repeat steps 2 to 6.

Formatting a message on Mac clients
About this task

You can format a complete message or a part of the message with any combination of the following:

« Bold
« [talic

« Underline

Before you begin
+ Use one of the following:

» Avaya Multimedia Messaging Release 3.5 and later

+ Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1.2 and later

+ Enable and log in to Multimedia Messaging.

Procedure

1. Inthe Enter message field, type your message.
2. Inthe text box, select the complete or partial message.
3. Right-click the highlighted text and click one of the following:

« Bold
« Italic

« Underline

& Tip:
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You can also use keyboard shortcut keys to apply the following formatting on 0OS X 10.13 and later:

» Bold: command +B
« ltalic: command + I
« Underline: command +U

4. If you want to add more than one type of formatting, repeat steps 2 to 3.

Formatting a message on Windows clients
About this task

You can format a complete message or a part of the message with any combination of the following:

» Bold
« ltalic

Underline

« Font

G Note:

If you use this procedure to format and send the message, Avaya IX™ Workplace Client displays the message as
plain text if the recipient is using an Android device.

Before you begin
+ Use one of the following:

+ Avaya Multimedia Messaging Release 3.5 and later
« Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1.2 and later

+ Enable and log in to Multimedia Messaging.

Procedure

1. Inthe Enter message field, type your message.
2. Select the complete or partial message.

3. Use the following keyboard shortcut keys to apply one or more of the formatting:

« Bold:Ctrl+B
o ltalic:Ctrl+1I
e Underline:Ctrl+U
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4. To change the font settings, do the following:

1. Select the complete or partial message.
2. Right-click the highlighted text, and click Change Font.

Avaya IX™ Workplace Client displays the Font dialog box.

3. Change the font settings in the fields as required.
4. Save the changes.

5. Restart Avaya IX™ Workplace Client.

Changing the font settings on Windows clients
Before you begin

+ Use one of the following:

+ Avaya Multimedia Messaging Release 3.5 and later
+ Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1.2 and later

+ Enable and log in to Multimedia Messaging.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, click User Preferences.
2. Click Messaging > Change Font.

Avaya IX™ Workplace Client displays the Font dialog box.

In the Font field, click the font that you want to use.
In the Font style field, click the font style that you want to use.

In the Size field, click the font size that you want to use.

o kAW

In the Effects area, do one or more of the following:

To strikeout the text, select the Strikeout check box.

« To underline the text, select the Underline check box.

« To use colored font, in the Color field, click the color that you want to use.
7. Optional: To apply the changes and keep the Font dialog box open, click Apply.
8. To apply the changes and close the Font dialog box, click OK.

9. To apply the following font settings for incoming messages, select the Apply font settings to incoming
messages check box:
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» Font
+ Size
+ Color
10. Save the changes.
11. Restart Avaya IX™ Workplace Client.

Copying and pasting an instant message
About this task

Use this procedure to copy and paste an instant message in the same conversation or to a different conversation.
Before you begin
You must have a conversation in progress.

Procedure

1. Copy the instant message.
2. Inthe Enter message field, paste the instant message.

Spell check in Windows

Spell checking on a Windows computer depends on the following language categories:

+ OS language: This is the language in which you have the localized resources on the local Windows OS. This
includes mainly text.

+ Input language: This is the language in which you write. This determines the keyboard layout.

« Workplace language: This is the language which you choose for Avaya IX™ Workplace Client in User Preferences >
Display > Languages. This determines the language in which you can view content within Avaya IX™ Workplace
Client.

Avaya IX™ Workplace Client always performs spell checking in the Workplace language. Spell checking is
successful only if you install the input language package on the computer for the corresponding Workplace
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language. Windows performs spell checking by comparing the validity of a written word with the list of valid
words that the input language contains.

Enabling spell check in Windows
Before you begin

Ensure that your administrator enabled spell check when setting up automatic configuration.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, click User Preferences.

2. Click Messaging.

3. Ifthe Spell check enabled switch is in the disabled state, click Spell check enabled.
4. Savethe changes.

Marking all instant messages as read
About this task

Use this procedure to mark all messages as read in a conversation, including the unread messages.

Before you begin

You must have a conversation in progress.

Procedure

On the conversation menu, select Mark all as read.

Status of sent instant messages

Avaya IX™ Workplace Client provides support for the following instant messaging indications with Avaya
Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1 and later:

+ Message delivered from the server to the receiving client
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+ Message read on the receiving client

For the instant messages that you send in an individual conversation, Avaya IX™ Workplace Client displays the
following status:

+ Send Failed: Avaya IX™Workplace Client displays this status if the message fails to get sent. You can try to
send the message again or delete the message.

+ Delivered: Avaya IX™ Workplace Client displays this status if the message gets delivered.

+ Read: Avaya IX™ Workplace Client displays this status along with the timestamp when the recipient reads your
message while the Send read receipts setting is enabled in Avaya IX™ Workplace Client of the recipient. Avaya IX™
Workplace Client marks the message status as Read, only after the recipient opens the conversation and reads
your message. Avaya IX™ Workplace Client does not display a read receipt for attachments. However, Avaya IX™
Workplace Client displays a read receipt if you include text along with the attachment.

For the instant messages that you send in a group conversation, Avaya IX™ Workplace Client displays the
following status:

+ Send Failed:Avaya IX™Workplace Client displays this status if the message fails to get sent. You can try to
send the message again or delete the message.

+ A11 Read:Avaya IX™Workplace Client displays this status along with the timestamp when all recipients have
read your last message while the Send read receipts setting is enabled in Avaya IX™ Workplace Client of the
recipients.

+ Some Read:Avaya IX™ Workplace Client displays this status along with the timestamp when only some of the
recipients have read your message while the Send read receipts setting is enabled in Avaya IX™ Workplace Client
of the recipients.

'9 Note:

Avaya IX™ Workplace Client does not display the Delivered status in a group conversation.

Viewing the read receipt for an instant message that is
read by only some of the recipients

About this task

Use this procedure if you are in a group conversation and only some of the recipients have read your message.

Before you begin

+ Use Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1 and later.

+ Enable and log in to Multimedia Messaging.
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Procedure

For your message that is read by only some of the recipients, select Some Read.
Avaya IX™ Workplace Client displays the list of all the users who have:

+ Read your message

+ Not read your message yet

Disabling read receipts for instant messages
About this task

Avaya IX™ Workplace Client provides support for the following instant messaging indications:

Message delivered from the server to the receiving client

+ Message read on the receiving client

By default, Avaya IX™ Workplace Client enables read receipts for instant messages.

If you disable read receipts:

+ The sender of the instant messages receives notifications when the messages are delivered.

« The sender of the instant messages does not receive read receipts if you only read the messages.However, when
you reply to the messages, it implicitly means that you have read all the previous messages in the conversation.
Hence, the sender of the instant messages receives notifications indicating that the messages were read.

» You receive read receipts of messages that you send to others, as long as the receiver of your messages does not
disable read receipts on their Avaya IX™ Workplace Client.

Before you begin

+ Use Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1 and later.

+ Enable and log in to Multimedia Messaging.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences.
2. Select Messaging.
3. Todisable the setting, turn off Send read receipts.
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4,

Save the changes.

Disabling emoji animation
About this task

Use this procedure to disable all emoji animations for yourself. This includes incoming, outgoing, and preview of
emoji animations.

By default, Avaya IX™ Workplace Client displays animated emojis. If you disable emoji animations, Avaya IX™
Workplace Client displays animated emojis as static images.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select User Preferences.
2. Select Messaging.

3.
4

. Save the changes.

To disable the setting, select Emoji Animation.

Configuring the notification sound for instant messages
About this task

Use this procedure only on Avaya IX™ Workplace Client for Android and Windows to configure the notification
sound when you receive instant messages.

Procedure

1.
2.
3.

4,

In the Avaya IX™ Workplace Client settings, select User Preferences.
Select Notifications.

To hear a notification sound when you receive instant messages:

» On Avaya IX™ Workplace Client for Android: Select Messaging Notification Sound.
« On Avaya IX™ Workplace Client for Windows: Select AMM Notification Sound.

Optional: On Avaya IX™ Workplace Client for Android, select one of the following:

« Default: To use the default notification sound.
« Custom: To select a custom ring tone for the notification sound.

« Off: To turn off the notification sound.
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On all clients, do the following:

1. Savethe changes.

Configuring the instant messaging provider
About this task

Use this procedure if you want Avaya IX™ Workplace Client for Windows to be the instant messaging provider for
applications on the Windows desktop.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Desktop Integration.
2. Select IM Provider.

3. To enable the setting, select Set as default IM Provider.

4

. Save the changes.

Working with attachments

Adding attachments to an instant message
About this task

If you are using Avaya Multimedia Messaging, only users with enhanced Avaya Multimedia Messaging privileges
can send generic attachments and use the built-in recording feature of Avaya IX™ Workplace Client to attach
audio, video, or image files. On desktop clients, you do not need enhanced privileges to send generic
attachments.

If you are on a VolIP call, you must wait for the VolP call to end before you can use the built-in recording feature of
Avaya IX™ Workplace Client.

'9 Note:

If you are using a third-party application and want to share a file in an Avaya IX™ Workplace Client conversation,
you can select the share option to view Avaya IX™ Workplace Client. On selecting Avaya IX™ Workplace Client, you
can add the attachment to a conversation. This applies to all platforms, except iOS.
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Before you begin

You must have a conversation in progress.

Procedure

1. Select

2. Select one of the options to select the type of attachment:

+ Record and attach an audio message.

» Capture and attach a video message.

+ Click and attach a photo.

« Attach a generic file from your gallery, music player, photos, or other available applications.

3. Select ,orpressEnter.

Avaya IX™ Workplace Client sends the attachment to the participants.

Viewing attachments
About this task

Use this procedure to view the attachments that you receive as part of a conversation. The attachment might be
a photo, video, audio file, or generic attachment. The badge count on a conversation indicates how many new
and unread messages are in that conversation.

To prevent Avaya IX™ Workplace Client from downloading common malware, your administrator might restrict
the download of attachments with specific file extensions.

Before you begin

You must have a conversation in progress.

Procedure

1. Do one of the following:

« To view a photo, select the photo.

« Toview a video, select the video.

« To listen to an audio file, select the audio file.

« To view a generic attachment, select the attachment.
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2. Select the application that you want to use to view the file.

Managing instant messaging participants

Adding participants to a conversation on mobile clients
About this task

Use this procedure to add participants to an Avaya Multimedia Messaging conversation. You cannot use Spaces
to have a multiparty conversation.

If you add a participant who has never logged in to Avaya Multimedia Messaging, Avaya IX™ Workplace Client
displays the following error message: Participant address is incorrect.

Before you begin

You must have a conversation in progress.

Procedure

1. Onthe conversation menu, select Add participant.
Avaya IX™ Workplace Client displays the Choose contacts for your conversation screen.

2. Select the contacts whom you want to include in the conversation.
3. Tap Next.

Avaya IX™ Workplace Client displays the Confirm contacts for your conversation screen.

4. Tap Add.

Adding participants to a conversation on desktop
clients
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About this task

Use this procedure to add participants to an Avaya Multimedia Messaging conversation. You cannot use Spaces
to have a multiparty conversation.

If you add a participant who has never logged in to Avaya Multimedia Messaging, Avaya IX™ Workplace Client
displays the following error message: Participant address is incorrect.

Before you begin

You must have a conversation in progress.

Procedure
Do one of the following:
1. Dragand drop contacts to a conversation.
You cannot drag contact groups to a conversation.
2. Onthe Participants screen:
1. Right-click an existing participant and select Add participant.

© Note:

Use the Add Participant dialog box to add users from only the Local or Workplace Contacts list. To add a
new participant from an LDAP to a conversation, search for the contact using the name or number field
and then drag and drop the contact into the conversation.

2. Search for a contact and then select that contact.
3. Select Add.

4. Inthe confirmation dialog box, confirm the action.

Viewing instant messaging participants
Before you begin

You must have a conversation in progress.

Procedure

Do one of the following:

+ On mobile clients: On the conversation menu, select View Participant List.
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+ On desktop clients: On the Conversations screen, select X participants.X indicates the number of participants.

Avaya IX™ Workplace Client displays the Participants dialog box that includes the list of participants.

Adding the IM participant as a Workplace Contact on
desktop clients

About this task

Use this procedure to add the participant of a point-to-point instant messaging conversation as a Workplace
Contact.

Procedure
1. Go tothe Messages screen.

2. Hover the cursor on a point-to-point instant messaging conversation, and click
3. Enterthe appropriate values in the fields to add the contact.
4. Click Add Contact.

Removing a participant from a conversation on mobile
clients

About this task

Use this procedure to remove a participant from an Avaya Multimedia Messaging conversation. The conversation
history displays who removed whom from the conversation. The participant who is removed from the
conversation can still view the history of conversation. However, the conversation history is up-to-date only till
the time that the participant was part of the conversation.

Before you begin

+ You must use Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1.2 and later.
+ Your administrator must enable the capability to remove participants.

+ You must have a conversation in progress.
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Procedure

1. Onthe conversation menu, tap View Participant List.
Avaya IX™ Workplace Client displays the Participants screen that includes the list of participants.

2. Tap the name of a participant.

3. Tap Remove from Conversation.

Avaya IX™ Workplace Client removes the selected participant from the conversation.

Removing a participant from a conversation on desktop
clients

About this task

Use this procedure to remove a participant from an Avaya Multimedia Messaging conversation. The conversation
history displays who removed whom from the conversation. The participant who is removed from the
conversation can still view the history of conversation. However, the conversation history is up-to-date only till
the time that the participant was part of the conversation.

Before you begin

+ You must use Avaya Multimedia Messaging service on Avaya Aura® Presence Services Release 8.1.2 and later.
+ Your administrator must enable the capability to remove participants.

+ You must have a conversation in progress.

Procedure
1. Onthe conversation menu, click X participants.
Xindicates the number of participants.
Avaya IX™ Workplace Client displays the Participants dialog box that includes the list of participants.

2. Toremove a participant, click Participant’s name > Remove from Conversation.
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Avaya IX™ Workplace Client removes the selected participant from the conversation.

Searching for an instant message
About this task

On some Avaya IX™ Workplace Client platforms, you must use the Search key to view the results after you use this
procedure.

G Note:

You cannot perform a search for an Avaya Spaces Direct Messaging conversation.

Procedure

1. Go tothe Messages screen.
2. Filter the messages and select Search All Messages.

3. Start typing the names of participants or the text that you want to look for.

Avaya IX™ Workplace Client displays the messages in your conversations that match the search criteria.

Leaving an instant messaging conversation
About this task

Use this procedure to leave an Avaya Multimedia Messaging conversation. You cannot leave a Spaces
conversation.

© Note:

If a participant removes you from a conversation, then instead of Leave Conversation you can view Remove
Conversation.

Procedure
1. Onthe conversation menu, select Leave Conversation.
2. Optional: If available on the Avaya IX™ Workplace Client platform, in the Leave Conversation dialog box,

select OK.

Avaya IX™ Workplace Client removes the conversation from your conversation history.
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Configuring Avaya IX™ Workplace Client Add-in for
Microsoft Outlook

Avaya IX Workplace Client add-in for Microsoft Outlook

Avaya IX™ Workplace Client provides a new and improved Outlook add-in for desktop platforms that includes the
following features:

+ Add meeting details to an appointment.

Start and join conferences from your calendar.

Start a call from within Outlook to a contact using Avaya IX™ Workplace Client for Windows.

Additionally:

+ You can add meeting invites on behalf of someone who has given you delegate access to their Exchange
Calendar.

+ You can automatically configure the meeting information for Avaya IX™ Workplace Client.

+ The conferencing system provides the meeting invite templates for Avaya Equinox® Conferencing.

» Microsoft Windows IM Provider integration, which is optional, activates click-to-IM and presence in Outlook for
Avaya IX™ Workplace Client contacts.

'9 Note:

Microsoft Outlook add-in for web mail does not support calendar delegation and IM provider.

In Avaya Equinox® Release 3.4 and later versions, the Outlook add-in includes support for Avaya Spaces. Besides
the existing capabilities, the Outlook add-in integrates the workflow from the existing Avaya Spaces Outlook add-
in. You need to sign in to Avaya Spaces on Avaya IX™ Workplace Client to enable Avaya Spaces in the Outlook add-
in.

By integrating with Avaya Spaces, you can use the Search feature to search for a meeting if multiple meetings are
configured.

Microsoft Outlook requirements
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+ Microsoft Outlook add-in for Windows is supported on Exchange Server 2010 SP1 and later versions, including
Office 365.

+ Microsoft Outlook add-in for Mac and web mail is supported on Exchange Server 2013 and later versions,
including Office 365.

+ You must enable the Exchange Calendar service in Avaya IX™ Workplace Client for the Microsoft Outlook add-in to
work.

« Internet access must be available because portions of the add-in are hosted on the Internet as a part of the new
Avaya IX™ Workplace Client add-in for Microsoft Outlook architecture.

+ To use the Delegate feature, you must be provided with delegate access to the calendars that you wish to access.
Contact your IT department for assistance.

Avaya IX Workplace Client add-in for Microsoft Outlook
installation

The Outlook add-in is installed by default during the Avaya IX™ Workplace Client installation.

To prevent the default installation on Avaya IX™ Workplace Client for Windows, select the Custom setup type and
disable the Outlook add-in installation. The add-in is also enabled by default for non-guest users.

Functionality differences between the Outlook native
and web-based add-in

Microsoft Outlook add-in for Avaya IX™ Workplace Client for Windows includes native components. These native
components provide functionality enhancements to the Outlook add-in when used in Outlook for Windows.

Such enhancements are not possible when using the add-in in web mail or in Outlook for Mac. The native
components cannot be used in these cases. Outlook add-in implementation for Mac is based on the web-based
add-in.

The enhancements in functionality that native components provide include:

+ Accessing Credentials Manager

« While the portal user name is sent through configuration by Avaya IX™ Workplace Client, the password is not
provided directly to the add-in. Outlook native add-in reads the password from Windows Credentials

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 211



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

Manager and embeds to configuration delivered to Avaya IX™ Workplace Client.This is not possible using the
web-based add-in. If the password is unavailable for the web-based add-in, you receive a prompt to enter the
password.

+ Extending contact context menu, persona context menu, and contact ribbon for dialing associated numbers

« This native functionality is unavailable in the web-based add-in.

» Working in the Offline mode

» This functionality is available while working with Outlook for Windows along with the native add-in. Web-
based add-ins are not supported in the Offline mode.

+ Delegate support to create meeting invites on behalf of another user

« This native functionality is unavailable in the web-based add-in.

Scheduling a meeting

Scheduling a meeting using the Avaya IX Workplace
Client Add-in for Microsoft Outlook

About this task

Use this procedure to schedule an Avaya IX™ Workplace Client or Spaces meeting.

Before you begin

« Ensure that the Avaya IX™ Workplace Client Add-in for Microsoft Outlook is enabled by default.

+ Loginto Spaces on Avaya IX™ Workplace Client and Microsoft Outlook.

Procedure

1. In Microsoft Outlook, select one of the following:

+ New Items > Appointment
+ New Items > Meeting

2. Optional: To create a meeting on behalf of another user, select the calendar of the other user before creating
anew item.
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3. Inthe Tofield, specify the participants.
4. Optional: In the Subject field, type a subject name.

If you do not enter a subject name, Avaya IX™ Workplace Client automatically populates the Subject field with
the Avaya IX™ Workplace Client Virtual Room name or the selected Spaces name.

5. Inthe Ribbon area, click Meeting Details.

If only one bridge is configured, the system populates the message body with the conference bridge and
collaboration information. Also, the system displays the side panel.

If multiple bridges are configured, the system does not populate the message body with the conference
bridge and collaboration information. However, the system displays the side panel where you can confirm
and add the bridge details.

6. Optional: If you are using Spaces and multiple meetings are configured, you can use the Search field to
search for a meeting.

The system lists the Avaya IX™ Workplace Client meetings, if any, first followed by the Spaces meetings.
7. Optional: If multiple bridges are configured, do the following:

1. Inthe Meeting Details field, select the bridge whose details you want to add to the message body.
2. Inthe side panel, click Add Details.

The system populates the message body with the meeting details.
8. Optional: Modify the text in the message body.
Multiple meeting links might be available in the Location field or the Body area of the email. Only if the
Location field is empty, the meeting link is used from the Body area of the email. If multiple meeting links are
available, Avaya IX™ Workplace Client uses the call button on the Top of Mind screen to dial you into the

meeting according to the following priority:

+ Avaya Equinox® Conferencing
+ Avaya Spaces Conferencing

© Note:

You cannot reserve resources while scheduling a conference.

9. Optional: Edit the scheduled time with the frequency at which the meeting is repeated.
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10. Click Send.

Scheduling a meeting using Microsoft Outlook Web
Access

About this task

Use this procedure to schedule an Avaya IX™ Workplace Client or Spaces meeting.

Before you begin

» Ensure that the Avaya IX™ Workplace Client Add-in for Microsoft Outlook is enabled by default.
» Login to Spaces on Avaya IX™ Workplace Client and Microsoft Outlook Web Access (OWA).

Procedure

1. In Microsoft OWA, select the option to create a new appointment or meeting.
2. Click Avaya IX Workplace Outlook Add-In.

The system displays the side panel.

3. Optional: If you are using Spaces and multiple meetings are configured, you can use the Search field to
search for a meeting.

The system lists the Avaya IX™ Workplace Client meetings, if any, first followed by the Spaces meetings.

4. Optional: If multiple bridges are configured, select the bridge whose details you want to add to the message
body.

5. Click Add Details.

The system populates the message body with the conference bridge and collaboration information of the
selected bridge.

6. Optional: Modify the text in the message body.
Multiple meeting links might be available in the Location field or the Body area of the email. Only if the
Location field is empty, the meeting link is used from the Body area of the email. If multiple meeting links are
available, Avaya IX™ Workplace Client uses the call button on the Top of Mind screen to dial you into the

meeting according to the following priority:

+ Avaya Equinox® Conferencing

+ Avaya Spaces Conferencing
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© nNote:

You cannot reserve resources while scheduling a conference.

7. Optional: Edit the scheduled time with the frequency at which the meeting is repeated.
8. Inthe Tofield, specify the participants.
9. Optional: In the Subject field, type a subject name.

If you do not enter a subject name, Avaya IX™ Workplace Client automatically populates the Subject field with
the Avaya IX™ Workplace Client Virtual Room name or the selected Spaces name.

10. Click Send.

Joining or hosting a meeting

Joining or hosting a meeting using the Avaya IX
Workplace Client Add-in for Microsoft Outlook

About this task
Use this procedure to join or host an Avaya IX™ Workplace Client or Spaces meeting.
Procedure

1. In Microsoft Outlook, open the appointment or meeting that is scheduled at the current time.
2. Inthe Ribbon area, click one of the following:

« Start: To host the conference
« Join: To join the conference.

Hosting a meeting using Microsoft OWA
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About this task

Use this procedure to host an Avaya IX™ Workplace Client or Spaces meeting.

Procedure

1. In Microsoft OWA, open the appointment or meeting that is scheduled at the current time.
2. Inthe Ribbon area, click Avaya IX Workplace Outlook Add-In.

The system displays the side panel.

3. Click Start Meeting.

Joining a meeting using Microsoft OWA
About this task
Use this procedure to join an Avaya IX™ Workplace Client or Spaces meeting.
Procedure

1. In Microsoft OWA, open the appointment or meeting that is scheduled at the current time.
2. Inthe Ribbon area, click Join.

Making an Avaya IX Workplace Client call from within
Microsoft Outlook

Before you begin

Enable the Allow calls from Outlook contacts setting.

Procedure

1. In Microsoft Outlook, open the Contacts screen.
2. Right-click or double-click a contact card and select Call Contact.
3. Select the number that you want to call.

© nNote:
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Numbers displayed in the Microsoft Outlook view and Call Contact option might differ. For example, if you
use this procedure, you might be able to view only one number. However, if you move the cursor over the
contact entry or email address, you might view additional phone numbers. These phone numbers might be
retrieved from Lync or Skype for Business. This is a known functionality.

Making an Avaya IX Workplace Client call from a
browser

About this task

Use this procedure to make calls from the highlighted numbers on Google Chrome and Microsoft Internet
Explorer browsers.

Before you begin

Enable the browser add-in.

Procedure

1. Hover the cursor over the highlighted number that you want to call.
2. Click the number.
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Uninstalling and upgrading Avaya IX™ Workplace Client

Mobile clients

Upgrading Avaya IX Workplace Client on mobile devices
About this task

If a new version of Avaya IX™ Workplace Client is available in Google Play or Play Store, the mobile device
displays an upgrade notification.

Procedure

1. Access the Notifications area on your mobile device.

2. Select the upgrade notification for Avaya IX™ Workplace Client.
3. Accept the default values to complete the upgrade process.
4

. Optional: Configure the latest settings for Avaya IX™ Workplace Client using the automatic configuration
process.

Removing data from mobile clients
About this task

Use this procedure on mobile clients to permanently remove information from Avaya IX™ Workplace Client, such
as account information, settings, and application data.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Support.
2. Select Reset Application.
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3. Inthe confirmation dialog box, confirm the change.

Uninstalling Avaya IX Workplace Client from mobile

devices
Before you begin

Ensure that Avaya IX™ Workplace Client is not running.

Procedure

Do one of the following:

+ On Android devices: Go to the application settings on the device and tap Uninstall for Avaya IX™ Workplace
Client.

+ OniOS devices: Press and hold the Avaya IX™ Workplace Client icon, tap the X icon in the upper-left corner of the
Avaya IX™ Workplace Client icon, and tap Delete.

Desktop clients

Upgrading Avaya IX Workplace Client on desktops
Before you begin

Exit the Google Chrome browser if it is open. You might need to right-click on the Google Chrome icon in the
taskbar notification area to select the Exit option.

Procedure

To upgrade to the latest build on:

« Avaya IX™ Workplace Client for Mac: On the Mac menu bar, click Avaya IX Workplace > Check for Updates.
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+ Avaya IX™ Workplace Client for Windows: In the Avaya IX™ Workplace Client settings, select Support > Check for
Updates.

Removing data from desktop clients
About this task

Use this procedure on desktops to permanently remove information from Avaya IX™ Workplace Client, such as
account information, settings, and application data.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Support.
2. Select Reset Application.

3. Inthe confirmation dialog box, confirm the change.

Uninstalling Avaya IX Workplace Client on desktops

Before you begin

Ensure that Avaya IX™ Workplace Client is not running.

Procedure

+ On Windows desktops, open Control Panel and do the following:

. Click Uninstall a program.

1

2. Inthe Uninstall or change a program window, select Avaya IX™ Workplace Client.
3. Click Uninstall.
4

. Inthe Programs and Features dialog box, click Yes.

A message box displays the status of the uninstall operation. After the software is uninstalled, the system
closes the dialog box. Avaya IX™ Workplace Client no longer shows in the Uninstall or change a program
window.

+ On Mac desktops, do the following:

1. Double-click the Avaya IX Workplace-XX.dmg file.
2. Double-click Uninstall.

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 220



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

3. Inthe confirmation dialog box, click Yes.

After Avaya IX™ Workplace Client is uninstalled, the system displays a message.
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Troubleshooting

Support, alerts, and log files

Capturing detailed log information
About this task
Use this procedure so that Avaya IX™ Workplace Client can capture detailed logs for use by support personnel.
Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Support.
2. Totoggle the feature on and off, select Enable Diagnostics.
3. Save the changes.

Configuring the quality improvement option
About this task

Use this procedure to configure the quality improvement option so that Avaya can collect quality-related product
data.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, select Support.
2. Select Quality Improvement.

Avaya IX™ Workplace Client collects data for use by support personnel.

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 222



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

3. Savethe changes.

Configuring the support email address
About this task

Use this procedure only on Avaya IX™ Workplace Client for Android to configure the support email address. Avaya
IX™ Workplace Client sends log files to this email address.

Before you begin

Get the email address from your administrator.

Procedure

1. Inthe Avaya IX™ Workplace Client settings, tap Support > Report a Problem > Support Email Address.
2. Type avalid email address.
3. Savethe changes.

Sending log files to support
About this task

If you face an issue with Avaya IX™ Workplace Client, you might be required to send the log files to Avaya support
for troubleshooting the issue.

If your administrator enables encryption of logs but does not set the encryption passphrase, you can provide a
custom passphrase to encrypt the logs. Ensure that the passphrase is not your regular account password as you
need to share this password with your administrator for decrypting the log file.

© Note:

On Avaya IX™ Workplace Client for Android, when you send logs using an email address, Avaya IX™ Workplace
Client passes the email address string, unaltered, to your chosen email application. Avaya IX™ Workplace Client
does not format or validate email addresses. The email application formats and validates email addresses.

Before you begin

On Avaya IX™ Workplace Client for Android, configure the support email address.

August 4, 2020 Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows 223



Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

Procedure
1. Do one of the following:

« On Avaya IX™ Workplace Client for Android: Tap Support > Report a Problem > Send Logs.
« On desktop clients and Avaya IX™ Workplace Client for iOS: Select Support > Report a Problem.

2. Optional: If your administrator enables encryption of logs but does not set the encryption passphrase, then
provide an encryption passphrase.

3. Do one of the following:

+ On mobile clients: If more than one email option is listed, select the appropriate option, and enter the details
in the email body.

« On desktop clients: Enter the details in the email body.
4. Send the logs report.

Checking alert messages
About this task

Avaya IX™ Workplace Client displays an Alert icon if the configuration is incorrect or Avaya IX™ Workplace Client
cannot connect to a server.

G Note:

Avaya IX™ Workplace Client displays an Information icon if the issue is not service impacting, not urgent, or only
informative.

Procedure

A

Avaya IX™ Workplace Client displays a detailed message.

1. On the Top of Mind screen, select

2. Select the message.

3. Correct the error or contact your administrator for assistance.

Decrypting the log file
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About this task

If the log file is encrypted, use this procedure to decrypt the log file.
» If you type the passphrase in the command, the passphrase is visible.For example, you might want the
passphrase to be visible when you are not in a public environment and have no privacy concerns.

+ If you do not want the passphrase to be visible while typing the command, you can enter the passphrase later.For
example, you are providing a demo on how to decrypt the log files, and do not want other people to view your
passphrase while typing the command.

Before you begin

Open the terminal application.

Procedure

+ If you want the passphrase to appear in the command, run the following command: openssl enc -d -
aes-256-ecb -md sha256 -salt -k $logpassphrase -in $logfile -out $decryptfile.

Where, you must replace:

+ $logpassphrase with the configured passphrase.

+ $logfile withthe encrypted zip path. For example, /Users/<user name>/Desktop/
encrypted.zip.

+ Sdecryptfile with the location where you want to place the decrypted zip. For example, /Users/
<user name>/Desktop/decrypted.zip.

+ If you do not want the passphrase to appear in the command, run the following command: openssl enc -d
-aes-256-ecb -md sha256 -salt -in $logfile -out S$decryptfile,andthen enterthe
passphrase.

Where, you must replace:

+ $logfile withthe encrypted zip path. For example, /Users/<user name>/Desktop/
encrypted.zip.
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+ Sdecryptfile with the location where you want to place the decrypted zip. For example, /Users/
<user name>/Desktop/decrypted.zip.

Conferencing issues

Enhanced conference control functionality is
unavailable

Condition

After switching an Avaya IX™ Workplace Client conference call between the MDA devices, enhanced conference
control features such as moderator control, roster list, and collaboration window are unavailable on the new
device. However, conference control features continue to be available on the original device.

Solution

Procedure

After switching the conference call to the new device, end the conference call on the original device.
You can then view the enhanced conference control features on the new device.

Unable to join a meeting on Avaya IX Workplace Client
for Android

Condition

The meeting invite includes two or more meeting URLs. If you try to join this meeting from the Top of Mind
screen by clicking on the meeting invite, the meeting IDs are incorrectly appended one after the other. If you are
using an OTT deployment, you cannot join the meeting.
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Cause

The sender of the meeting invite used the Location field in the invitation to send multiple meeting URLs
separated by a semicolon.

Solution

Procedure

Join the meeting using the correct meeting URL and ID.

Contact issues

Cannot access local contacts on Avaya IX Workplace
Client

Cause

When you initially logged in to Avaya IX™ Workplace Client, you did not configure access to local contacts.
Solution

Procedure

Do one of the following:

+ On Android devices: In the settings of the device operating system, set Privacy and safety > App permissions >
Contacts > Contacts permissions to On for Avaya IX™ Workplace Client.

+ OniOS devices: In the settings of the device operating system, set Privacy > Contacts to On for Avaya IX™
Workplace Client.
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+ On desktop clients: In the Avaya IX™ Workplace Client settings, select User Preferences > Contacts and enable
Show Local Contacts.

Contact image is invisible

Condition

If the image of a contact is added or changed from LDAP and if you perform an enterprise search for that contact,
Avaya IX™ Workplace Client does not display the latest image.

Solution

Procedure

Delete and add the contact again to display the contact image.

Instant messaging issues

Timestamp is not updated for an open instant
messaging conversation

Solution

Procedure

1. Goto adifferent screen in the Avaya IX™ Workplace Client application.

2. Return to the instant messaging conversation screen.
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The timestamp is automatically updated.

Telephony issues

Cannot end a call on a bridged extension that is on hold

Condition

If you are using a bridged extension with a call on hold on Avaya IX™ Workplace Client and the call is also active
from the bridged extension or EC500 station, you cannot end the call from Avaya IX™ Workplace Client.

Solution

Procedure

1. From the bridged extension or EC500 station, drop the call.
2. Resume the call from Avaya IX™ Workplace Client.

3. When you finish your conversation, end the call on Avaya IX™ Workplace Client.

Receive two call notifications for an incoming call

Condition

Avaya IX™ Workplace Client displays two call notifications for an incoming call. One notification is over Wi-Fi or
SIP, and the other notification is over GSM.

Solution

Procedure
On Communication Manager, your administrator must:

+ Configure the Extend Call button.
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« Enable the EC500 status for the station.

Avaya IX Workplace Client displays incorrect call logs
for a bridged in call

Condition

There are two users, A and B. A uses MDA and logs in to more than one Avaya IX™ Workplace Client
simultaneously. B logs in only in Avaya IX™ Workplace Client for Windows.

1. Bcalls A.A answers the incoming call on Avaya IX™ Workplace Client for Mac.

2. Abridges in the call on Avaya IX™ Workplace Client for iOS and hangs up the call on Avaya IX™ Workplace
Client for Mac.

3. Bends the outgoing call.
4. Achecks the call log on Avaya IX™ Workplace Client for i0S.The call log displays an outgoing call from A to B.

Cause

For the MDA feature, this is a form of originating a new call. Hence, the call logs display an outbound call
attempt.

Solution

Procedure

Avaya confirms that this functionality is as intended.

Client Enablement Services callback call gets dropped
after called party answers the call

Cause

This issue occurs when enforced SRTP is enabled in Communication Manager.
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Solution

Procedure

Avaya confirms that this functionality is as intended.

Video issues

The microphone stops working during a video call

Condition

During a video call, the microphone stops working and Avaya IX™ Workplace Client displays the following error
message: USB Controller Bandwidth Exceeded.

Cause

This condition might occur if your video camera and microphone connect to:

+ The same USB hub
+ The same USB keyboard hub

+ The USB ports on the front of your computer

Solution

Procedure

Connect the video camera and microphone to the USB ports on the back of your computer.

Video window does not close automatically
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Condition

If you de-escalate or stop a video from an Avaya one-X® Communicator H.323 endpoint, Avaya IX™ Workplace
Client does not close the video window.

For a simple point-to-point video call between Avaya IX™ Workplace Client and Avaya one-X® Communicator,
Avaya IX™ Workplace Client functions differently.

« If Avaya one-X® Communicator SIP drops the video, the Avaya IX™ Workplace Client video window closes.

« If Avaya one-X® Communicator H.323 drops the video, the Avaya IX™ Workplace Client video window remains
open with a black screen.

Solution

Procedure

Close the video window manually.

Web collaboration issues

Cannot de-escalate to audio or start web collaboration

Condition

If you answer a conference call on an EC500 endpoint and bridge in to the conference from Avaya IX™ Workplace
Client, you cannot de-escalate to audio or start web collaboration. When you disconnect from the EC500
endpoint, the De-escalate to audio and start web collaboration functionality is still unavailable in Avaya IX™
Workplace Client.
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Solution

Procedure

Drop from the conference and dial in again from Avaya IX™ Workplace Client.

Cannot access the web collaboration session of a
conference

Condition

The Web Collaboration window displays the following message: Meeting is currently locked and
not accepting new users.

Cause

This issue occurs if the moderator locks the conference before you open the web collaboration.
Solution

Procedure

Ask the moderator to unlock the conference.
You can then access the web collaboration session.

Cannot view the Start Sharing option during a P2P
video call

Condition

You cannot view the Start Sharing option during a point-to-point video call when both the following conditions
are met:

» Avaya IX™ Workplace Client for Mac is registered using Session Border Controller.

+ BFCP transport is configured as TCP.
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Solution

Procedure

Configure BFCP transport as UDP.

Unable to share an application during a conference

Condition

While using Avaya IX™ Workplace Client for Mac, you are unable to share an application during a conference.

Cause

Application sharing is possible only when Avaya IX™ Workplace Client for Mac has access to the accessibility
feature.

Solution

Procedure

1. Onthe Apple menu, go to System Preferences > Security & Privacy > Privacy > Accessibility.

2. Inthe Allow the apps below to control your computer area, select the check box next to Avaya IX™ Workplace
Client.

Other issues

Poor audio or video quality and slow response time
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Condition

The performance of Avaya IX™ Workplace Client for presence indication, contact searches, and instant messaging
depends on the wireless network that you are using. You might experience impairments to audio quality, video
quality, and slow response time depending on the quality of the network connection.

Cause

Connections using VPN over the Internet, 3G cellular data, or weak Wi-Fi signals might impair the performance of
Avaya IX™ Workplace Client.

Solution

Procedure

Use a properly engineered private network to achieve best results.
Avaya IX™ Workplace Client actively monitors audio and video quality and provides feedback if audio and
video quality are impaired.

Avaya IX Workplace Client for iOS exits unexpectedly

Condition

The operating system on your iPad or iPhone can end applications running in the background if an active
application requires more memory.

Cause

This issue can occur when you are running memory consuming applications or if you are synchronizing many
contacts over the network.
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Solution

Procedure

Restart Avaya IX™ Workplace Client.

Cannot change to a different IP connection with
Windows 8

Condition

When you are connected to an active network connection, you cannot change to a different IP, such as a VPN
connection.

Cause

This is a known Windows 8 limitation. This issue occurs if you are connected to an active network when you
change to VPN.

Solution

Procedure

Do one of the following:

+ Toggle network connectivity by unplugging and re-plugging in an Ethernet cable.

+ Disable the active network connection before changing to a different IP connection.

Error while installing Avaya IX Workplace Client for
Windows

Condition

You might receive the following error while installing Avaya IX™ Workplace Client for Windows:

Another installation is in progress. You must complete that installation before continui:
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Cause

This error indicates that the Windows Installer Service is currently being utilized for another installation or
update at this time. The Windows Installer process can only run one installation at a time. Complete the other
installation or wait a few minutes for the background installation that is taking place to complete.

Solution

Procedure

Reboot the computer and try installing again.
If the error returns, attempt to find any applications currently installing and close them.
If you are unable to find an application that is running updates, open Task Manager and go to the Details tab.

Locate and end any msiexec.exe entries that you see.

ok W

Attempt the installation once again.

Error while uninstalling Avaya IX Workplace Client for
Windows using the Windows Control Panel

Condition

You might receive the following error while uninstalling Avaya IX™ Workplace Client for Windows using the
Windows Control Panel:

Error opening installation log file. Verify that the specified location exists and is wr

Cause

This issue occurs when your administrator enables Windows Installer Logging, but the Windows Installer engine
cannot write the uninstallation log file correctly. For more information, see https://support.microsoft.com/en-
us/kb/2564571/en-us.
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Solution

Procedure

Stop and restart the explorer.exe process using the Windows Task Manager.

Getting security warnings while using Avaya IX
Workplace Client

Condition

When a program attempts to gain access to your contact information in Outlook, Avaya IX™ Workplace Client
displays security warnings.

Cause

Your email administrator might only allow add-ins for specific programs by adding the add-ins to a Trusted list.
For nontrusted programs, Avaya IX™ Workplace Client displays a security warning because of the potential risk
that the nontrusted program might use Outlook to spread viruses.

Solution

Procedure

Inform your email administrator to add Avaya IX™ Workplace Client to the Trusted add-ins list.
Installing an antivirus program and keeping the antivirus program updated regularly might prevent the
security warning from appearing again.

Microsoft Outlook displays a security notification
message

Condition

Upon starting Avaya IX™ Workplace Client, Microsoft Outlook displays a security notification message stating that
a program is trying to access email address information stored in Outlook.
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Cause

Microsoft Outlook displays the security notification message if Microsoft Outlook:

» Does not detect a valid antivirus program.
 Detects that the virus definitions are out-of-date.

+ Is set to always warn about programs accessing email address information.

Solution

Procedure

1. Inthe Microsoft Outlook dialog box, select the Allow access for check box.
2. From the corresponding drop-down list box, select 1 minute.

3. Select Allow.
If you select Deny, Avaya IX™ Workplace Client cannot access email address information. However, Avaya IX™
Workplace Client can still access your Outlook contacts.

To prevent this message from reappearing, ensure that your antivirus program is active and up-to-date.

Presence status is updated incorrectly

Condition

Avaya IX™ Workplace Client displays incorrect presence status in the following situations:

« If you set your presence status to Automatic, the presence status always displays as Offline.

» If you are on a call, the presence status does not display as Busy. It might show the message Presence
Server 1s not available.

Cause

Client Enablement Services provides presence information using Avaya Aura® Presence Services. Client
Enablement Services has a limitation that it does not automatically publish Available for mobile endpoints.

Presence status updates as the result of being on a call, also known as Telephony Presence, require the
appropriate Avaya Aura® configuration by your administrator. If the Presence Server restarts while you are on a
call, you see the message Presence Server is not available.
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Solution

Procedure

+ If you set your presence status to Automatic, to see your own presence change from Offline to Available, you
must log in with another presence capable client.
The presence status of that client triggers an update to your presence status.

Alternatively, you can manage your presence manually and set your status to Available when you want.

+ If you do not see your presence status update while on a call, contact your administrator to determine if you have
the necessary configuration for this feature.
If you are still on the same call after the Presence Server restart is complete, your presence status might not
get updated. You must wait for the existing call to end.

Getting error messages while managing calls on
multiple devices using MDA

Condition

Avaya IX™ Workplace Client displays the following error messages depending on whether your administrator
configured the Max. Simultaneous Devices field on System Manager:

e You have been logged off. Another device has connected using this extension.

» This Extension has reached the maximum number of devices.

Cause

If your administrator:

+ Does not configure the Max. Simultaneous Devices field on System Manager, you cannot use another device to
log in to Avaya IX™ Workplace Client using the same extension.

+ Configures the Max. Simultaneous Devices field on System Manager, you cannot exceed the usage limit.
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Solution

Procedure

If Avaya IX™ Workplace Client displays one of the above error messages, inform your administrator.

Space key on the soft keypad works incorrectly in Avaya
IX Workplace Client for iOS

Condition

If you insert a space in the right aligned text field in Avaya IX™ Workplace Client, the characters inserted before
the space are not shifted to the left or the cursor is not advanced. Even if you insert a number of spaces, the
characters on its left are not advanced.

Cause

Since i0S 7, the right aligned text fields function differently. Apple confirms that this new functionality is as
intended.

Solution

Procedure

After you insert a character following the space, the characters move to the left and the space is visible.

Microsoft Exchange ActiveSync search is not working

Condition

Some Android devices have a known issue connecting to Exchange servers configured with certificates earlier
than TLS version 1.2.

Cause

The Android device is not automatically configured to accept the ActiveSync accounts.
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Solution

Procedure

In the Exchange ActiveSync account settings, select the Accept all SSL certificates check box.

Certificate issue on Avaya IX Workplace Client for iOS

Condition

When you manually install a certificate on Avaya IX™ Workplace Client for iOS, Avaya IX™ Workplace Client stops
working on the device if you upgrade iOS to 10.3 or later.

Cause

The certificate is not automatically trusted for SSL.
Solution

Procedure

1. Toturn on SSL trust for a certificate, on your iOS device, go to Settings > General > About > Certificate Trust
Settings.

2. Inthe Enable full trust for root certificates area, enable the trust for the certificate.

Touch functionality does not work properly

Condition

While using Avaya IX™ Workplace Client for Windows, touch functionality such as drag and drop, and scroll might
not function properly.
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Solution

Procedure

Upgrade .NET Framework to 4.8 or a later version.

Microsoft Outlook add-in does not display the meeting
details

Condition

Microsoft Outlook add-in does not display the meeting details in the Avaya Meeting Scheduler area.

Solution

Procedure

1. Open Microsoft Outlook.

2. Goto File > Options > General.

3. Inthe User Interface options area, for When using multiple displays, select Optimize for compatibility.
4

. Restart Microsoft Outlook.

Loud and annoying music is heard when call is on hold

Cause

This condition occurs in the following deployment scenarios:

« Client network is IPv4 and Avaya Aura® Media Server network is IPv6, or vice versa.

« There is a mismatch of IP versions between the client network and the Avaya Aura® Media Server network.
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Solution

Procedure

Contact your administrator to set the same media preference setting for the client network and the Avaya Aura®
Media Server network.
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Resources

Documentation

See the following related documents for the Avaya IX™ Workplace Client and Avaya Multimedia Messaging

solution at http://support.avaya.com.

Title

Overview

Avaya IX™ Workplace Client Overview
and Specification for Android, iOS, Mac,
and Windows

Avaya IX™ Workplace VDI Overview and
Planning

Planning

Planning for and Administering Avaya
IX™ Workplace Client for Android, iOS,
Mac, and Windows

Avaya Multimedia Messaging Reference
Configuration

Use this document to:

Understand high-level product functionality,
performance specifications, security, and
licensing.

Understand high-level product functionality,
security, and licensing. Also, perform deployment
planning.

Perform system planning and configuration for:

Avaya IX™Workplace Client for Android
Avaya IX™ Workplace Client for iOS
Avaya IX™ Workplace Client for Mac
Avaya IX™ Workplace Client for Windows

Understand technical overview information,
system architecture, functional limitations, and
capacity and scalability for Avaya Multimedia
Messaging.

Audience

Customers and sales,
services, and support
personnel

System administrators

Customers and sales,
services, and support
personnel

System administrators

Customers and sales,
services, and support
personnel
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Title

Implementing

Deploying Avaya Multimedia Messaging

Deploying the Avaya Aura® Web
Gateway

Implementing, administering, and
troubleshooting Avaya IX™ Workplace
VDI

Administering

Administering Avaya Multimedia
Messaging

Administering the Avaya Aura® Web
Gateway

Using

Working with the Agent feature on
Avaya IX™ Workplace Client for iOS

Using Avaya IX™ Workplace VDI

Using Avaya IX™ Workplace Client for Android, iOS, Mac, and Windows

Use this document to:

Install, configure, and administer Avaya
Multimedia Messaging.

Install, configure, and administer the Avaya Aura®
Web Gateway.

Install, configure, administer, and troubleshoot
Avaya IX™ Workplace VDI.

Administer and manage Avaya Multimedia
Messaging.

Administer, manage, and troubleshoot the Avaya
Aura® Web Gateway.

Administer and use the Agent feature on Avaya IX™
Workplace Client for iOS.

Set up and use Avaya IX™ Workplace VDI.

Audience

Implementation personnel

Implementation personnel

Implementation personnel

Implementation personnel

Implementation personnel

Implementation personnel
and enterprise users

Enterprise users
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Procedure

Go to https://support.avaya.com.

At the top of the screen, type your username and password and click Login.

Click Support by Product > Documents.

In Enter your Product Here, type the product name and then select the product from the list.

A

In Choose Release, select the appropriate release number.
The Choose Release field is not available if there is only one release for the product.
6. Inthe Content Type filter, click a document type, or click Select All to see a list of all available documents.

For example, for user guides, click User Guides in the Content Type filter. The list only displays the documents
for the selected category.

7. Click Enter.

Avaya Documentation Center navigation

The latest customer documentation for some programs is now available on the Avaya Documentation Center
website at https://documentation.avaya.com.

'9' Important:

For documents that are not available on Avaya Documentation Center, click More Sites > Support on the top
menu to open https://support.avaya.com.

Using the Avaya Documentation Center, you can:
» Search for content by doing one of the following:

« Click Filters to select a product and then type key words inSearch.

« From Products & Solutions, select a solution category and product, and then select the appropriate
document from the list.

+ Sort documents on the search results page.

« Click Languages ( @ ) to change the display language and view localized documents.

« Publish a PDF of the current section in a document, the section and its subsections, or the entire document.

» Add content to your collection by using My Docs (i}).Navigate to the Manage Content > My Docs menu, and do
any of the following:
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+ Create, rename, and delete a collection.

+ Add topics from various documents to a collection.

» Save a PDF of selected content in a collection and download it to your computer.
+ Share content in a collection with others through email.

«+ Receive collection that others have shared with you.

+ Add yourself as a watcher using the Watch icon ( ®). Navigate to the Manage Content > Watchlist menu, and
do the following:
« Enable Include in email notification to receive email alerts.
« Unwatch selected content, all content in a document, or all content on the Watch list page.

As a watcher, you are notified when content is updated or deleted from a document, or the document is removed
from the website.

« Share a section on social media platforms, such as Facebook, LinkedIn, and Twitter.

« Send feedback on a section and rate the content.
'9 Note:

Some functionality is only available when you log on to the website. The available functionality depends on the
role with which you are logged in.

Training

The following courses are available on the Avaya Learning website at http://www.avaya-learning.com. After
logging in to the website, enter the course code or the course title in the Search field and press Enter to search
for the course.

Course code Course title

2035W Avaya Unified Communications Roadmap for Avaya IX™ Workplace Client
20390W Using Avaya IX™ Workplace Client

2216W Avaya IX™ Workplace Client Fundamentals
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Course code Course title

3140W Avaya IX™ Workplace Client Solutions Overview

3185W Designing the Avaya IX™ Workplace Client Solution

4965W Avaya IX™ Workplace Client Overview

7150V Integrating and Supporting Avaya IX™ Workplace Client Over the Top

Viewing Avaya Mentor videos
Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot Avaya products.

About this task

Videos are available on the Avaya Support website, listed under the video document type, and on the Avaya-run
channel on YouTube.

Procedure
» To find videos on the Avaya Support website, go to https://support.avaya.com/ and do one of the following:

+ In Search, type Avaya Mentor Videos,click Clear All and select Video in the Content Type.

+ In Search, type the product name. On the Search Results page, click Clear All and select Video in the Content
Type.The Video content type is displayed only when videos are available for that product.

In the right pane, the page displays a list of available videos.
+ To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and do one of the following:

« Enter a key word or key words in the Search Channel to search for a specific product or topic.

« Scroll down Playlists, and click a topic name to see the list of videos available for the topic. For example,
Contact Centers.
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© nNote:

Videos are not available for all products.

Support

Go to the Avaya Support website at https://support.avaya.com for the most up-to-date documentation, product
notices, and knowledge articles. You can also search for release notes, downloads, and resolutions to issues. Use
the online service request system to create a service request. Chat with live agents to get answers to questions,
or request an agent to connect you to a support team if an issue requires additional expertise.

Using the Avaya InSite Knowledge Base

The Avaya InSite Knowledge Base is a web-based search engine that provides:

+ Up-to-date troubleshooting procedures and technical tips
« Information about service packs

+ Access to customer and technical documentation

» Information about training and certification programs

» Links to other pertinent information

If you are an authorized Avaya Partner or a current Avaya customer with a support contract, you can access the
Knowledge Base without extra cost. You must have a login account and a valid Sold-To number.

Use the Avaya InSite Knowledge Base for any potential solutions to problems.

1. Go to http://www.avaya.com/support.

2. Log on to the Avaya website with a valid Avaya user ID and password.The system displays the Avaya Support
page.

3. Click Support by Product > Product-specific Support.

4. In Enter Product Name, enter the product, and press Enter.

5. Select the product from the list, and select a release.

6. Click the Technical Solutions tab to see articles.
7

. Select relevant articles.
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Glossary

Communication Manager

Communication Manager

A key component of Avaya Aura®. It delivers rich voice and video capabilities and provides a resilient, distributed
network for media gateways and analog, digital, and IP-based communication devices. It includes advanced mobility
features, built-in conference calling, contact center applications and E911 capabilities.

EC500
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A feature that bridges calls received by the Avaya Aura® Communication Manager server to any mobile phone,
regardless of location or wireless service provider.

FNE

FNE

An extension assigned to a feature within Communication Manager. The system administrator configures a Feature
Name Extension (FNE) to correspond to a FAC that activates the feature.

FECC

Far End Camera Control (FECC) is a feature of endpoint cameras, where an endpoint in the call can remotely control
the camera of another endpoint in the call.

OTT
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Over the Top (OTT) deployment means that you can use Avaya IX™ Workplace Client in a non-Avaya Aura®
environment as a conferencing client for users that have a virtual room assigned to them.

System Manager

System Manager

A common management framework for Avaya Aura® that provides centralized management functions for provisioning
and administration to reduce management complexity. System Manager can also function as a self-signed Root
Certificate Authority (CA) or as an intermediate CA. System Manager enables the Simple Certificate Enrollment
Protocol (SCEP) application to sign certificates for Avaya deskphones.

UCCP

Unified Conference Control Protocol (UCCP) is a web-based protocol. It is used by Conferencing clients to have
conference control including roster, moderator commands, and user commands.
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